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Preface
Welcome!

The World Wide Web has fueled the explosive growth of the Internet and the emerging 
software and services industries that surround it. The Web lets individuals, companies, 
and institutions—anyone with an Internet connection—publish electronically. 
The fundamental unit of the Web is the “page” you see when you browse for 
information. Pages are hypertext documents. When you click on a link, your computer 
gets the page referenced by the link and displays it on your screen. Web pages can also 
have images, sound, video, forms, and other features.

What is GNNpress?
GNNpress is an interactive authoring tool that helps you create and publish Web pages. 
You can use GNNpress with or without access to the GNN Hosting Service. With the 
GNN Hosting Service, you will be able to save your pages directly to the GNNservers 
used by the service. 

What is the GNN Hosting Service?
GNNpress and the GNN Hosting Service give you an integrated publishing system for 
the World Wide Web. The computer system on your desk connects to GNN’s Web 
servers where you can publish your pages. The GNNpress software and the GNN 
Hosting Service enable you to join the thousands who have made their presence known 
on the Internet.
You can use GNNpress with several levels of service. As your Internet needs grow, 
you can move up to higher service levels. Each service level gives you more disk space 
and supports more frequent page accesses than the previous level.

• No service: You can use GNNpress to create Web pages without having a GNN 
Hosting Service account. If you have your own GNNserver, you can use GNNpress 
to save pages directly to that server. Otherwise, you have to use some other file 
transfer mechanism to manually move the pages you create with GNNpress to the 
Web server you are using.

• Personal Service: You can access the Internet and publish your pages on the 
World Wide Web. GNNworks is the browser you use to surf the Web. GNNpress 
is the tool you use to create and publish your pages on the Web. Together, they 
create a comprehensive and powerful Internet software suite for the home 
consumer. The Personal Service level is included in a GNN membership.
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• Domain Service: This service level also gives you a unique “domain” name — 
such as mycompany.com . This makes your company easy to find on the Web 
(http://www.mycompany.com ) and lets you project a professional corporate 
image.

• Commercial Service: In addition to a domain name, this service level gives you 
control over most administrative, database, and programming capabilities of the 
GNNserver where your Web site is hosted.

• Dedicated Service: In addition to the features of the Commercial service, this 
service level gives you full access to the system, your choice of hardware and soft-
ware configuration, and secure financial transactions. 

What is a GNNserver?
A GNNserver is a powerful Web server you can use to create, publish, and manage 
information on the World Wide Web. The GNN Hosting Service uses GNNservers to 
host your pages. If you want to set up your own Web server, you can download the 
GNNserver software for free from http://www.tools.gnn.com/index.html . 
The GNNserver is extendable with C and Tcl APIs that can access various types of 
databases. Full CGI support is also provided.

About This Book
This book is both a tutorial and a reference manual for the GNNpress software. If you 
are a new user, you should start with Part I, use the software for a while, and then read 
through the rest of the book. Experienced users can search through the chapters, table 
of contents, and index to find special topics explained.
This book also covers some of the interaction between GNNpress and GNNserver. The 
GNNserver documentation describes administration and programming of the server.

Versions of GNNpress
This manual describes GNNpress v1.1. If you are using an earlier version of GNNpress 
(such as v1.01), some of the v1.1 features will appear differently or will not be 
available. Icons like the one to the left identify features added in v1.1. You can upgrade 
to GNNpress v1.1 by downloading the software from the GNN Web Site (at 
http://gnn.com/ ).
By default, GNNpress v1.1 originally used “Short Menus” mode, which hides access 
to advanced features. These features include MiniWebs, Style Sheets, and some 
dialogs for setting preferences. If these features are not visible in your version of 
GNNpress, choose the Tools Preferences menu item. In the General Preferences 
dialog, uncheck the “Short Menus” item. Then, click OK. When you use the longer 
menus, you will see menus items for administering your Web site that are supported 
only if you have the Commercial or Dedicated level of GNN Hosting Service.
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Why Give Away Our Software for Free?
In our ongoing effort to support and promote publishing on the World Wide Web, 
GNN makes two major Web tools — GNNpress and GNNserver — available at no 
charge. GNNpress is the top-ranked Web page authoring software, and GNNserver is 
the remarkable server software at the core of the GNN Hosting Service. This free 
distribution is GNN’s gift to the Web community.

To Contact Us or Get More Information
To sign up for GNN Hosting Service:
• Call 800/819-6112
• Send email to info@gnnhost.com
• Read http://gnn.com/gnn/join/index.html  or 

http://www.gnnhost.com/
• Go to the “GNN” keyword on AOL.

For GNN Hosting Service Technical Support:
• Call 800/879-6882
• Send email to support@gnnhost.com  or support@gnn.com
• Read http://www.gnnhost.com /

To download GNNpress or GNNserver for free:
• Read http://www.tools.gnn.com/index.html
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Part 1:
Essentials

Part I provides the bare minimum you need 
to know to create and publish Web pages, 
plus some information that will help you later.

Chapter 1 orients you to this book and its style.
Read Chapter 2 if you need to install GNNpress. It covers installation and 
system requirements. It also covers a few essentials about preferences you 
may need to set before you can run GNNpress.
Work through the examples in Chapter 3. These give you a taste of using the 
tools.

• Take a quick tour of the World Wide Web to see how it works and what 
it can do.

• Create a Web page with hyperlinked text and images and publish it to your 
GNN Hosting Service directory (or to a public directory where you can 
test your pages if you are not yet a GNN Hosting Service subscriber).

• Use the MiniWeb to see how Web pages are organized.

Read Chapter 4 to get an overview of the GNNpress workspace. This 
overview will help you understand the tasks and functions in Part 2.
Chapter 5 covers some basics (no more is needed!) about HyperText Markup 
Language (HTML) and other secrets of the World Wide Web.
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Our Assumptions About You
We realize there is probably no “typical” reader of this book or user of GNNpress. 
Some of you are novices; some have considerable experience. How you will use this 
book depends on what you already know. How we explain things depends on what we 
assume about you and your system.
You can use GNNpress if you can use a word processor.

• We assume your computer connects to the Internet either directly or through a 
modem connected to a service such as GNN. Otherwise:
• If your computer connects to a local-area network (LAN), you should contact 

your system administrator to find out how to connect to the Internet.
• If your computer is not connected to a network or modem, you must connect it.

• We assume you know how to use your computer and its operating software.

• You know about files and directories (sometimes called documents and folders), 
how to create them, rename them, move them, and delete them.

• You know how to use your computer’s operating system to run programs.
• You have experience with a window-based, graphical user interface, like 

Microsoft Windows or the Macintosh.
• You know how to use your computer’s mouse.

• We assume you have used one of the popular word-processing software packages, 
such as Microsoft Word.
• The editing conventions in GNNpress are similar.
• The file-saving operations in GNNpress look similar, but they also allow you to 

save files over the Internet.
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• We do not assume that you are familiar with the World Wide Web and with the 
concept of navigating through information with hypertext, but we recognize that 
many of you are familiar with these services and concepts.
• If you are familiar with Web navigation, scan Chapter 3 to see how GNNpress 

lets you browse the Web. Then work through its examples to create a Web page.

GNNserver Administrator
Administering a GNNserver requires expertise typical of a system administrator. 
Extending or customizing the server requires programming expertise.
The GNNserver manages permissions for access to information, user accounts, and 
modification of files. Hence, the GNNserver administrator has the responsibilities of a 
system administrator. Separate documentation for the GNNserver software is available 
for those who use the GNN Hosting Service at the Commercial or Dedicated level and 
those who download the free GNNserver software and manage their own server.

A Tutorial and a Reference
We intend this book for the novice and the experienced user. Part 1 is a tutorial and a 
description of the workspace. Part 2 introduces many more details and advanced 
features of GNNpress and serves as a reference manual too. It also covers the way 
GNNpress and the GNN Hosting Service interact.

How to Use This Book
We urge you to use this book, not just read it. To learn about the software, use the book 
as a tutorial. We show how to accomplish a variety of tasks. Work through the 
instructions to learn. The book usually introduces a set of steps to accomplish a 
particular task with a distinctive heading:

Do a task:

Following the heading that introduces a task are either sequential steps or optional 
steps, each with its distinctive style:

1 Numbered paragraphs, like this one, designate step-by-step instructions. Follow 
them to learn how the tools work. Menu commands are shown with arrows, for 
example, File Save means you should pull down the File menu and choose the 
Save option.
Paragraphs with a square bullet, like this one, are optional steps. Usually there is a 
sequence. Do one or more of the steps to cause the designated action or actions.
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After you have gained experience, you will find that the book serves as a working 
companion and a source of more detail. You can find information either through the 
table of contents or the index.
Considering our experience with many software packages, we recommend that you go 
through the book thoroughly after you have used the software for a while. You will 
discover useful features that you breezed over the first time.

Online Help
There are many online help pages available throughout the application. Most dialogs 
have a help button that you can click to get assistance with a specific task. You can 
search for specific topics using Help Search For Help On. This will bring up a dialog 
box where you enter a term to search for in the online documentation.

Typographical Conventions
We use a variety of fonts to identify items or processing steps:

Variations Among Different Platforms
GNNpress is available for Microsoft Windows and Macintosh. We have compromised 
between making the application similar across different platforms, versus making it 
look similar to other applications on the same platform. Paragraphs in this book that 
apply to specific platforms are identified in the text.

bold, sans serif: Menus, menu items, and field names. Menu names 
with options use arrows, for example, File Save.

italic: To emphasize selected words, for example, in the 
paragraph above, “We urge you to use this book...”

italic, underlined A hyperlink. When browsing a Web page, click on a 
hyperlink to display the Web page it references.

courier Text that you type. For example: http://gnn.com/ .
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What’s New in V1.1?
By default, GNNpress v1.1 originally used “Short Menus” mode, which hides access 
to advanced features. These features include MiniWebs, Style Sheets, and some 
dialogs for setting preferences. If these features are not visible in your version of 
GNNpress, choose the Tools Preferences menu item. In the General Preferences 
dialog, uncheck the “Short Menus” item. Then, click OK. 
When you use the longer menus, you will see menus items for administering your Web 
site that are supported only if you have the Commercial or Dedicated level of GNN 
Hosting Service.
If you’ve used GNNpress v1.0 before, see page 193 for a list of the new features you 
will find in GNNpress v1.1. The icon to the left identifies features that are new in 
GNNpress v1.1. If you are using an earlier version, these features will not be available. 
To find out how and when you can upgrade to GNNpress v1.1, please visit the GNN 
Web Site (http://gnn.com/ ) for update information.
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This chapter explains how to install GNNpress on the following operating systems:

• Microsoft Windows 3.1, 3.5 NT, Workgroups, and Windows95

• Mac OS: System 7 and later

You can download the GNNpress software from http://gnn.com , 
http://www.gnnhost.com , or http://www.tools.gnn.com .

System Requirements
If you want to use GNNpress over the Internet, you need to have a “SLIP” or “PPP” 
connection from an Internet service provider, modem, and the appropriate connection 
software (for example, Trumpet winsock or Chameleon). 
You can still use GNNpress to author and access local files when your computer is not 
connected to the Internet. For example, while you create pages you may want to leave 
your modem off and then connect your modem to the Internet when you are ready to 
publish your pages. When your modem is off, you have access to all the features of 
GNNpress, but cannot open, save, delete, or browse on network locations.
If you have additional questions about using GNNpress with various types of Internet 
connections, see the GNN Hosting Service Frequently Asked Questions (FAQ) list at 
http://www.gnnhost.com/publish/faq/faq.htm .
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MS Windows
• Microsoft Windows 3.1, NT 3.5, Workgroups, or Windows 95

• Intel x86 microprocessor:
• 386 minimum
• 486 or above recommended

• 4 Mbytes RAM minimum; 8 Mbytes recommended

• 5 Mbytes free disk space required for installation

• Internet TCP/IP software:
• Windows NT and Windows95 have support for TCP/IP built in. Windows NT 

and Windows95 users do not need to install third-party software.
• The Windows 3.1 and Windows for Workgroups 3.11 operating systems do not 

have built-in support for TCP/IP, and you have to install a “TCP/IP stack” on 
your system if you plan to search the World Wide Web. Sources of TCP/IP soft-
ware include FTP Inc., Microsoft, NetManage, Novell, Digital Equipment 
Corp., and Spry Inc.

• A modem or direct network connection. (A modem is required to use GNNworks.)

Macintosh
• System 7 or above.

• CPU: 68020 or higher, or Power PC

• 8 Mbytes RAM; 12 Mbytes recommended

• 5 Mbytes disk space required for installation

• MacTCP software (check your system disks if it is not already installed)

• A modem or direct network connection. (If you use a modem, you also need PPP 
or SLIP software.)
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Install GNNpress
MS Windows

Install GNNpress on Windows 3.1, NT 3.5, Workgroups, or Windows95:

1 Click on the Web link to download GNNpress. Specify the location on your hard 
drive where you want to store the compressed GNNpress software. This can be a 
directory where you store temporary files.

2 Use the File Manager to find the file you downloaded.

3 Double-click on the file you downloaded to expand and run the setup procedure.

4 Follow the prompts in the setup procedure to install GNNpress.

5 When the installation is complete, you can double-click on the GNNpress icon in 
your Program Manager to run GNNpress.

Installing as a GNN Hosting Service Member
If you are a GNN Hosting Service member and you used GNNworks to download 
GNNpress, the software will be installed in the GNN directory and will automatically 
use the same dialup connection as GNNworks.

Installing with No Internet Connection
If you are not a GNN Hosting Service member and you do not have a WINSOCK.DLL 
file (TCP/IP connection software), you will see a message that says “Couldn't find 
TCP/IP network (WINSOCK.DLL ). Would you like a stand-alone installation?”
If you proceed with a stand-alone installation, a null WINSOCK.DLL  is placed in the 
GNNpress directory. GNNpress tells you that you are not connected to a network when 
you first try to access an Internet location.
If you install GNNpress stand-alone and later decide you want to use it over the 
Internet, you must change the installation as follows:

1 Install Internet access connection software (this should place a file called 
WINSOCK.DLL  in your windows directory. 

2 Arrange for Internet access from a provider such as the GNN Hosting Service.

3 Start the Windows File Manager and search for GNNPRESS.EXE . Delete the 
WINSOCK.DLL  file in the same directory as GNNPRESS.EXE . If there is no 
WINSOCK.DLL  file in its directory, GNNpress will use the WINSOCK.DLL  file in the 
windows directory.

If you delete the null WINSOCK.DLL  without installing Internet access software, and 
then try to use GNNpress, it will not start. Either install a valid WINSOCK.DLL  or 
reinstall GNNpress.
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Using GNNpress with an AOL Account
You can download a special version of the WINSOCK.DLL  file from America Online. 
Go to keyword: winsock  to download this file, which allows you to use GNNpress on 
your PC through your America Online account.

Macintosh

Install GNNpress on a Macintosh:

1 Click on the Web link to download GNNpress. Specify the location on your drive 
where you want to store the compressed GNNpress software. This can be a direc-
tory where you store temporary files.

2 Double-click on the file you downloaded to expand and run the installation.

3 Follow the prompts in the installation procedure to install GNNpress.

4 When the installation is complete, you can double-click on the GNNpress icon to 
run GNNpress.

Updating to New Versions of GNNpress
When new versions of GNNpress are introduced, you can update over the network 
instead of re-installing. Select File Upgrade GNNpress. You can download a new 
version of the software and install it.

Preferences You Should Set Now
If you want to use GNNpress to send email, you should set your Mail Address in the 
Network Preferences dialog. To see this dialog, choose the 
Tools Preferences Network menu item.
Chapter 10 covers Preferences in detail, but you might need to set the Proxy server now 
if your site is behind a firewall or if you connect to the Internet through a service 
provider who runs your connections. First ask your System Administrator if your are 
behind a firewall. Some hints that you might be are:
• You cannot ftp to a remote site.

• You cannot log in to a remote site.

• You can reach internal Web servers but no external Web sites.

Setting preferences for use behind a firewall:
1 Start GNNpress.
2 Choose the Tools Preferences Network menu item.
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3 Click the Always Proxy check box.
4 Ask your system administrator for the name of the Proxy server. Typically it is in 

the form hostname:port  (for example, www.mycom.com:81 ). Do not type the 
leading http://.

5 You may also need to set a SOCKS host name in this dialog if you are behind a fire-
wall. Ask your system administrator.



16 User’s Guide to GNNpress 1.1

Installing GNNpress
Preferences You Should Set Now2



Do-It-Yourself Authoring and Publishing for the World Wide Web 17

33 Getting Started:
Tour the Web and

Create a Page

In This Chapter . . .
A Little Background 17
What You See When You Start 19
Browse the World Wide Web 19
Create and Edit a Web Page 22
Save to Your Local Drive 27
Publish to the GNN Hosting Service 28

This chapter gives you a quick introduction to browsing and authoring with GNNpress. 
It takes you through step-by-step instructions on how to browse and create a simple 
page from a template. It also shows you how to use GNNpress to author a Web page 
and publish it to the GNN Hosting Service.

A Little Background
Before we start our tour of the World Wide Web and GNNpress, we’d like to explain 
a few of the terms you’ll see. They are a lot less mysterious than they sound.

• Web Pages: The documents you see on the Web are called “pages.” They contain 
text, images, and “links” that let you jump to other pages.

• Browse: When you look at a Web page, you are “browsing” that page, and the soft-
ware you are using is called a “browser”. Another term for browsing Web pages is 
“surfing.” GNNpress is both a browser and an “authoring tool” — because it lets 
you look at pages and create or change them.
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• Web server: The computer that stores the pages you see is called a “Web server.” 
It runs software that knows how to send pages and images to browsers.

• Web client: On the Web, the “client” is your own computer. You don’t need to 
understand “client-server computing” to use GNNpress. In case you’re curious, a 
“client” computer is one that sends requests to a “server” computer. The “server” 
processes the request, and the “client” takes care of showing you the results.

• URL: The strings of characters (like http://www.mycompany.com/ ) you keep 
seeing in advertisements are locations on the Web called Uniform Resource Loca-
tors or “URLs”. You can pronounce this as “you-are-els” or “earls”.

• Web site: All your pages, images, and other files make up your “Web site.”

• Home page: The first page you want people to see in 
your set of pages is called the “home page.” Other 
pages are just “pages.”

• MiniWeb: With GNNpress, you can treat all the 
pages, images, and other files in a directory as a small 
version of the Web — called a “MiniWeb.” A 
MiniWeb acts as a “File Manager” for your Web 
pages. You use MiniWebs to manage your pages and 
see connections between files.

• HTML: The language used behind-the-scenes to 
format Web pages is called HyperText Markup Language (HTML). In the past, 
people had to learn this language to create Web pages. Now, you can use 
GNNpress to create pages as easily as you would write a letter using a word 
processor.

• Publish: When you make your pages public to other people browsing the Web, you 
are “publishing” those pages. With GNNpress, publishing is about as easy as 
saving a file with a word processor.

Web servers Web client (or “browser”)
(GNNworks or GNNpress)

URLs

Pages/files

(Web pages published here)

Web site

Other pages 

“Home”
page

links
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What You See When You Start

To start GNNpress, either:

Double-click the GNNpress icon in the Global Network Navigator 
program group or folder.

By default, GNNpress starts with a Page Window with helpful pointers to 
documentation, support, and authoring assistance. You may set your 
Preferences  (see page 170) to bring up an empty Web page, a specific page or a 
MiniWeb.

Browse the World Wide Web
GNNpress is both a browsing and an authoring tool. In this section we cover briefly its 
use as a browser. As a browser, GNNpress offers many of the same capabilities you 
enjoy with the GNNworks browser. When you want to learn more browsing the Web, 
see Chapter 6.
The steps in this section assume that your modem is connected to the GNN service. 
(You can use GNNpress to create and access pages on your own disks even when your 
computer is not connected to the Internet. For example, while you create pages you 
may want to leave your modem off and then connect your modem to the Internet when 
you are ready to publish your pages. To find out how, skip to page 22.)

Location field:
enter URL to 
access a new
Web page
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Go Surfing!
This section shows you how to browse the Web with GNNpress. 

To start your tour of the Web:

1 Using your mouse, move the cursor to the Location field in the Page Window.

2 If there is any text in the field, hold your mouse button down and sweep over it. If 
your mouse has more than one button, use the left one.

3 Hit your Backspace key to erase the highlighted text.

4 Type http://gnn.com . (Don’t include the period.) Then press your Return key. 
This is the address or “URL” of the Global Network Navigator “home page,” 
which GNNpress will start loading.

Wait for a little while—the small animation in the upper right corner of the 
window tells you that the computer is transferring information. In addition, 
messages at the bottom of the page tell you when the connection is made and 
the size of the files that are being transferred.
This page changes every week, so don’t worry if it doesn’t look like the picture 
below. The instructions that follow lead you to a gallery of paintings that 
includes the Mona Lisa. If you find links to something else that interests you, 
go ahead and try those links. The exact path to the gallery of paintings may 
change, too. If the path changes, go ahead and explore on your own.

Linked image: 
Click on an area to see
the page linked to that
part of the image

Messages about file
transfer are shown here

“Download in progress”
animation
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5 Look for the text that says, “Whole Internet Catalog” or “WIC.” Click on this text 

to open the home page for the catalog.

6 Click on the “Select” link to move into the catalog.

7 You will see headings and words colored and underlined. These are hyperlinks. 
Move the cursor to the All Subjects hyperlink and click on it.

8 Scroll down and click on the Arts Exhibits link.

9 Scroll down the page until you find the Leonardo da Vinci Museum link (in the 
“Artists” section). Click on this link.

10 A page entitled Leonardo da Vinci Museum, appears. Click the GO button.

11 Scroll down to the Enter the Main Gallery hyperlink and click the mouse.

12 Click the East Wing link. “Postage stamps” of famous paintings appear.

13 Scroll down the page until you see the Mona Lisa postage stamp. Click on it. After 
a time delay, she fills a big part of your screen.

14 Now traverse backward by clicking the Back icon at the top of the Page Window. 
Then click it again. You can choose another wing of the museum to visit if you like.

As you browse the Web, you may see messages like “could not contact server.” This 
means the Web site you are trying to reach is either busy or not running. You can try 
the link again later. See page 54 for details about such messages.

Your Hot List
Browse the Web by visiting links that look interesting. If you find a page you would 
like to remember, you can add it to your GNNpress Hot List, a personal list of 
interesting pages.

To add a page to your Hot List:

1 When you are connected to a page that you want to 
add to your Hot List, choose the Browse Add to Hot 
List menu item. (That is, choose the Add to Hot List 
item from the Browse menu. We will use the  
arrow for menu choices in the rest of this document.)

2 Now you can use that Hot List item in this session 
and any time you use GNNpress in the future. Choose the Browse Hot List menu 
item. The title of the Web page you added is shown in your list.

3 Select the item you want and click Fetch to open that page.
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Create and Edit a Web Page
The steps in this section show you how to create a Web page for yourself. Your page 
will have text, links, and a way for people to send you email. And, you’ll be surprised 
how quickly you can create all of this.

To create and edit your personal Web page:

1 Create a Blank Page:
Choose the File New Page menu item. You’ll see a blank window that says 
“Please title this page.” This is just like a blank document in a word processor.

Let’s start by giving the page a title. In the Title field above the blank area, type 
“_____’s Page” and fill in your name. For example, type “Joe’s Page”. Press 
the Return key and you will see this title at the top of the window.

2 Type and Format Text in Your Page:
At the top of the page, type “Welcome to _____’s Home Page!” Fill in your 
name again. For example, type “Welcome to Joe’s Home Page!” Then, click on 
the welcome message you typed to make sure the cursor is in this line.
Choose the Format Heading Hdg 1 menu item. This makes your welcome 
message big and bold. Your welcome message will look like this:
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3 Create a List:

After your welcome message, type this text:

Use your mouse to highlight the lines that say “GNN” and “Webcrawler”. 
(Highlight all of both lines.)
Choose the Format List Bulleted List menu item to make these two lines a list.

4 Create Links to Other Pages:
Use your mouse to highlight the word “GNN”. Then choose the Element Link 
menu item.
Type the URL for GNN’s home page (http://gnn.com/ ) in the Link to Page 
field, like this. Then, click the OK button. The text that says “GNN” is now a 
link to GNN’s home page.

Double-click on the link you just created to the GNN home page. Double-
clicking opens a second window. (Don’t worry if you accidentally single-click 
on the link. You can use the Back button later to move back to the page you are 
editing. Your changes to the page will still be there unless you click the “Reload 
Page” icon.)
Follow the link on GNN’s page to the “Whole Internet Catalog” or “WIC.”



24 User’s Guide to GNNpress 1.1

Getting Started: Tour the Web and Create a Page
Create and Edit a Web Page3

From the Whole Internet Catalog, follow the link to WebCrawler.

Click the Copy URL button in the toolbar of the WebCrawler Page 
window.
Now move back to the window you were editing and use your 
mouse to highlight the word “WebCrawler”. Then choose the 
Element Link menu item.
With the cursor in the Link to Page field, press Ctrl+V to paste the URL you 
copied from the WebCrawler page into this field. Then, click the OK button. 
The text that says “WebCrawler” is now a link, too.

5 Create an Email Link:
After your list of links, type “Send me mail.”
Highlight the word “mail” and choose the Element Link menu item.
In the Link to Page field, type “mailto: ” and then your email address. Then 
click the OK button. For example:
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Click on the link you just created to try sending mail to yourself. You will see 
a page that looks like this. Go ahead and send yourself some mail.

6 Add a Background Color and Graphics:
Click the “Back” icon until you are back at the page you have been creating.
Choose the Format Body Attributes menu item. You will see this dialog, which 
lets you select colors for the background and text in your page.

Click the Pick button to the right of the Back-
ground Color field. You’ll see a color dialog. 
Click on a light background color like white or 
yellow. Then click the OK button in the color 
picker. The code for the color you selected 
will be shown in the Background Color field.
Click the OK button in the Body Attributes 
window. The background of your window will 
change to the color you selected.
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Now your page has a background color, but you probably want to add graphics 
to it, too. GNNpress comes with a library of clip art you can use in your pages. 
(Or you can use graphics you create with any other software.) To see the clip 
art library, choose the Help Templates menu item.

Scroll down and click on the link to the “Clip Art Library”.
Scroll down until 
you see the part of 
the table that lists 
the types of rules 
in the clip art 
collect. Click on 
the link to see the 
“Full Collection” 
of horizontal 
rules.
Find your favorite 
rule and drag your 
mouse across it to highlight it. Then press Ctrl+C to copy the rule.
Move back to the window for your page. (It should be under the clip art 
window.)
Place the cursor in your page and press Ctrl+V to paste the rule you selected. 
You can copy and paste graphics from any Web page to your page.
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Save to Your Local Drive
As you create Web pages, you should save copies of them to your local disk drive as 
described in this section. In fact, you can use GNNpress to create and save Web pages 
even when your modem is not connected. Then, when you connect to the Web, you can 
publish your pages as described in the next section.

To save your home page to your local disk:

1 Choose the File Save As menu item. A file selection dialog appears. (For details 
on using this dialog under Microsoft Windows or on a Macintosh, see page 40.)

2 Select your local drive in the field labeled Drives / MiniWebs / Sites.

3 In the Directory list (Windows) or the list of folders and files (Macintosh), double-
click on the directory or folder where you want to save your page.

4 Move the cursor to the Page Location field and add a file name of index.html  to 
the end of the page location. (Use a file name of index.htm  for your “home page” 
—the first page you want people to see when they visit your pages. If people don’t 
specify a file name when they visit your pages, the GNN hosting servers give them 
the index.htm file automatically.) For example, the Location on your local drive 
could be c:\mydir\index.htm  on Windows and BigDrive:Web 
Pages:index.htm  on a Macintosh. (The colons separate successive layers of 
drive, folder, and file names on a Macintosh.)

5 Click OK when you have finished setting the location.
See page 153 for ways to customize how GNNpress saves images and modifies links 
when you save a page.
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Publish to the GNN Hosting Service
Publishing on the Internet with GNNpress is as easy as saving a file on your computer 
as you did in the previous section — the steps are the same, except you save to the 
GNN Hosting Service instead of to your local disk drive and you are asked to enter 
your username and password. 
If you don’t have a GNN Hosting Service account, follow the instructions at 
http://gnn.com/gnn/join/index.html  (or on America Online at keyword: 
GNN ) to sign up for a free, unlimited-access, 1-month trial membership. Once you have 
your GNN “netname” (username) and password, you can publish pages as follows.
(See page 161 for more details on publishing pages.)

To publish your personal home page to the GNN Hosting Service:

Make sure you are connected to the GNN Hosting Service before you try to publish a 
page. If you do not yet have an Internet connection or a GNN Hosting Service account, 
you should skip the rest of this section.

1 Choose the File Save As menu item. The file selection dialog you saw when you 
saved the file locally appears. (For details on using such dialogs, see page 40.)

2 Click on the arrow to the right of the field labeled Drives / MiniWebs / Sites.

3 If you have Personal-level service, type http://members.gnn.com/ netname/ 
in the Page Location field. For example, if your netname is “snoopy”, type 
http://members.gnn.com/snoopy/

If you have Domain, Commercial, or Dedicated service, type the Web address for 
your domain. For example, type http://www.mycompany.com/ .
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4 Move the cursor to the Page Location field and add a file name of index.html  to 

the end of the page location. (The index.htm  file should be your “home page” —
the first page you want people to see when they visit your pages. If people don’t 
specify a file name when they visit your pages, the GNN server gives them the 
index.htm  file automatically.)

5 Click OK to save your page. The first time you save to your GNN Hosting Service 
location in each session, you will see this authentication dialog:

Type your netname and password if GNNpress prompts you for them. GNNpress 
will save the page and all the image files (lines, bullets, photos) associated with it. 
Saving the file across the network may take a few seconds.

If a page with the file name you typed already exists, a dialog will ask you 
whether to save the file, don’t save, or rename the page. 
If any of your images already exist in this directory, GNNpress asks you if you 
want to save it, don’t save it, rename it, or cancel. There is no need to re-save 
image files now, though you can if you wish. GNNpress will ask what you want 
to do for each pre-existing file.

Now your page is on the GNN Hosting Service! Your friends with Web browsers can 
see it if they look at the address where you saved the page (for example, 
http://members.gnn.com/ netname/). Don’t forget to add your page to your own 
Hot List, so you can get to it easily.
If you want to change your page in the future, just display your page with GNNpress. 
Make your changes with GNNpress, then choose File Save to publish your changes.
See page 153 for ways to customize how GNNpress saves images and modifies links 
when you save a page.
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The GNNpress user interface lets you work with Page windows and MiniWeb 
windows, choose commands, drag-and-drop, work with local or remote pages, and 
more. This chapter will give you an overview of the software, which will help you use 
it efficiently. This chapter also presents an overview of how to find your way around 
the online help system.

About GNNpress
Browse and Author

There is an important difference between GNNpress and other Web browsers. 
GNNpress is an editor and a browser. The editing and formatting features are not 
available in other Web browsers.
Because we integrate authoring and browsing, you can integrate reading and editing. 
If you are browsing (reading) a page on your GNN Hosting Service directory or a 
GNNserverwhere you have permission to change pages, you can correct an error that 
you see and republish the page.
You can copy material from pages you are browsing—text, images, hyperlinks, full 
URLs—and paste them into a page that you are authoring.
GNNpress and the GNN Hosting Service give you an integrated publishing solution 
for the World Wide Web.  As a subscriber to the GNN Hosting Service, you can 
publish your pages on the Web server GNN provides.
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Pages and MiniWebs
GNNpress uses two kinds of windows: Page windows and MiniWeb windows. You 
use Page windows to browse and author individual Web pages, and you use MiniWeb 
windows to work on a collections of related pages. When GNNpress starts, by default, 
you see a Page window. Page windows and MiniWeb windows are visually distinct 
from each other and have different menus and commands. However, basic principles 
about the interface, such as drag-and-drop and copy and  paste, work the same in both 
windows.
You can open many Page windows and MiniWeb windows. The number is limited by 
the amount of memory on your machine. Each page window has its own history.
This next section describes the window and menus you see when GNNpress starts up. 
It explains major elements on the screen and explains how to distinguish between the 
two kinds of windows used in GNNpress—the Page window and MiniWeb window.

Your Files and the GNN Hosting Service
GNNpress lets you create Web pages whether or not you are not connected to the GNN 
Hosting Service. You can save and test a set of pages as files on your own hard drive. 
When you are ready for the rest of the world to see your pages, just connect to the GNN 
service and save the files in your publishing space as shown in the previous chapter.

Publishing Pages to Other Servers
GNNpress can be used without the GNN Hosting Service or a GNNserver to browse 
the Web and to develop Web pages. However, you see the full power of GNNpress and 
the GNN Hosting Service when you use them both together.
If you want to publish to a Web server other than the GNN Hosting Service or a 
GNNserver, you can only save them directly if the Web server supports the HTTP 
(HyperText Transfer Protocol) PUT protocol. (Several other servers also support the 
PUT protocol, but disable it by default.) Otherwise, you will need to use ftp or some 
other file transfer method to move your files to the server.
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The GNNpress Environment
The Windows

This figure shows the major parts of the GNNpress screen. The following sections 
discuss these parts, the Page window, and the MiniWeb window.

You can resize Page and MiniWeb windows by dragging with the cursor. Click the 
mouse on the window border or corner and drag to the desired size and shape.

Title Bar
The Title Bar is at the top of the window. It contains the title of the Page or MiniWeb. 
The Title Bar lets you find the window you want when you have more than one 
window open.

Title bar

 

 

Minimize/
maximize
buttons

Menu bar

Location
field

Vertical
scroll bar

Body page
area

Status bar

Horizontal 
scroll bar

Tool bar 

Control 
menu
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Menu Bar
Beneath the Title Bar on some systems, above it on 
others, is a row of words. This is the Menu Bar. The 
menus in it give you access to the tools that the 
application provides. Each word is the entry into a 
pull-down menu. If you click on any entry (menu 
item) in the Menu Bar, you see a pull-down menu 
with several choices.
The available choices are shown in bold. Some 
choices are in faint type; they are unavailable for 
this particular page or MiniWeb. To activate a 
choice, move the cursor to it and click the mouse 
button.
In the Page window, the menus are File, Edit, 
Element, Format, Table, Tools, Browse, and Help. In 
MS Windows, there is also a Window menu.
In the MiniWeb window, the menus are File, Edit, View, Tools, Browse, and Help. In MS 
Windows, there is also a Window menu.

Toolbar
Below the Menu Bar is the Toolbar. It has icons (pictures) that correspond to common 
commands that you use frequently. The same commands are also available through the 
Menu Bar, but you can get to them more quickly through the toolbar.
To activate a command, move the cursor to the icon and click the mouse button.
See page 177 for information on customizing the toolbar.

Location Field
Below the toolbar is the Location field. It contains the URL (Uniform Resource 
Locator) of the page you are viewing. You can view another page by typing its URL 
in this field.

Title Field
Below the Location field is the Title field. It contains the title of the page you are 
viewing. It shows the same text as the window’s Title Bar. You can use the Title Field 
to change the text in the Title Bar. Just type a new title in the field and press Return.

Home Page Field
The MiniWeb has a Home Page field instead of a Title field. It contains the title of the 
home page in the MiniWeb you are viewing. You can select a different home page in 
this field with the arrow to the right.
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Scroll Bars

On the bottom and right side of the windows are Scroll Bars. Use them to move to parts 
of the page or MiniWeb not currently visible. You can click on the upward-pointing or 
downward-pointing arrows in the Scroll Bar on the right, to control upward or 
downward scrolling. Similarly, use the Scroll Bar on the bottom to control scrolling 
right or left. You can also move the “thumb” within the Scroll Bar to the approximate 
relative place in the page or MiniWeb.

Status Bar
At the bottom of the window is a Status Bar. As you work, messages appear there so 
the application can let you know what it is doing. If the mouse cursor is over a toolbar 
icon, the Status Bar shows the icon’s function.

Page Window
When you start GNNpress, you see a Page window.

GNNpress works on Windows and Macintosh systems. The interface takes on visual 
characteristics that are native to the platform the application is running on. Depending 
on your system, the startup screen may look a little different than the example, but the 
elements are the same and they work in the same way.
It is possible to make GNNpress start up by opening any page you like, a blank page, 
or both a new MiniWeb window and a new Page window. See page 170 to set the 
startup window.
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Page Window Toolbar
The Toolbar gives you quick access to frequently used commands such as Cut, Copy, 
Paste, and Copy URL. There is also a MiniWeb icon and a Page icon. See page 177 for 
information about customizing the toolbar. 

Status Bar
At the bottom of the window, the Status Bar lets you know what the application is 
doing. For example, if you click on a hyperlink to cause a page to be transferred over 
the network, the Status Bar will continually update information about the transfer.

Page Window Menus
Here is the menu bar for the Page window. 
Click on any menu to see the choices it offers.The File menu operates on Pages either 
locally or remotely over the Web. Edit, Element, Format, and Table are all used to author 
pages. The Tools menu has special utilities and functions, including some to access a 
GNNserver. Browse has viewing capabilities. Window (Windows only) lets you 
rearrange multiple GNNpress pages on your screen. Help provides access to 
documentation, search tools, and examples.
(See page 180 in Appendix A for a brief list and description of all the menu items you 
see when you are using a Page window.)

Cut Copy Paste Copy 
URL

Insert 
Image

Make 
Link

Show 
HTML

Reload Back Forward Stop

Page MiniWeb
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MiniWeb Window
The MiniWeb is like a “File Manager” for your Web pages. It helps you organize and 
manage the files that make up your Web site. It gives you with a graphical view of the 
collection of files showing all the pages and any other files (such as images and 
sounds) and the connections between them. One page is designated as the home page 
(it is displayed with a special icon—a spider at home in its web). If a page links to 
another page outside your directory, those pages are also shown.
A MiniWeb uses icons to represent files (pages) and arrows to represent the links 
between them. Icons can be dragged and dropped into other MiniWeb windows and 
into Page windows. Arrows between icons represent links between the files. 
MiniWebs are color coded to show the status and relationships of the files in the 
MiniWeb:
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MiniWeb Window Toolbar
The toolbar gives you quick access to frequently used commands such as Open, Import, 
and Save As.

Status Bar
At the bottom of the window, the Status Bar lets you know what the application is 
doing.

MiniWeb Window Menus
The File menu operates on either Pages or MiniWebs—opening, saving, closing—
either locally or remotely over the net. Click on any entry to access tools associated 
with the application. The Edit menu is used to copy URLs from or to the MiniWeb. The 
View menu controls the viewing scale and redraws the MiniWeb. The Tools menu has 
utilities or functions to access special services on the GNNserver. Browse examines the 
history and the Hot List. Help provides access to documentation, search tools, and 
examples.
See the following sections for descriptions of the menus in MiniWeb windows.
(See page 187 in Appendix A for a brief list and description of all the menu items you 
see when you are using a MiniWeb window.)

Dialog Boxes
Selecting a pull-down menu item that has three dots at the end (for example, 
File Open...) will open a dialog box where you type text or click buttons. Some 
dialogs require you to close the dialog (perhaps with the Cancel button) before you can 
continue other operations in GNNpress. Your machine will beep if you need to close 
a dialog before moving to a different window.

Operations
Online Help

GNNpress provides several ways you can find answers to your questions—you can 
click the Help button in various dialogs, or you can use the Help menu.

New 
MiniWeb

New 
Page

Open Import Save 
As

Cut Copy Paste Stop
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Get online help in a dialog:

While in a dialog box, click the Help button, or press Help or F1 on your keyboard, 
to get specific help on that dialog.

Search the Help table of contents:

Choose the Help Contents menu item. You will see a page that contains and 
describes links to various help files. For example, you can click on the link to the 
online User Guide to search the online version of this book.

Search for Help by looking up a word:

1 Choose the Help Search For Help menu item. You will see a page with links to the 
GNNpress online documentation. 

2 Click the GNNpress documentation link. If you are not connected to the GNN 
Hosting Service, the dialer appears. Once you are connected, you see this page.

3 Type a word or words in the field, and click the Search button. You will see a list 
of sections that contain those words. You can click on a link to move to that section.

Open an example Web page you can start editing:

1 Choose the menu Help Templates.

2 Select a template from the list. Each template is a group of pages and images.
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Look at the list of Frequently Asked Questions:

Choose the menu Help FAQ.
This is a common Internet term, usually abbreviated FAQ and pronounced “fack”.

Get contact information for help with technical questions:

Choose the menu Help Technical Support.

File Selection and Network Operations
The following commands in the File menu open file selection dialogs: Open, Save, Save 
As, Import, Copy File, and Delete. In addition, the Browse buttons in various dialogs open 
similar dialogs. These dialogs allow you to manipulate files on both your local disks 
and on your GNN Hosting Service directory. When you save or open a file on your 
directory, you may be prompted for a user name and password if the file or location is 
protected.
See page 27 for steps that show you how to save pages to your local disks and to the 
Web.

MS Windows
The file selection dialogs under Microsoft Windows are much like file selection 
dialogs in other Windows software.

• In addition to selecting local disk drives (such as C:\ ), the Drives / MiniWebs / Sites 
field lets you select your GNN Hosting Service directory 
(http://members.gnn.com/ netname). See page 176 to learn how to add more 
directories to this list.
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• The Location field uses Windows file paths, such as c:\mydir\index.htm  for 
local files. For files on a server, the Location field uses URLs, such as 
http://members.gnn.com/netname/myfile.htm .  For pages, use a file 
extension of .htm (for example, mypage.htm ). For MiniWebs, use no file 
extension.

• MiniWebs are stored both as directories and files, so they show up in both lists. 
Double-click on a MiniWeb in the Directory list to see a list of the files in the 
MiniWeb. Double-click on a MiniWeb in the Files list to perform the dialog’s 
action on the MiniWeb.

Macintosh
File selection dialogs on a Macintosh contain several fields in addition to the ones you 
normally see in Macintosh file dialogs.

• You can type the full location of the file or a URL directly into the Location field. 
Local disks, folders, and files are separated by colons (:) in this field. For example, 
BigDrive:Web Pages:Club:index.htm references a file in the Club folder of 
the Web Pages folder on a drive called “BigDrive”.

• In addition to selecting local disk drives, the Drives / MiniWebs / Sites field lets you 
select GNNservers you have used before. See page 176 to learn how to add more 
GNNservers, MiniWebs, and other directories to this list.

• After you use the Drives / MiniWebs / Sites field and the scrolling list of files and 
folders to find a directory, you can type a file name at the end of the text in the Loca-
tion field. To make your pages portable to all other platforms, it is best to use file 
names with 8 characters and no spaces. For pages, use a file extension of .htm  (for 
example, my_page.htm ). For MiniWebs, use no file extension.

File location or
server URL

Select local disk
or remote server
Browse up 
folder tree

Select type of
file to look for

Select a file or 
folder
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• The “..” folder in the list of files and folders moves you up one folder level.

• The Desktop button moves you to the files and folders on the Macintosh desktop.

Choose Commands
GNNpress gives you several options for choosing commands to execute. You can use 
the toolbar icons, the pull-down menus, or command keystrokes. These options give 
you speed when you know the command you want and a complete view of the 
commands when you need it.

Short Menus
One of the choices in Tools Preferences General is Short Menus. If the Short Menus 
option is selected, the Page and MiniWeb menus are abbreviated to exclude options for 
using MiniWebs and administering pages and servers. See page 179 for a list of the 
menu commands and specific differences between Short Menus and Full Menus. 

Undo Commands
The first items in the Edit pull-down menu are Undo and Redo. Each Undo command 
backtracks another step through the changes you have made. Redo reverses the last 
Undo.

Names for Pages and Directories
URLs

You can name page URLs, MiniWeb URLs, and directory URLs anything you want, 
but you will find your Web pages easier to manage if you give them distinctive names. 
Page URLs should end with .htm, MiniWeb URLs with .mw. Directories should not 
have a suffix.

Conventions Between Platforms
When you save files with GNNpress on Windows systems, you can use filenames with 
up to 8 characters plus a 3-character suffix after a period. When you save files on a 
Macintosh or the GNN Hosting servers, you can use longer file names. In general, to 
make files portable to any type of computer, it’s best to use the “8.3” filenames 
required on Windows.
You should use .htm as a suffix for HTML files on Windows, not .html.
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This book covers many details about the Web: how to author pages, manage and 
arrange them, publish them to a server, and use forms. In this chapter we cover a few 
basic concepts that appear in several places in the rest of the text.

Hypertext Markup Language (HTML)
The Hypertext Markup Language (HTML) is the standard language that Web pages 
use to specify the links and structure of a document. The Web itself is independent of 
the data transferred, but all current browsers can render HTML into a readable page on 
your screen.
Detailed information about the HTML standard is available on the Web at  
http://www.w3.org/hypertext/WWW/MarkUp/MarkUp.html (or simply 
follow the hyperlink to HTML at http://www.w3.org/ ).
In this book we cover only a few of the details, because GNNpress makes most of them 
transparent to you. You edit with GNNpress much as you would with a traditional 
word processor. 
There are some limitations because of HTML’s inability to support some common 
attributes of publications (like nicely formatted equations), but there are compensating 
benefits, mainly the ability to create a link to anywhere in the world. After you have 
created a page, GNNpress helps you package and save it onto a friendly server near 
you, and anyone with access to any Web browser can access it.



44 User’s Guide to GNNpress 1.1

A Few Basics About the World Wide Web
Structure and Layout of HTML Documents5

Structure and Layout of HTML Documents
There is an important difference between Web pages and the documents you create 
with a typical word processor. With a word processor you assign appearances to 
elements that make up your document. For example, a document contains various 
levels of headings, paragraphs, bulleted lists, numbered lists, page headings, and page 
numbers. When we wrote this document, for example, we specified that Level 1 
headings like the one above are shown in numbered, in 20-point bold Helvetica.
When you create a Web page, you cannot do this. You specify only the structure of the 
page—six levels of headings, three types of paragraphs, three kinds of lists, a few 
fonts. GNNpress lets you create a Style sheet that defines the appearance of each 
structure, but people browsing with another tool can define these relations differently. 
In short, the reader controls the appearance of the page, not the author or publisher.

Markup Tags
HTML contains several categories of “tags” you use to structure pages. The minimum 
set of tags you need to create a page are Titles, Headings, and Paragraphs. This section 
just gives you an overview of the types of formatting HTML allows; GNNpress 
handles the syntax of the tags for you.

Titles
Every HTML page should have a title. A title is generally displayed above the page 
and is used to identify it in other contexts (for example, the title appears in the  Hot 
List). Choose about half a dozen words that describe the document’s purpose.

Headings
HTML has six levels of headings, numbered 1 through 6, with 1 being the most 
prominent. Headings are displayed in larger and/or bolder fonts than normal body text.

Paragraphs
Most of the text in Web pages is in paragraphs. Browsers handle the lengths of the 
lines. If you change the size of a window, the lines on the pages rewrap correctly.



A Few Basics About the World Wide Web
Uniform Resource Locators (URLs)

Do-It-Yourself Authoring and Publishing for the World Wide Web 45

5
Additional Markup Tags

Your document can also have various kinds of lists (unnumbered, numbered, term-
definition pairs) that you can nest. You can also include quotes, addresses, and text that 
is “preformatted” so that the spacing and line breaks will not change.

Character Formatting
HTML allows formatting of specific words or characters. You can designate words to 
be emphasized, underlined, italicized, and more.

Links to Other Documents
HTML’s distinctive feature is the hyperlink, which is a link to other documents. These 
appear in a distinctive font, and clicking on one will fetch the page it references.
Links can be relative to the current page or absolute. You can have links to other 
locations in the same page and links to specific places in other documents.

Images, Graphics, and Other Special Features
HTML includes mechanisms for transmitting “in-line” images, that is, images 
included on the page, and “external” images, which you click on a link to display.
Documents can also include graphics, animation, sound, and other special files by 
associating an external program that can display or play them.The GNNworks browser 
comes with a number of these external viewers.

Uniform Resource Locators (URLs)
The cryptic strings of characters (like http://www.mycompany.com/ ) you keep 
seeing in advertisements are addresses on the Web. These addresses are called 
Uniform Resource Locators or “URLs.” You can pronounce this as “you-are-els” or 
“earls.” Browsers use these addresses to find Web pages and other files on the Internet.
You can think of a URL as being a little like a file location on your disk drive. 
However, the URL also tells the location of the file on the Web and how to read the file.
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Anatomy of a URL
URLs contain three types of information. (Well, if you start writing programs for the 
Web, they can contain more than that. But, we won’t get into that now.)

• Access method: Most URLs you see have an access method of http , which stands 
for HyperText Transfer Protocol. This is the standard protocol used to send Web 
pages across the Internet. (That’s really all you need to know about it unless you 
want to write programs for the Web.) If you see a Web address starting with some-
thing like “www.mycompany.com ”, you need to put “http:// ” before that 
address to read that page with GNNpress.
Other common access methods are: file , ftp , and mailto . Other access 
methods—such as gopher, news, and wais— need a proxy server, which you can 
set in the Tools Preferences Network dialog. See page 172 for details. Read the 
http://www.ncsa.uiuc.edu/demoweb/url-primer.html  page if you want 
to learn more about URLs for other access methods.

• Computer location: The next part of the URL tells which computer holds the file. 
The location is usually “www. ” plus the “domain” name you see in email addresses 
from this location (such as aol.com  or gnn.com ). Some URLs contains a different 
prefix or no prefix before the domain name. You may occasionally see a number 
after the domain name. This is called a “port number.”

• File location: The last part of the URL tells where to find the file on the computer. 
The file location can contain a directory path and/or a file name. If you omit the 
directory, the top-level directory on the Web server is used. If you omit the file 
name, the default “home page” file name on the Web server is used. On most Web 
servers, the default home page is index.htm  or index.html . For example:

With GNN, you save your pages in a subdirectory that matches your “netname”, the 
name you use to connect to the service. You default home page is index.htm .

Location in URL Directory File
.../subdir/file.htm Use the “subdir” directory 

below top-level directory.
Use the “file.htm” file.

.../file.htm Use the top-level directory. Use the “file.htm” file.

.../subdir/ Use the “subdir” directory 
below top-level directory.

Use the default home page 
name for this Web server. 

.../ Use the top-level directory. Use the default home page 
name for this Web server. 

http://members.gnn.com/netname/index.htm

File location Computer location  Access method  



Do-It-Yourself Authoring and Publishing for the World Wide Web 47

Part 2:
Create and

Publish Web
Pages

GNNpress and the GNN Hosting Service 
form an integrated client-server network 
publishing system for creating content, 
managing information, and developing 
applications on the World Wide Web.

The integration of browsing and authoring lets you create, read, and edit both 
local and remote Web pages. With the MiniWeb you can visualize and 
organize a collection of pages into a document, and a forms interface lets you 
design forms for the user to input information.
Chapter 6 covers browsing in detail. Chapter 3 in Part 1 gave you a brief 
introduction.
Read Chapter 7 to see how easily you can use GNNpress to create interesting 
Web pages.
Chapter 8 describes the MiniWeb, which helps you organize and manage 
collections of pages.
Chapter 9 covers publishing Web pages to servers.
Read Chapter 10 to learn how to customize GNNpress by changing your 
Preferences.
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This chapter explains how to use GNNpress to navigate and read information on the 
World Wide Web. While GNNpress is primarily an a tool for creating HTML and 
publishing to the GNN Hosting Service or to a GNNserver, it is also a browser. 
Familiarity with GNNpress and its differences from other Web browsers is also 
important when you create pages. 

Things to Know About Browsing
You use a Page window for browsing with GNNpress. This is also the window you use 
to create Web pages.
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Different Ways to Navigate
As the following figures show, there are several ways to find and display the page of 
a URL in GNNpress.

Open a URL with GNNpress:

If you know the URL, you can type it directly in response to the File Open menu.
You can follow a link in an open page to a new page (a new URL).
Each GNNpress Page Window keeps a history of the current session. Using the 
Back and Forward buttons at the top of the window, you can traverse to any page in 
the list of pages that GNNpress has displayed in this Page Window in this session. 
You can also scroll through the list of available pages.
The GNNpress Hot List keeps track of addresses that you have placed there. You 
can use the Hot List to “remember” names of interesting Web pages, and consult 
your Hot List when you want to return to a URL you previously found.
GNNpress keeps a Global History of the current session. You can jump back to any 
page in the list of pages that GNNpress has displayed in any Page Window.
There are many Web pages that provide information services for the World Wide 
Web. You can use these to search for information.

Open URLs:

Follow hyperlinks:

Use the Tool Bar: Use the Menu Bar:
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Directory Services—Finding Things on the Web
Normally you find information on the Web by following links. While this mechanism 
often leads you to unexpected treasures, it is not efficient. The Web has a great 
navigation architecture, but it lacks an information architecture. The normal method of 
browsing is somewhat like using a library whose main search mechanism is to pick up 
a book and then follow references from book to book. Moreover, the books’ titles 
relate only vaguely to their content. Without indexing services and ways to search for 
information, Web pages are strewn throughout file systems all over the world with no 
relationship to each other except through URLs.
Fortunately several institutions or companies have filled this void by creating Web 
pages whose main purpose is to catalog and provide search mechanisms to find other 
pages on the Web. Because they were created independently, their search mechanisms 
are different, so we do not describe them here. Some of the more popular sites are:

• Global Network Navigator and the Whole Internet Catalog. This site gives you 
news, articles, and an online community called “Netizens”—http://gnn.com/

• WebCrawler, a keyword searcher of Web pages—http://webcrawler.com/

• Yahoo, a catalog and search engine—http://www.yahoo.com/

• Infoseek, a full-text commercial search service—http://www.infoseek.com/

• Lycos, an Internet catalog served by Carnegie-Mellon University—
http://lycos.cs.cmu.edu/

Surf the Web
Quick Start

Here is a quick summary of commands you can use while browsing the Web:

Get Pages

When you know the URL Location field at top of page, or File Open 
menu, Location field

Hyperlinks Single-click on the hyperlink (double-click to 
get the page in a new window)

Window history Click drop-down arrow of Location field in page 
window.

Global history Browse Global History
Click Fetch button
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Open Pages
The File Menu and the Location Field

To use the Page Window as a browser when you know the URL, type the URL in the 
Location field in your Page window.
Position your cursor in the field and edit the current URL. You can Backspace to get 
rid of the current URL and type in a new one, or you can move the cursor and edit 
specific parts of the current URL.
For example, to look at the Global Network Navigator home page, type 
http://gnn.com/  and then press the Return key.

What You See When the Page Opens
A small web animation appears in the top right corner of the GNNpress Page window. 
This animation indicates that GNNpress is searching for and loading the page. The 
status bar at the bottom of the window shows what GNNpress is doing. The page you 
requested is shown when it has been loaded.

Hot List Browse Hot List

Viewing

Back Back button at top of page

Forward Forward button at top of page

No images Tools Preferences General

Stop loading Stop button

Reload Browse Reload Page or press Browse button in 
Tool Bar

Hot List

Add URL to Hot List Browse Add To Hot List

Edit Hot List Browse Hot List
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Notice several changes while the page is loading.

• The stop button in the toolbar becomes “active” and is no longer fuzzy. 
If you want to stop the current function—for example, loading a new 
Web page—click this button. To resume loading after you have stopped 
it, use Browse Reload Page. This transfers the page and images again.

• The status bar at the bottom of the window shows a message about the current state 
of the current action, or, if your cursor is pointing to a toolbar icon, the status bar 
displays the button’s function.

If you have set your preferences so that pictures are loaded by default, you 
may see hour glasses appear in the page, soon to be replaced by images. The 
hour glass appears while an image is being loaded, and is replaced by the 
image when it is ready to be displayed. If your system and network 
connection are fast enough, images may load before you see the hour glass.
If you have set your preferences so that pictures are not loaded (see page 
168), a question mark appears and the image does not appear automatically. 
This is a useful option if your modem is not very fast. In this case, you click 
the mouse on the question mark to cause the image to appear.
A lightning bolt appears if the image cannot be loaded. This usually occurs 
because a hyperlink has broken.

Scroll
Most Web pages are longer than a screen. On the right and bottom sides of the 
Page window, and many other windows, are Scroll Bars. They consist of two 
arrows with a bar, called a “thumb,” between. For the scroll bar on the right side 
of the window, click and hold on the upward-pointing arrow to move the viewing 
window up the page. Click and hold on the downward-pointing arrow to move 
down the page. The position of the thumb corresponds to the current position 
within the page. Moving the thumb downward causes the view to jump 
downward; moving upward causes the view to jump upward. Moving the thumb 
to the bottom of its slot causes the view to move to the bottom of the page.
The scroll bar at the bottom of the window behaves similarly, but it controls right 
and left motion, not up and down.
Similar scrolling features are by the Location field on the Page, but there is instead just 
one downward-pointing arrow, and no upward-pointing arrow nor vertical bar.

Follow Hyperlinks
Once you open a Web page, you see words that are italicized and underlined, like this. 
These are hyperlinks that refer to other URLs. Clicking on a hyperlink causes that new 
URL to be displayed, in the same Page window if you single-click, or in a new Page 
window if you double-click.
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Multiple Windows, Multiple Pages
One of the more useful features of GNNpress is the ability to open multiple Page 
Windows and browse in all of them. The number of windows you can open is limited 
by the amount of memory (RAM) your computer lets GNNpress use. You will see a 
message if you do not have enough memory to open another window.

Clone a Page
Double-click on Page icon to the left of the Location field to open another 
window showing the same page.

Unsuccessful Openings
Sometimes the URLs or pages you request do not open successfully. When GNNpress 
cannot open a page, the server usually gives a helpful message. Some of the reasons 
for the lack of success are beyond your control. 
A common cause of problems is that the link you tried to follow was incorrect. 
Sometimes a URL connected to link has moved, yet the link is still there. You can 
sometimes figure out bad links. Look for the following possibilities if you typed the 
URL correctly:

• Some URLs require the trailing slash be at the end of a directory.

• Sometimes the file name requires the .html file ending and the author forgot to use 
it. Try .htm as well.

Other messages you might see are:

Retrieve Failed Usually the result of a server error, which may be out of your 
control. Browse Reload Page may produce the correct result.

Couldn’t Find 
Server

GNNpress couldn’t find the URL that contains the page. Either 
the URL is wrong or the server that contains the page is down.

Not Found The filename is wrong, even though the server may be correct. 
Sometimes this occurs because a link points to a file that no longer 
exists.

Couldn’t find File 
/ Page/MiniWeb 

The file is not available. Sometimes this is because there are too 
may people trying to access the server that contains the page you 
want to see.

“Forbidden” You do not have permission to access a particular page.
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Moving Around the Web
Sequential Browsing—Follow Links

To jump to a hyperlinked page: 

To jump to a page that is “hyperlinked” to text in the current page (blue color, italics, 
underlined) click the mouse on the appropriate text.

Single-clicking replaces the page in the current Page Window with the new Web 
page.
Double-clicking creates a new Page Window showing the new Web page.

Backward and Forward
After you follow a hyperlink you notice that the Back button is no longer fuzzy.

Backward:

Click this button to take you back a page. The backward function is also 
available in the Browse menu: Browse Backward.

Once back in the home page, you should notice that the Forward button is 
no longer fuzzy.

Forward:

This button takes you to a Web page you have just come back from.
With these two buttons you can traverse all the Web pages you have visited 
in this Page Window. The forward function is also available in the Browse 
menu: Browse Forward.
Notice also that the underline for the hyperlink you followed is purple instead of blue, 
and the underline is now dashed. Purple text means that the page that this link points 
to is cached (stored in local memory). Hence it is much faster to use that link again, 
because GNNpress no longer has to download the page across the Internet. The 
network link to the URL is not kept open after the page is transferred.
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Reload Page
When you load a page it is cached (that is, it is stored in your computer’s 
memory). If you open the same page again, it does not have to be 
transferred over the network again. However, if for some reason you need 
to reload the current page you are viewing in the Page Window (either 
because you think the original page has changed) you may use the Reload 
button or the menu item Browse Reload Page. This causes the page to be transferred 
over the network again, even if the page is locally cached.
When you reload the page, GNNpress shows any changes to the document since you 
last visited it. Some Web pages change often, sometimes by the minute. Weather or 
time Web sites reload the current page with the current data.
If you are also editing pages with GNNpress (in addition to browsing), you should save 
any changes to your pages before you reload. Attempting to reload a page that has been 
edited produces a dialog box asking you to save your changes or reload and lose 
changes.

Stop
If you want to stop the current function, for example, loading a new Web 
page or image, press this button. The status bar at the bottom of the Page 
Window says “aborted http://...” To resume loading after you have stopped 
it, use Browse Reload Page. This causes the URL to be transferred again.

View Locations Within a Page
Some pages have links to internal anchors, which look like hyperlinks that have been 
already been used. They simply point to a location within the same page. You can read 
a page by just scrolling upward and downward, but these anchors let you move to 
specific sections. Click on the link to jump to the anchor it points to.
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History—Remember Where You’ve Been
You can open URLs that you have viewed before during this session using GNNpress’ 
history.

Window History
Click the down arrow to the right of the Location field to see a list of all Web pages you 
have visited during this session in that Page Window. You can re-open any page in this 
list by selecting it. This menu only lists pages opened from this window; it does not list 
pages visited from other windows you may have opened. 

Global History
A similar list of all Web pages viewed by any Page Window during this session is 
available if you choose the Browse Global History menu item. A list of Web pages 
appears. If the list is too long to fit in the small window, use the scrolling arrows on the 
right side of the window.

To view a page from this history, double-click on it to select it from the list, then click 
the Fetch button.
You can open a Global History or Hot List item without opening a new page by using 
the Copy URL button to copy the URL of an item to the clipboard. Then, in a Page 
Window, paste the URL into the Location field.
Closing the GNNpress application automatically clears your global history. Each 
launch of GNNpress begins a new global history.

Chronological
list of all pages
visited in the
current session
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Hot List—Keep Track of Interesting Web Pages
GNNpress also allows you to keep a Hot List from session to session. This is a list of 
Web sites (URLs) that you think you might visit frequently, or that you want to 
remember and access easily. Unlike the history list, the Hot List is maintained after you 
finish your session and exit GNNpress.
This list is stored in your GNNpress preference file, which GNNpress creates 
internally when you use the Preferences option under the Tools menu. Deleting this file 
erases your list.

Adding or Opening a Page

To add or open a page:

1 Go to that page in the Page Window (enter the URL in the Location field, or if you 
have visited it already choose it either from the Browse Global History menu or by 
scrolling the arrow to the right of the Location field).

2 Choose the menu item Browse Add To Hot List to add the page to the list. To see 
the list, choose the menu item Browse Hot List.

3 Double-clicking on any entry in the Hot List brings up that page in the Page 
Window, or you can single-click on any entry to select it, then click the Fetch 
button. If no entry is selected, the Fetch button is inactive.
You can open a Hot List item without opening a new page by using the Copy URL 
button to copy the URL of an item to the clipboard. Then, in a Page Window, paste 
the URL into the Location field.

Collection of
commonly
visited Web
locations
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Editing and Formatting the Hot List

When you add a page to your Hot List, it is added to the end of the list. You can edit 
and rearrange your Hot List. The buttons in the Hot List have these functions:

View the Pages
Print a Page

Choose the menu File Print to print the current page. The menu File Print Setup lets 
you specify various printing options—size of page, orientation, scale, and color.

External Viewers
Some links in Web pages point to files that GNNpress cannot display. Included in this 
category are such objects as images, video clips, audio clips, and PostScript files. 
When you click on the link to one of these types of files, GNNpress can launch an 
external viewer, and the contents of the file appears on your screen or plays through 
your audio device.
GNNworks comes with a number of external viewers. You may want to use 
GNNworks instead of GNNpress to view these types of files.
If you have not specified an external viewer for a particular type of file, GNNpress 
copies the file to your local hard drive, and asks you for a file name. To set external 
viewers for GNNpress, see page 174.

Fetch Causes the selected page to be displayed in the Page Window. 
Click on Fetch after you have selected an entry from the list.

Close Closes the Hot List Window.
Add Label Allows you to add a label above a selection in the list. When you 

click on Add Label, a dialog box appears and asks you for the 
name of the label. Type the name in the box indicated.

Add Separator Adds a line across the list above the selected item.
Move Up Select an entry, a separator, or a label. Click Move Up to raise the 

selection one notch up the list.
Move Down Select an entry, a separator, or a label. Click Move Down to lower 

the selection one notch down the list.
Remove Removes the selection from the list.
Copy URL Copies the URL of the selection. You may then Paste the URL.
Help Invokes the help window about the Hot List.
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Browsing Preferences
Load Images

If this option is not selected, then when opening a page, images in that page are not 
loaded. Instead a question mark is placed where the image would appear. Clicking on 
the question mark causes the image to be loaded. This can save time if your modem is 
not very fast. See page 168 for details.

Pre-Fetch Pages
If selected, then whenever a web page is opened, all pages to which that page links to 
are loaded into local memory. While this option causes the initial loading to go more 
slowly, browsing is much faster after the pages are loaded. See page 169 for details.
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GNNpress is an easy-to-use word processor for creating and editing Web pages. As 
you create a page, it looks exactly as it does when you view it with GNNpress as a 
browser. GNNpress creates pages in the Hypertext Markup Language (HTML), so any 
Web browser can view them. You never have to look at the HTML itself, although you 
may.
GNNpress also lets you publish your pages directly to the Web. You can browse the 
Web while creating a page, and you can import information over the Web and 
incorporate it into your page. You can also follow links in your page as soon as you 
create them. Your page is a fully functional Web page right from the start.

Things to Know About HTML
HTML Basics

The Hypertext Markup Language (HTML) is the common language used by browsers 
and servers on the World Wide Web. It specifies the structure of Web pages—levels 
of headings, links, images, forms, and more. When the Web was created in 1992, 
people edited HTML documents by hand, as one would with non-WYSIWYG, tag-
oriented word processors.
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Although GNNpress hides HTML details from the reader and author, there are still 
some basic functions about HTML that you should know.
There is an important difference between Web pages and the documents you create 
with a typical word processor. With a word processor you assign appearances to 
elements that make up your document. For example, a document contains various 
levels of headings, paragraphs, bulleted lists, numbered lists, page headings, and page 
numbers. When we wrote this document, for example, we specified that Level 2 
headings like the one above are shown in 16-point bold Helvetica.
When you create a Web page, you do not do this. You specify only the structure of the 
page—headings, three types of paragraphs, three kinds of lists, a few fonts. GNNpress 
lets you create a Style sheet that defines the appearance of each structure, but people 
browsing with another tool can define these relations differently. In short, the reader 
controls the appearance of the page, not the author or publisher.

Design Guidelines
Creating HTML is easy—witness the proliferation of Web pages—and GNNpress 
makes it easier. The following hints will help you plan and create better pages.
More information on using HTML is available via the Web at http://www.w3.org 
/hypertext/WWW/Provider/Style/Overview.html  (or just follow the HTML 
link, then the Information Provider Materials link from http://www.w3.org/ .

Headings
• Do not use a header level smaller than Hdg 3 for text that you want to be read easily 

or in the main part of the document.

• Use the various Hdg styles as headers. To make text dark or bold, use the menu 
Format Type Style Bold or Format Type Style Strong.

Images and Graphics
• In the Alignment box under the Element Image menu item, check the Bottom, Left, 

or Right button for images, so text wraps nicely for those readers who make their 
window narrow. If you use Middle or Top there will be a large gap between lines.

• Some readers still use browsers that don’t display images. You should add some 
text in the Text for non-graphic browsers field for these readers.
• For non-linked images this field should describe the image.
• For linked images this field should tell where the link goes.
• Use brackets to surround the text in the Text for non-graphic browsers field, for 

example [Lightning bolt image] . This has a nice look on browsers that 
don’t show graphics (like Lynx).

• Keep image files smaller than about 30 Kbytes.
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Structure of Set of Web Pages

• When including textual or pictorial navigation aids, place cues on the left side to 
go back or to the previous page. Use the right side to go forward or to the next page.

• When doing slide presentations use Prev/Next links not Next/Prev to match the orga-
nization of browser navigation buttons.

• To keep the reader from getting lost, organize the information in a hierarchical 
format with a shallow depth (about five layers maximum), and a wide base.
• Let readers move down the hierarchy quickly by providing bulleted/graphical 

indexes or main menus with textual and/or visual clues about the pages to which 
you link.

• Typically, the title of the page should also be in the text of the page as a Hdg 1.
• Bulleted graphics or image maps can exist on your page and are often next to the 

Hdg 1 title.
• Provide header and footer navigation bars (text or graphics) for moving up and 

down throughout the hierarchy.

HTML vs. Word Processors
When the Web was created, people first wrote pages by typing HTML tags by hand—
just as they would write computer programs. Now, GNNpress lets you create pages 
without worrying about the HTML tags. You edit Web pages as you would edit 
documents with a word processor.
You’ll need to remember that HTML does not give you as much control over page 
layout as a word processor. The reader also has some control over how your pages 
look. The reader decides how big to make the browser window, and often the reader 
can even change the font your pages use. 
Here are some things you should remember as you design pages:

Multiple spaces
Normally in HTML, any number of space is shown as one space. This means that if 
you type two spaces, you will only see one. If you type a tab it will also show up as a 
space.
GNNpress provides a way for you to type multiple spaces by using special “non-
breaking space characters.” You can turn on this capability by choosing the 
Tools Preferences menu item and selecting the “Non-breaking” option in the Text Edit 
Spacing field. However, some browsers will show “&nbsp;” instead of spaces if you 
do this.
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Paragraph Formatting
In some word processors, if you want to grab paragraph formatting when copying a 
selection so that you can paste it, you grab the entire line at the end of the paragraph. 
In GNNpress, you need to grab the blank line before the paragraph, instead. (In HTML 
the information about the paragraph is stored in a tag before the paragraph.)

Bullets in Lists
Bullets are not characters that can be selected. Think of them as part of the line break 
between paragraphs. The only way to select or delete bullets is to select or delete the 
line break.

Styles
The style sheets in GNNpress provide a description for how each HTML element is to 
be displayed. Only one style sheet may be used in a page. Style sheets affect only how 
the page is seen by other GNNpress users.
There are ways style sheets can lead to confusion. If your Level 1 heading is displayed 
in a bold font, that is different from using the Bold emphasis.

Titles
Every page has a title. This is different from the file name. The title is what will be 
placed at the top of a window displaying the page. Changing the title will not change 
the URL, nor will changing the URL change the title.

Images
GNNpress can display gif, jpeg and xbm files as in-line images at the moment. All 
others require an external viewer (see page 174).

Sources of More Information
See the Web page http://www.w3.org/pub/WWW/MarkUp/ . Follow any of the 
links in the “Specs, Drafts, and Reports” section.

Starting Points
An Empty Page

If you do not have documents in another format that you can import or transfer into 
your Web pages, you can always create them from scratch. There are several ways to 
open an Empty Page.
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Setting the Start-Up Page Default

You can control the page you see when you start GNNpress.

Set the start-up page:

1 Choose Menu item Tools Preferences General.

2 Select one of three choices for the Startup View:
Home Page—opens with the page you specify.
Blank Page—opens with a new empty page.
MiniWeb—opens with a new MiniWeb and a new empty page in the MiniWeb.

Creating a New Empty Page

Open a new empty page:

With focus on a Page window, choose File New Page.
With focus on a MiniWeb window, choose File New Page.

Opening an Existing Page
One of the most useful attributes of GNNpress is its ability to browse and author at the 
same time. You can edit a page as you browse and then save the file to your GNN 
Hosting Service directory (http://members.gnn.com/ netname/), or to your local 
files for further editing. Pages at web sites you visit can be used the same way. Saving 
the file to your local directory provides a quick way to format the page as you wish and 
then publish it on your GNN Hosting Service directory.
You can also copy an existing page to a new file with the File Copy File menu item. 
You can then edit that new file without making changes to the existing page. See page 
151 for details about copying files with GNNpress. (See page 10 if you do not yet have 
v1.1.)
If the File Copy File command is not visible in your version of GNNpress, choose the 
Tools Preferences menu item. In the General Preferences dialog, uncheck the “Short 
Menus” item. Then, click OK.
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Importing HTML Text and Graphics

Import text from another Web page:

1 Place your cursor where you wish the imported file to be inserted.

2 Choose the menu File Import. You will see this dialog. (For details on using such 
file selection dialogs, see page 40.)

3 When you click Import, the file and any included images are inserted at your cursor
The dialog box that appears has the following choices:

Import Imports whatever page is selected in the dialog into the document 
where your cursor is placed.

Cancel Closes the Import dialog box.
Scan Browse your local files or your GNN Hosting Service directory. If you 

enter a site that you don’t have permission to browse, the message 
“Cannot Browse Location” appears in the box where the file names 
would otherwise appear.
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4 Within the File Import dialog box is the Options dialog box. Click on Options to 

see the following choices:

Text
Entering and Revising Text

When you start GNNpress, you see a Page window that says “GNNpress: The Fastest 
Way to Publish on the Net”. You can change your startup appearance by editing the 
Startup View in the Tools Preferences General menu (see page 170).
To create your own Web page, you can start by editing any existing page, or you can 
start by editing a blank page.

None If there are any images in the page you are importing, they are not 
imported to the same directory that contains the page. If you want 
the imported page to reference the images in their original loca-
tion, check the Relative Links to Full URL field.

Relative All relative images are saved locally into your directory, and they 
are linked within the text of the document as local images. See 
the "Links" section on page 115 for an explanation of relative and 
absolute references

All All image files in the document are copied to your directory.
Relative Links 
to Full URL

All relative links in the imported page are converted to absolute 
URLs.

Use Base when 
possible

You can ignore this field. Checking it has no effect when you 
import from most pages.
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Creating and Saving a Web Page

Create the page and give it a title:

1 Select the menu File New Page.

2 Save the page with a new name. Choose the menu item File Save, and save the 
page to a directory on your local disk. (For details on using such file selection 
dialogs, see page 40. For details on saving files to your GNN Hosting Service 
directory see page 161.)

Because this is a new page, this action invokes the Save As dialog. If you’ve 
already saved this page, choosing File Save will save your page without 
displaying this dialog.

3 In the Page window, move your cursor to the Title field and type a new title for the 
page. The web icon next to the field breaks, to show that you have unsaved 
changes. Saving the page changes this icon back.

Icon for new, unsaved 
pages

Icon for pages with 
unsaved changes

Icon for saved pages
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Entering Text

As you move the mouse over the Page window, the cursor is I-shaped. When you click 
the mouse in the text, a flashing I-shaped cursor marks the point where text will be 
placed when you type.
Once you have positioned the cursor, there are several ways to get text into your page.

Type text into your page:

Type on the keyboard. The text appears at the cursor position.
You do not see any HTML tags around text you type. (HTML is the language used 
to format Web pages. For example, a paragraph begins with a “<P>” tag.) If you 
want to see and edit the HTML code, choose the Tools Show HTML menu item.

Paste text into your page:

Enter text into a document by pasting from almost any source.
You can copy and paste text between GNNpress and other applications. For 
example, in Microsoft Word or PowerPoint, select text and then choose the 
Edit Copy menu item (or press Ctrl-C). You can then paste it into your Page 
window at the cursor location, by choosing Edit Paste (or press Ctrl-V).

Drag-and-drop from other page windows:

1 In any GNNpress page window, highlight the text you want to move. (You cannot 
drag-and-drop from other applications to GNNpress.)

2 Holding the cursor down on the highlighted text, drag the text to the page and loca-
tion where you want to put it.

3 Release the cursor. The text is removed from where you selected it, and placed into 
the new location.

Selecting and Editing Text
The sentences you type can be edited with the mouse and edit keys, similar to most 
word processors. As you work with GNNpress, you must first select the text that you 
want to change.

Editing Text

To edit text:

To delete text, select it, then press Backspace/Delete on the keyboard, or use the 
Edit Clear or Edit Cut menu.
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“Drag-and-drop”: To move text, highlight it, hold the mouse button down and 
move the cursor to the desired new location, then release the mouse button.
Alternatively, you can Cut and Paste text, either with the Edit menu (Edit Cut then 
Edit Paste) or the Cut and Paste buttons on the toolbar.
To replace text, select it then type over it.
To move a line of text up or down, place the cursor above the line or at the left 
margin, then press Delete or Return to raise or lower the line.

Keyboard Commands

Use the keyboard to control the cursor:

The arrow keys move the insertion point one character or line in each direction.
Holding down the control key makes the left and right arrows move left and right 
by a word rather than a character. (If your keyboard has word left/right keys they 
should work as well.)
The Home and End keys move to the start and end of the current paragraph respec-
tively. With the control key down they move to the start and end of the current line.
The Next (+Page, PgDown) key and the Prev (-Page, PgUp) keys move the inser-
tion point to the next or previous page, respectively.
Holding down the Shift key while you move the cursor with the keyboard selects 
text instead of just moving the cursor.

Navigate with the keyboard:

The Help or F1 keys bring up the online GNNpress reference manual. Some 
dialogs also contain a Help button that brings up help on that dialog.

Edit text with the keyboard:

If your keyboard has keys labeled Cut, Copy and Paste, then these perform as 
labeled.
Holding down the CTRL key when depressing the Copy key copies the URL.
Pressing Return starts a new paragraph in whatever way seems appropriate. In a list 
it creates a new list item. In a header it exits the header and starts a new paragraph.
Pressing Linefeed or CTRL+J (at the end of a list, header, or form) exits the current 
format (list, header, or form) and starts a new paragraph in whatever way seems 
appropriate.
Pressing Backspace (or CTRL+H) deletes the last character.
Pressing CTRL+D deletes the next character.
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Pressing Delete normally deletes the character to the right of the cursor, but you 
may change it to delete the character to the left by choosing the Tools Preferenc-
es General menu item and checking the UNIX Style Delete field.

On the Macintosh, the Backspace key is labeled Delete, so pressing Delete does 
a backspace.

Pressing CTRL+U deletes to the beginning of the line.

Finding and Replacing
Edit Find/Replace opens a dialog that lets you find or replace text in the current page.

Find and replace text:

1 Type the characters to search for in the Find What box at the top.

2 Type the characters to replace these in the Replace With box underneath.

3 Optionally select one or more of the following Search Options:

Whole Word Checking this box makes the match find only whole words 
that match the text you type. When this box is not checked, 
GNNpress matches your text even if it is a part of a word. For 
example, if you check this box, searching for “cat” will match 
“cat” only, and not words like “catalog”.

Match Case Checking this box makes the match case-sensitive. When this 
box is not checked, GNNpress finds matches that use either 
upper or lower case letters. For example, if you check this box, 
searching for “ZIP” matches “ZIP”, but not “zip” or “Zip”.

Search Backward Checking this box makes GNNpress search backward through 
the page beginning at the cursor position. The default is to 
search forward.

Type characters
to search for

Type characters
to replace with

Choose method
of search
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4 Use the buttons on the right to control the search.

Copying from Other Pages
Copying Text

Copy text from another page:

1 With the mouse, highlight the text you want to copy.

2 Click the Copy icon.

3 Return to your Web page, position the cursor at the end of the page, and 
click on the Paste icon.

Copying and Pasting URLs
You can create links to pages by copying the address of a page and pasting it into your 
page. The address of a page is called a URL (Uniform Resource Locator).

Copying a URL:

• If you’ve already opened the page whose address you want to copy, choose 
the Edit Copy URL of Page menu item (or click the Copy URL button in the 
toolbar). This copies the URL of the current page so that you can paste it.

• If the page you want to link to is listed as a link on another page, highlight that link 
and choose the Edit Copy URL in Selection menu item (or click the Copy URL 
button in the toolbar). You can hold down the Ctrl key on your keyboard while you 
highlight a link to prevent GNNpress from opening that page. This copies the URL 
of the link so that you can paste it.

Find Finds and selects the next match.
Close Closes the dialog box.
Replace Replaces the current selection with the characters in the Replace 

With box.
Replace All Finds and replaces all the characters that match in the entire page.
Find Next Finds the next match. The Search Backward field controls whether 

this is the next match in the forward or backward direction.
Wrap & Find Same as Find Next, but starts over at the beginning of the page if it 

gets to the end of the page.
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Pasting a URL to create a link:

• If you want GNNpress to fill in the text for the link, position the cursor 
where you want to create the link, and choose the Edit Paste URL menu 
item (or click the Paste URL button in the toolbar). This creates a link to 
the URL you copied. If you copied the URL of a page, GNNpress adds 
the title of that page as the text for the link. If you copied the URL of a highlighted 
link, GNNpress adds the URL of the page as the text, instead.

• If you want to turn existing text into a link, highlight the text you want to link, and 
choose the Edit Paste URL menu item (or click the Paste URL button in the 
toolbar). This makes the highlighted text a link to the URL you copied.

Spaces, Line-Breaks, and Horizontal Rules
Spaces

Generally, you can’t use multiple spaces to move text horizontally in HTML. 
However, there are some ways to get around this restriction. 

Move text horizontally:

The best way to align 
text into columns is to 
use tables. See page 98 
for details.
Another way to add 
horizontal spaces is to 
choose Tools Prefer-
ences General and 
check “Non-Breaking” 
in the Text Edit Spacing 
field. Then, you can 
type multiple spaces. 
However, some 
browsers show these 
non-breaking spaces as 
“&nbsp; ” instead of as a space. If you select “One” in this field, you can only type 
one blank space at a time. 
Another way to add spaces is to highlight the paragraph and choose Format Para-
graph Preformatted to change the paragraph to a fixed width font and allow you to 
align text by adding spaces.
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Line Breaks and Forced Line Breaks

Create a Normal 
Line Break—a 
new paragraph, 
placed two lines 
below the point of 
insertion:

Press the Return 
key.
In the middle of any 
list, you can add a 
line break without 
creating a new list item by choosing Format Paragraph New. 

Create a Forced Line Break—same paragraph, one line below the point of 
insertion:

Press Shift-Return or choose Element Forced Line Break.
A line separated by a forced line break is still part of the same paragraph as the line 
above and is subject to that paragraph’s formatting.

Horizontal Rules
You can use the horizontal rule, which by default spans the full width of the page, to 
divide areas of the page.

Insert a Horizontal Rule:

1 Position the cursor where you want the rule to start.

2 Choose Element Horizontal Rule.

Reposition or duplicate a Horizontal Rule. Either:

Use the basic editing conventions—select, cut, copy, paste, and drag-and-drop.
Use the Cut, Copy, and Paste buttons in the toolbar.
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Character Styles
Characters can be given distinctive styles, like bold, italic, fixed width , and more. 
To format the style of text you have selected, use the Format Type Style menu. 
Character styles are applied to individual characters (and strings of characters like 
words and sentences), as opposed to whole paragraphs or other page elements.
Some paragraph structures also affect how the characters within them look, like 
Headings and Quotations. You can use these character styles to further modify the type 
style of a Heading or other paragraph structure.
GNNpress provides two categories of character styles: formatted (physical) styles and 
logical styles.
If some of the type styles in the Format Type Style menu are not visible in your version 
of GNNpress, choose the Tools Preferences menu item. In the General Preferences 
dialog, uncheck the “Short Menus” item. Then, click OK.

Formatted Character Styles
Formatted character styles are styles that have a specific meaning, for example, bold 
or italic. Regardless of the browser used to view your page, characters with formatted 
styles always appear in that style. (A GNNpress Style Sheet can modify the look of 
formatted styles, but normally you modify logical styles only.)
GNNpress has these formatted styles:

Plain Plain text

Bold Bold text

Italic Italicized text

Underline Underlined text
Fixed Pitch a monospaced font such as Courier

– Superscript – a smaller point size of the current font, elevated above the 
baseline

– Subscript – a smaller point size of the current font, moved slightly 
below the baseline

Bigger A larger font size than the surrounding text. Font size 
changes are cumulative. You can apply this style multiple 
times to text to increase the font size further. The actual 
font size varies on different browsers. 

Smaller A smaller font size than the surrounding text. You can 
apply this style multiple times to text to decrease the font 
size further.
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Logical Character Styles
Logical character styles describe how a particular word or phrase is used. In contract, 
“character styles” describe how a word or phrase should be displayed. Logical 
character styles have no “standard” appearance. Different browsers may display these 
styles in different ways. For example the “emphasis” style may be italicized on some 
browsers and shown in bold on others.
The deleted text and new text styles are HTML 3.0 styles that are not yet supported by 
all browsers. 
The logical styles are:

Deleted Text Text has been deleted, for example in a legal document or 
a software specification. By default, a line strikes through 
the text. 

New Text Text that has been added to a document. By default, the text 
is dark gray and change bars are added to the page.

Citation A reference to a book, article, or other work, for example, 
“For more information, see Taylor, The Life of Birds”.

Code Words or phrases that are part of code examples or 
commands, for example, “ls *doc ”.

Definition A defined word or phrase, for example “The second to last 
item is the penultimate item”.

Emphasis An emphasized word or phrase. Some other browsers show 
this style in italics.

Keyboard Text intended to be typed in by the reader on a command 
line or other text-entry environment.

Sample Example text, similar to code.

Strong Strongly emphasized text (stronger than the emphasis 
style). By default, GNNpress shows this style in red. Some 
other browsers show this style in bold.

Variable A place holder for some other value in a command line or 
sample text, for example, “To print a file, use the print 
file name  command, where file name  is the file you 
want to print”
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Applying and Removing Character Styles

Both formatted and logical styles are cumulative, that is, you can apply several styles 
to a selection. When a style has been applied to a selection, that style name has a check 
next to it in the Format Type Style menu.

Apply a character style:

1 Select the characters you want to apply a style to.

2 Choose a character style from the Format Type Style menu.
You can apply more than one style at a time to characters. To do this, repeat 
step 2 while the selected characters are still highlighted.

Remove a single character style from a selection:

1 Select the characters that have the style you want to remove.

2 Choose the character style (checked) you want to remove using the Format  Type 
Style menu.

Remove all character styles from a selection:

1 Select the characters you want to revert to plain text.

2 Choose Format Type Style Plain.
Use Edit Undo if you want to correct a recent formatting choice.

The characters you selected revert to the default style of the surrounding text.

Paragraphs and Lists
Paragraph Structures

Paragraphs (all text between forced line breaks) can be assigned a specific structure—
like Heading, Numbered List, or Quote — to set off text and organize your page.
You use the Format menu to give paragraphs structure. 

Normal Paragraphs
Normal paragraphs, the default, are almost unstructured. They start at the left margin 
with no indenting or character styles.
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Change a structure back to a normal paragraph:

1 Select the text you want to change back

2 Choose the menu Format Remove Format.

Changing Paragraph Alignment
You can make any paragraph, heading, or list centered, right aligned, or fully justified 
on both the left and right. In fact, you can even align text that wraps next to an image 
that is left or right aligned with text. Note that some browsers do not support text 
alignment. For example, GNNworks currently supports Align Left and Align Center.

Align a paragraph:

1 Place the cursor in the paragraph, heading, or list you want to align or justify.

2 With the Format Paragraph menu item, choose Align Left, Align Right, Align Center, 
Flush, or Align Default. (“Align Flush” aligns both the left and right edges of the 
text. “Align Default” removes any previous paragraph alignment.)

Headings
GNNpress provides six levels 
of headings, from Hdg 1, the 
largest, to Hdg 6, the smallest. 
Usually you use headings to 
title a section. They are set off 
from the text through a larger 
font or other form of emphasis.

Apply a heading to text:

1 Place the cursor where you 
want the heading to start.

2 Choose a heading type from 
the Format Heading menu.

3 Type your heading text.

Apply a heading to existing text:

1 Position the cursor in the line of text you want to affect.

2 Choose a Heading type from the Format Heading menu.
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Change a heading format:

1 Select all of the text in the heading.

2 Choose the new heading level you want to use from the Format Heading list.

Remove a heading format:

1 Position the cursor anywhere in the heading text.

2 Choose the Format Remove Heading Format menu item.
Or, you can use Edit Undo to undo a recent formatting choice.

Block Quotes, Preformatted Text, and Address Signatures
Block Quotations are used for 
long passages of quoted 
material and as such are, by 
default, offset from regular 
paragraphs.
Preformatted text is used 
when you want tabs, spaces, 
and carriage returns in the text 
preserved, for example, code 
samples or examples that must 
appear as they are typed. 
GNNpress displays 
Preformatted text in a 
monospaced font like Courier.
Address Signatures are 
typically used at the top or the 
bottom of the page to indicate 
the owner of the document, when it was last changed, any copyright information, or 
any other administrative information for the page. Address signatures are usually in 
italics and offset, by default.

Apply Block Quotes, Preformatted text, and Address signatures:

1 Place the insertion point where you want the structure to begin, or position the 
cursor in the paragraph you want to affect.

2 Choose one of these three structures from the Format Paragraph menu.
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Change Block Quotes, Preformatted text, and Address signatures:

1 Position the cursor in the paragraph you want to affect.

2 Choose BlockQuote, Preformatted, or Address from the Format Paragraph menu.

Remove Block Quotes, Preformatted text, and Address signatures:

1 Position the cursor in the paragraph you want to affect.

2 Choose the menu Format Remove Paragraph Format.

Lists
Lists are useful for organizing related text. They combine a group of lines, all separated 
by line breaks, into a single structure. 
There are three types of lists:

• Bulleted lists are 
indented with bullets 
marking each item.

• Numbered lists have 
sequential numbers.

• Definition lists have a 
term line followed by a further-indented definition paragraph.The term and defini-
tion structure is repeated throughout the list.

You can add, delete, and rearrange list items. You can also nest lists. Nested lists have 
multiple levels of sub-lists and can be mixed. For example, a Numbered list can be 
nested within a Definition or Bulleted list, or another Numbered list.

Bulleted and Numbered Lists
Bulleted lists are useful for listing items that can appear in any order. This structure 
indents and indicates items by bullets or squares. Numbered lists are best for items that 
are ordered in a specific sequence, as with procedures. 

Apply a bulleted or numbered list structure:

1 Place the insertion point where you want the Bulleted or Numbered list to begin 
when you type Or, select the text you want to turn into a list.

2 Choose Bulleted List or Numbered List from the Format List menu.
You cannot select the numbers or bullets associated with a list. They are part of the 
structure, but not part of the context.
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End the current list structure:

1 Place the cursor anywhere in the list.

2 Choose Format Exit List Format.
The cursor moves to the line below the list, and leaves it unstructured. Exiting from a 
nested list takes you out one level. Repeat the Exit command to continue to move out. 
To move completely out of the list, place the cursor below the list and click.

Remove a list structure (that is, make it unstructured):

1 Place the cursor in the list, and choose Format Remove List Format.
Individual items in a list cannot be unstructured. You must unstructure the 
whole list at once.
Use Edit Undo if you want to correct a recent formatting choice.

Adding, Deleting, and Rearranging List Items

Paste or type new items:

1 Place the cursor at the end of the line before the new item you want to add.

2 Press Return to provide a line for the new item.

3 Type text or Paste previously typed list items.
Several list items can be pasted in at once. The items below the new items shift 
downward to accommodate the new list members.

Delete or move items within the list:

Use basic editing conventions—cut, copy, paste, and backspace.
If you add or delete an item in the middle of a Numbered list, all the items below it are 
automatically renumbered to reflect the change. (If the numbers look odd, scroll up and 
down to refresh the screen.)

Add a normal paragraph within a list:

Normally, when you press the Return key within a list, the bullet or number for the 
next item is added automatically. However, sometimes you want to add a second 
paragraph to a single list item. 
To add a second paragraph within a list, choose Format Paragraph New.
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Definition Lists
Definition lists contain indented Terms followed by their Definitions, indented further.

Definition Lists follow the same basic List rules as Bulleted and Numbered lists. The 
differences are presented below.

Apply a definition list structure:

1 Place the insertion cursor where you 
want the Definition list to begin.

Or, you can select text you want 
to turn into an Definition list.
Terms and Definitions must be 
on separate lines. The Term item 
must be first, then the Definition line.

2 Choose Definition List from the Format List menu.

3 Type your text. Create new a Term line by pressing Return at the end of a defini-
tion, then press Return again to create a new Definition line.

If you convert selected text to a list, the first paragraph becomes a Term, the second a 
Definition, and so on until the last paragraph in the selection.

Terms

Definitions

Select text
and use the
“Definition”
list style to
format as a series of terms
and indented definitions.
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Change the relative positions of term and definition lines:

1 Place the cursor within or highlight the Term or Definition you want to change.

2 Choose Term or Definition from the Format List menu.
If you place the insertion cursor in a line or at the beginning of a line, all the 
text to the right of the cursor moves down one line and changes to a Term or 
Definition (depending on which you choose). There is still a line for the term 
or definition where your cursor started, even if your cursor was at the beginning 
of the line. 
Placing the cursor in a line and pressing the Return key has the same effect as 
placing the cursor in a line and selecting the opposite line type from the 
Format List menu.

You can choose Term when the cursor is already in a Term line to create two 
Terms in a row. Likewise, you can choose Definition when the cursor is already 
in a Definition line to create two Definitions in a row.

If you highlight the entire term or definition line, that line slides left or right to 
become a Term or Definition (depending on which you choose) without 
moving down a line or affecting any other lines.

Put your cursor here

Format List Definition
and choose

(or press Return).

Put your cursor here

Format List Term.
and choose

Highlight a Term and choose
Format List Definition.
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Nested Lists
At any point in a list you can create a sub-list, which is indented further than the current 
list item.

There is no limit to the number of nested list layers and the kinds of primary and nested 
lists that can be mixed. Nested lists can carry markers that are different from the 
primary lists that contain them. These markers may not look the same to all browsers.
As with all Lists, the nested sub-list is itself a distinct list that adheres to basic list rules. 
See the list rules above to understand how nested lists work.

To nest an existing list item(s):

1 Select the item(s) you want to nest.

2 Choose the list structure you want to use from the Format List menu.

3 Continue the nested list by pressing Return at the end of the nested list.

Bulleted list 

Numbered list 
Bulleted list

Definition list 

Numbered list

Bulleted list 
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There are two results, depending on how you select the item in step 1.

Nest a new list with typed or pasted items:

1 Place the cursor at the end of the item line you would like to nest below.

2 Choose the desired list structure from the Format List menu

3 Type or Paste new items, as many as you want.

Removing Formats
You can remove character styles and paragraph structures, leaving the text in a plain 
format. Use Edit Undo if you want to correct a recent formatting choice.

Remove all character styles from a selection:

1 Select the characters you want to change back to plain text.

2 Choose Format Type Style Plain.

Change a heading into a normal paragraph:

1 Place the cursor in the heading you want to change to plain text.

2 Choose Format Remove Heading Format.

Remove Block Quotes, Preformatted text, or Address signatures:

1 Place the cursor in the paragraph you want to affect.

2 Choose Format Remove Paragraph Format.

Remove a list structure:

1 Place the cursor anywhere in the list

2 Choose Format Remove List Format.
You cannot remove the format of more than one list level at a time.

Placing the 
cursor in the 
item line:

Placing the cursor in the item line shifts everything to its right 
to a new indented line. Everything to the left of the cursor 
remains in the original item position in the primary list. This 
is true even if the cursor rests to the left of all text in the line.

Selecting the 
entire line:

Selecting the entire line moves the entire item line to a nested 
position and erases the original item position.
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Useful Tools
Borders

To help show the structure of a page, you can add border lines above and below lists. 

Show borders:
Choose Format Show Border. The lines you see are not part of the page. They exist 
only to help you edit the page and are only shown in GNNpress.
If the Format Show Border menu item is not visible in your version of GNNpress, 
choose the Tools Preferences menu item. In the General Preferences dialog, 
uncheck the “Short Menus” item. Then, click OK.

Remove the borders:
Choose Format Hide Border.

Images and Colors
Images give the Web its lively look  and exploit the capabilities of electronic media. 
Though many pages use hypertext effectively without them, pictures can make 
information clearer and the page more appealing. This section covers inserting, 
positioning, and sizing images and changing the colors used by a page.

Quick Start
Here is a quick summary of commands you can use with images:

Insert Images In-line
Insert an image as an Element Element Image
Insert image as Imported File File Import
Insert an image out of line Element Link
Copy image page to page Copy and Paste or drag-and-drop
View GNNpress clip art library Help Templates and follow link to Clip Art

Replace and Modify Images
Replace in-line image Element Get Attribute, then Image dialog
Change alignment with text Element Get Attribute, then Image dialog
Re-position image Cut and Paste or drag-and-drop
Copy image Copy and Paste or drag-and-drop
Delete image Delete/Backspace, or Tools Cut

Modify Page Colors
Change for most other browsers Format Body Attributes
Change for GNNpress browsers Format Style Sheet
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Images on the World Wide Web
In-line images are graphic elements that load automatically with a Web page. 
GNNpress and the common Web browsers support several image formats:

Images in these formats are shown “in-line” — the image is shown as a part of the page 
itself. There may be a transmission delay after the page appears and before the image 
fills in, perhaps slowly if the image is large.
A common technique for displaying large images is to create a small version of the 
image called a “thumbnail”. Make the thumbnail an in-line image and link the 
thumbnail to either a page containing the full-size image or to the full-size image itself.
If a browser cannot display a particular image type, the images are represented by an 
“undisplayed image” icon (or text) on the page. Double-clicking on the icon or text 
spawns an external viewer, which displays the image. 
On Windows and Macintosh, for example, you can use Microsoft Imager or 
Paintbrush. If no external viewer is set, and the image is in GIF, JPEG, or XBM format, 
GNNpress displays the image on a separate page.
There are serveral types of GIF files:

• “Interlaced” GIF images use a window-shade effect — you see a low-resolution 
image quickly and the details are filled in as the rest of the image is loaded. 

• In “transparent” GIF files, one color is designated as the background color. In many 
browsers, the background color or background pattern of the page shows through 
in areas of the image with this color. Transparent images are used when you want 
an image that looks as if it is some shape other than a rectangle.
Although GNNpress does not show the background color as transparent, other 
browsers still have a transparent background if the GIF image you insert has a 
transparent color. To make transparent GIFs look the same with GNNpress as with 
other browsers, you can make the transparent background color of the GIF match 
the background color of the Web page.

GIF Graphical Interchange Format. File names normally have .gif suffix. 
Can use up to 256 colors. Best for images with large areas of a single 
color. Compresses files without loss of information.

JPEG Joint Photographic Experts Group. File names normally have .jpg  or 
.jpeg  suffix. Can use many colors. Best for photographic or painted 
images. You can specify amount of file compression. Some of the 
information is lost during compression.

XBM X bitmap format. Files normally have .xbm  suffix. Uses only 2 colors.
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Inserting Images In-line
There are several ways to insert an image into a page:

• as an Element;

• as an Imported File;

• Copy and Paste or drag-and-drop from another page in the same MiniWeb.

• Use the right mouse button to drag an icon for an image from a MiniWeb to a page. 
The image is added to the page. (If you use the left mouse button to drag the image 
instead, your page is replaced by a blank page containing the image. You must save 
this page before you can edit it.) 

As an Element
This is the recommended way to insert most images (because the dialog provides more 
options that apply to images than the File Import dialog). 

Insert an image as an Element:

1 Position the cursor where you want the image to be.

2 Choose Element Image to bring up this dialog:

3 Enter the Location of the image. Either:
Type a URL or the local file name in the Location field; or
Click the Browse button to browse for the file on your local disks or your GNN 
Hosting Service directory. (For details on using such file selection dialogs, see 
page 40.) Click the OK button when you have selected the file you want.

Set how image
will align with
text

Type text for 
browsers that
don’t show 
images

Type file location
or browse to 
find the file

Check to import
file into MiniWeb

Choose relative
or absolute link
to file
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4 Choose, by clicking, an Alignment option—Top, Middle, Bottom, Left, or Right—to 

choose how the image is aligned with the adjoining text. Text aligns with the image 
as shown below. 

You can also align the text next to a Left or Right aligned image by using the 
Format Paragraph menu item. 

5 Optionally, you can check the Import Image box.
Check Import Image to copy the image file to the page’s MiniWeb.
If you do not check this box, the image stays where it is and the reference to the 
image in your page uses a full URL.
This box is dimmed if the image is already stored in the page’s MiniWeb or if 
the image is stored on your local disk and the page is on a server. You can use 
File Import, instead, to import images if you want them automatically copied 
from your local disk to a MiniWeb on a server.

6 You can click the Relativize button to change the reference to the image to a relative 
URL. If the reference is already a relative reference, you can click the Absolutize 
button to change the reference to an absolute reference. See the "Links" section on 
page 115 for an explanation of relative and absolute references. 

7 In the Text for non-graphic browsers box, type the text you want to appear instead 
of the image for readers using browsers that do not display graphics.

8 Click OK, and the image appears where the cursor was positioned.

As an Imported File
Normally, using Element Image is the recommended way to insert images because the 
dialog provides more options that apply to images. However, File Import has the 
advantage of making it easier to copy images from your local disks to a MiniWeb on 
a server, so you may want to use this second method in that situation.

Insert an image as an Imported File:

1 Position the cursor where you want the image to be.

2 Choose File Import to see this dialog: (For details on using such file selection 
dialogs, see page 40.)

Top Middle Bottom Left Right
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3 Enter the Location of the image. Either:
Type a URL or the local file name in the Location field; or
Use the directory list and file list to find and select the file.

4 Click Import, and the image appears where the cursor was positioned. You can 
ignore the Options button; it provides options that apply to importing HTML and 
text files.

Copying Images from Another Page
If you are working with more than one page in the same MiniWeb, you can copy 
images from one Page Window to another. The image files are already saved in a 
common directory.

Copy an image from one page to another, either:

Copy and Paste.
Drag-and-drop.

For example, you can copy and paste images from the clip art library provided with 
GNNpress. Just choose the Help Templates menu item and follow link to the “Clip Art 
Library”. These files are stored on your hard disk when you install GNNpress.

URL or file
to import

List of files in
the selected
directory

Click here to
select a file
type

Directories
in the selected
drive or 
directory

Select a drive,
server, or
MiniWeb from 
this list
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Replacing and Modifying Images
Once images are in a page, you can replace images, realign text to them, reposition 
them, or delete them.

Replacing Images or Changing Alignment
You can replace any image on the page with another image. The procedure here is for 
in-line images.

Replace or change text alignment of an image:

1 Select an image by double-clicking on it or dragging across it. It is OK to select 
both an image and some of the associated text.

2 Choose Element Get Attribute to open the Image dialog.

3 If you selected both the image and some text, you can click Select Only to deselect 
the text and keep the image selected.

4 Enter a URL in the Location field or Browse to find the new image.

5 Change the Alignment option if you want to change the way the image aligns with 
the adjoining text.

6 Click, optionally, on Import Image.

7 Click OK.

Repositioning Images

Reposition an image, either:

Cut and Paste. You can use the commands in the Edit menu, the buttons in the 
toolbar, or the keyboard equivalents.
Drag-and-drop.
Change the vertical position by placing the cursor above the image and adding or 
deleting lines to move the image.

Move an image down a single line:

Press Shift-Return, a forced line break
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Indent the image:

1 Use Format Paragraph Preformatted to preformat the image’s paragraph. This 
changes the font of the text in the paragraph as well.

2 Press the spacebar to indent the image.

Copying or Deleting Images
You can use this procedure to place a graphic element, like a bullet or a line, several 
times on a page.

Copy an image:

Copy and Paste. Choose from the Edit menu or use edit buttons in the toolbar or 
their keyboard equivalents.

Delete an image, either:

Position the cursor just after it and hit Delete/Backspace key.
Select the image and

Click Cut in the toolbar;
Press the Delete key; or
Choose File Delete. (For details on such file selection dialogs, see page 40.)
Deleting an image from a page does not delete the actual image file. In addition, 
deleting a page file does not delete image files associated with it. If you want 
to delete files that are associated with another file, you can delete them sepa-
rately using File Delete or by selecting and deleting the file icon in the 
MiniWeb view.

Using the Built-in Hit Counters
If you are a GNN Hosting Service member, you can use the built-in counter image 
program to show how many times one of your pages has been visited. For example:

To add a counter to your page:

1 Open the page on your GNN Hosting Service Web site to which you want to add a 
“hit” counter. (You can only see the counter image if your page is already 
published on the GNN Hosting Service Web site.)
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2 Position the cursor where you want the counter image to appear.

3 Choose Element Image to bring up the Image dialog

4 Type the following in the Location field:

/NS/Counter/ mydirectory /page.htm

“mydirectory” should be the directory path for the page.
“page.htm” should be the filename of the page for which you want to count the 
number of times visited. (This is usually the page where you place the counter.)
If you have Personal-level service, include your home directory in the directory. 
Your link should look similar to one of these examples:

/NS/Counter/username/filename.htm
/NS/Counter/username/subdirectory/filename.htm

If you have Domain-level or higher service, your link should look similar to one of 
these examples:

/NS/Counter/filename.htm
/NS/Counter/subdirectory/filename.htm

Counter images act like regular images. You can align them as you would other 
images. The only difference is that a new image appears each time your page is visited. 
The number of times your page has been visited since you added the counter is stored 
as a number in the /mydirectory /.odo. page.htm file. When you first add a 
counter, the number of hits is set to 1. You can change the number in this file. For 
example, you might want to add the number of visits before you added the counter.

External Viewers for Images
Images are one of the categories of objects linked to the page that may require an 
external viewer. When you click on a link to an image with a format other than GIF or 
JPEG, typically a thumbnail-size icon is shown. If GNNpress cannot view it, it 
launches the right external viewer and the image appears on your screen. To set the 
right viewer, see page 174.

Image Maps
Image Maps are a special kind of link, based on an image. An image is divided, or 
mapped, into regions. Each region functions as a separate link. A single image, like a 
diagram of a truck, can be clicked in different places to link to information about that 
part of the image. Clicking on the truck’s hood could link to an engine specification 
page, or clicking on a wheel could link to a tire wear comparison.
Image maps work well for geographic maps, diagrams, or large images that function 
as indexes to more information. For details about creating Image Maps, see page 119.
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Setting Colors and Background Images
You can change the colors used for the background and text of a Web page. In addition, 
you can use an image file for the background of a page. You use the Format Body 
Attributes menu item to set colors and select a background image. 

Any browser that allows background color changes will display the colors you set. 

To set background and text colors for a page:

1 Choose the Format Body Attributes menu item. You will see the following dialog. 
This dialog allows you to select colors for the page background, the normal text, 
text with an unused link, and text with a link that you have already used. 

2 Click Pick next to the item whose color you want to set. You will see the standard 
Color dialog.

3 Select a color from this dialog. You may want to choose one of the standard colors 
so that the background will not be dithered on screens that can only display 256 
colors.
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Another way to set a color is to type the RGB value for the color you want (in 
hexadecimal numbers) into the field directly. The first two characters are the 
red value, the next two green, and the final two blue. Therefore #ff0000 is red, 
#00ff00 is green, #0000ff is blue, #ffff00 is yellow, #000000 is black, #ffffff is 
white, and #808080 is medium gray.

4 Click OK in the Color dialog. 

5 In the Body Attributes dialog, you can set another color or click OK to see the 
effects of your changes. 

If you set any color, we recommend that you set all four colors to prevent conflicts with 
settings your readers may have. For example, if you set a light background color and 
use the default text colors, a reader with a default background of black and light text 
may not be able to read your page because the text may appear light on a light 
background. The default colors are:

To select a background image:

1 Choose the Format Body Attributes menu item.

2 Type a URL in the Location field or Browse to find the new image. If the image you 
select is smaller than the browser window, the image will be “tiled” to fill the 
whole space. You should use an image with edges that match up when the image 
is tiled. Tiling allows you to specify a small image that will load quickly. 

3 You can click the Relativize button to change the reference to the background image 
to a relative URL. If the reference is already a relative reference, you can click the 
Absolutize button to change the reference to an absolute reference. See the "Links" 
section on page 115 for an explanation of relative and absolute references.

4 Click OK to see the effects of your changes. 
If you use a background image, we recommend that you also set the colors to avoid 
conflicts with your readers’ settings. In most cases, the colors in your background 
image should contrast strongly with the text colors you choose and the background 
image should be simple enough that it doesn’t distract from the text.

Background Gray: #c0c0c0

Text Black: #000000

Link Blue: #0000ff

Visited Link Deep Purple: #400080
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Example: Inserting an Image into Your Page
This section lets you step through the process of inserting an image.

1 Choose the menu item Element Image to see this dialog:

2 If you know the URL for the graphic you wish to import, you can type in into the 
Location field in this dialog. Otherwise, if the graphic is on your GNN Hosting 
Service directory or your local file system, you can use the Browse menu to find it.

3 Click Browse to see the following dialog: 

4 First choose a GNNserver directory or local drive to search on. Either
Choose a location from the Drivers / MiniWebs / Sites list. This is a list of your 
drives and the GNNservers you have visited. If you have already published to 
the GNN Hosting Service, that Web address is in the list. 
Type the location or URL in the Location field at the top of the dialog.
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5 Either type or choose http://www.tools.gnn.com/ . The Location field at the 

top of the dialog now changes to http://www.tools.gnn.com/ .
The directory and file listings will look similar to this:

6 In the new Directory list, double-click on the press directory to open it.

7 Now double-click on the 1.1 directory, then the help directory. 

8 Finally, double-click on the clip-art directory.

9 Set the List Files of Type field to “Image”. The Files list now shows file names 
ending with .gif and .jpg .

10 Scroll down in the list of files and select globe.gif. Then, click OK to return to the 
image dialog. The file you selected will be shown in the Location field.

11 The five radio buttons—Top, Middle, Bottom, Left, and Right—allow you select how 
the graphic aligns with the text. Select Middle, then click OK.
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Tables
Tables allow you to align text and images into columns and rows like the one below. 

GNNpress gives you control over the look of your tables.

• You can set and modify the number of rows and columns in your table.

• You can add headings and table captions to your table.

• You can set the width of your table’s border and the amount of space in the margins 
of individual table cells.

• You can merge cells to create areas that span any number of rows and columns.

• You can align the contents of cells both horizontally and vertically.

• You can put almost anything inside a table cell: text, images, headings, links, 
forms, horizontal rules — even other tables.
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Creating and Formatting Tables

To create a table:

1 Move your cursor to the place where you want to create the table, and choose the 
Table Create Table menu item. You will see the Table dialog.

2 Set the number of vertical columns and horizontal rows you want in your table. (It’s 
easy to change these numbers later.)

3 If you want the table to have a caption, type the text for in the Caption field. The 
caption will be centered from left to right either Above or Below the table.

4 The fields at the bottom of the dialog control the borders and spacing of the table.

If you want to hide the borders of the table, uncheck the Border box. (It’s actu-
ally easier to edit a table with borders, so you’ll probably want to leave this box 
checked while you are creating the table. When you are finished editing the 
table, you can hide the borders if you like.)
The Border Size field lets you set the width (in pixels) of the outside border of 
the table. If you make the Border Size a larger number (for example, 10), the 
table will look like it has a picture frame.

Table border Header cells

Cell space

Cell pad
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The Cell Space field lets you set the width (in pixels) of the borders between the 
individual cells in the table.
The Cell Pad field lets you set the amount of blank space (in pixels) between the 
text or other contents of a cell and the borders of that cell. You can think of this 
field as setting the margin widths of the cell.

5 Click OK when you are ready to create the table.

6 If you want to change any of these settings later, just put your cursor inside the table 
and choosing the Table Alter Table menu item.

Putting Elements into Tables
You can put text, graphics, and other elements into table cells the same way you would 
add them anywhere else on a page. Just position your cursor and type text. You can 
also use the menus to add text formatting, images, headings, links, forms, horizontal 
rules — even other tables.
You can use the arrow keys to move the cursor from one cell to another.
You can start new paragraphs by pressing Return. You can force text to wrap to the 
next line by choosing the Element Forced Line Break menu item.
Cells automatically expand as you add text and other elements. Once the table is as 
wide as your page window, text automatically wraps to the next line in the cell. When 
your readers view this page, wide tables are automatically adjusted to fit in the width 
of their browser windows. We recommend that you test the formatting of your tables 
with various page window widths.

Formatting Table Cells
A special way of formatting table cells is to make them “header cells”. By default, the 
text in header cells is shown in bold. You might want to change the cells in the top row 
or the left column of a table into header cells.
Another way you may want to format cells is to align the contents vertically or 
horizontally.

To create a header cell:

1 Place the cursor in the cell that you want to be a header cell.

2 Choose the Table Header Cell menu item. The cell becomes a header cell, the text 
changes to bold, and the text is centered vertically and horizontally in the cell.

3 If you want to change a header cell back to a normal cell, choose the Table Normal 
Cell menu item.
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To align the contents of cells:

To change the vertical (top-to-bottom) alignment of the contents of a cell, place 
your cursor in the cell and choose the Table V Align Cell menu item. You can 
choose to align the contents to the Top, Middle, Bottom, or Baseline of the cell.
You can choose the Table V Align Row menu item to vertically align the contents 
of all the cells in a table row. (If you align the contents of a cell, that setting over-
rides the alignment of the row.)
To change the horizontal (left-to-right) alignment of a cell, highlight the text you 
want to align and choose the Format Paragraph menu item. You can choose Align 
Left, Align Right, Align Center, Align Flush, or Align Default to align the paragraphs. 
(“Align Flush” aligns both the left and right edges of the text. “Align Default” 
removes any previous paragraph alignment.) If you highlight the entire table, you 
can change the alignment of all the cells in the table.
To align an image with text, highlight the image and choose the Element Get 
Attribute menu item. In the Image dialog, choose an Alignment option—Top, Middle, 
Bottom, Left, or Right—to align the image with the adjoining text.

To align the table itself:

If you want to align the entire table to the left, center, or right of the page, choose 
the Tools Show HTML menu item. Find the <TABLE>  tag. (It may already contain 
attributes like BORDER , CELLPADDING , and CELLSPACING .) Add the bold text 
shown below inside the existing <TABLE>  tag.
• <TABLE ALIGN=left>
• <TABLE ALIGN=center>
• <TABLE ALIGN=right>

Then, choose the File Parse menu item to apply your changes to the page window.
To align the table for readers using Netscape, choose the Tools Show HTML menu 
item. Find the <TABLE>  tag at the beginning of the table. Add <CENTER>  before 
the <TABLE>  tag. Then, find the </TABLE>  tag at the end of the table. Add 
</CENTER>  after the </TABLE>  tag.
Then, choose the File Parse menu item to apply your changes to the page window. 
Click the Ignore button in any windows that warn about missing termination tags.
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Merging and Splitting Table Cells
You can merge table cells to create areas that span rows and 
columns. For example, you could create a table like this one:

To merge table cells:

1 Move your cursor to upper-left cell in the set of cells you 
want to merge.

Merging cells deletes the contents of all the cells you merge, except the 
contents of the upper-left cell. To keep the contents of the other cells, cut and 
paste them into the upper-left cell of the area before you merge cells.

2 Choose the Table Merge Cell menu item. You will see the Merge Cell dialog.

3 Type the number of Columns and Rows the cell should span, and click OK to merge 
the cells. For example,

4 If you want to unmerge cells, choose the Table Split Cell menu item. The merged 
area will be split into the number of columns and rows that were merged. (You 
cannot split cells unless they have already been merged.)

HTML 3.0 Tables vs. Netscape Tables
There are minor differences in the ways tables are defined by HTML 3.0 and Netscape. 
GNNpress creates and displays HTML code using the current selection in the Conform 
To field in the General Preferences dialog. To check or change this setting, choose the 
Tools Preferences General menu item.
Changing this setting affects the following defaults for tables:
• With Netscape, text in table cells is aligned vertically to the middle of the cell by 

default. With HTML 3.0, text is aligned to the top of the cell by default.

If you place the cursor in
the upper-left cell of this 
table and merge that cell to
span 2 columns and 2 rows ...

... the result will be
a table that looks 
like this:
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• With Netscape, tables are aligned to the left of the page by default. With HTML 
3.0, tables are centered on the page by default.

• With Netscape, table widths are specified in pixels by default. With HTML 3.0, 
table widths are specified in “ens” (the width of the letter “n”) by default. You can 
add table width specifications in by editing the HTML directly.

Note that changing the Conform To field doesn’t control how other browsers display 
your table. You may want to set the vertical alignment of table cells even if you want 
to use the default to make other browsers align the text correctly.
Both HTML 3.0 and Netscape provide additional attributes for formatting tables. You 
can use the Tools Show HTML menu item to add such attributes. For example, you can 
add the WIDTH , UNITS , COLSPEC , and NOWRAP  attributes to the <TABLE>  tag.

Forms
Forms provide a way for readers of your Web page to send you information. For 
example, one of the forms in an electronic mail order company would allow the 
customer to specify their name, address, credit card number, and telephone number. 
This section explains how you create forms.

Quick Start
Here is a quick summary of commands you can use to create forms:

Create a form within a page Format Form

Insert a form element into a form Click appropriate button on form palette:

Radio button Radio

Check box Check

Text field Text

Text area field TArea
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Starting Points
GNNpress helps anyone to create and edit forms in a Web page. You select the types 
of field you want to create and click in the page to create it.
When you submit a form on the Web, a program on the server runs to send email, get 
information from a database, or whatever the particular form does. Normally, you 
would have to write programs to do these things.
However, some built-in programs are provided with the GNN Hosting Service. These 
programs let you use forms without being a programmer. See page 106 for details.

Layout and Design
A Form has Field Elements that are inserted into a form by clicking the button on the 
form palette to produce the desired dialog box. Setting the attributes in the field 
element dialog and clicking OK inserts a form element at the cursor position within the 
form. GNNpress allows you to create eight types of field elements: Text Fields, Radio 
Buttons, Check boxes, Text Areas, Selection Lists, Picture Fields, Reset buttons, and 
Submit buttons. Each field element needs to have a Form Tag (you can think of it as 
analogous to a variable name in a computer program) to identify the field when the 
results are sent to the form handler. See the “Use the Form Palette” section below.
More than one form may be created within an HTML document, but forms cannot be 
nested. The Form palette is visible when the cursor is inside the form and disappears 
when the cursor is outside of the form.
Text, images, links, etc. can be inserted and modified in the form just as in the rest of 
the page. Form elements can be dragged-and-dropped or cut and pasted, but must 
always be placed within a form.

Selection List Slist

Image field Picture

Reset Reset

Submit Submit
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Creating Input Forms

Create a form that will run the program:

1 Choose the Format Form menu item to see this dialog:

If the Format Form menu item is not visible in your version of GNNpress, choose 
the Tools Preferences menu item. In the General Preferences dialog, uncheck the 
“Short Menus” item. Then, click OK.

2 Type the URL of your CGI program or script in the Form Handler Location field. 
The next section talks about the built-in form handlers you can use.

3 In the Method field, select the HTTP method that will be used to submit the form to 
the server. The choices are GET and POST. Most servers (all GNNservers) support 
both GET and POST; older servers may only support GET. You should use POST if 
you can, because it allows larger transmissions. The returned format of the form 
data is slightly different depending on whether the data came in a GET or a POST.
• GET causes the filled-out form contents to be appended to the URL as if they 

were a normal query.
• POST causes the filled-out form contents to be sent to the server in the hidden 

header information rather than as part of the URL.
In addition, the Form Palette appears containing 8 buttons for field 
elements. You can move the Form Palette anywhere on your screen.

4 Two dotted lines appear surrounding the form. Click the cursor 
between those lines on the page to make the Form Palette visible. 
Click the cursor outside the form, to hide the Form Palette.

5 Display or hide the dotted boundary of the form with Format Hide 
Borders/Show Borders. This also displays/hides dashed borders around 
lists. It is common to use Horizontal Rules to help reader distinguish 
the borders of a form within a page.

6 Click Format Exit Form Format when the form is at the bottom of the page and 
there is nothing beneath the form to click into, and you want to exit the form.

Enter location
of program or
script
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7 Use the option Format Remove Form Format to remove the form. You must 

remove all form elements first, but the software reminds you to do this.
A page can contain more than one form, but forms cannot be nested within each other.

Choosing a Form Handler
• If you want to email the contents of the form to yourself or someone else, you can 

type mailto:you@youraddress.com as the Form Handler Location. Most 
browsers will understand this and will send the field values as email. However, the 
email format is a bit difficult to read. For example, if you have fields called “field1” 
and “field2” and the reader submits values of “apple” and “banana”, the email you 
receive will say:

field1=apple&field2=banana

• If you are a GNN Hosting Service member, you can use the built-in mail program 
to get better formatted email messages from your forms. Type /mail  as the Form 
Handler Location. In the Method field, select POST. To use this program, your form 
also needs to contain fields called “mailfrom ” and “mailto ”. These can be any 
type of field. Normally, the “mailfrom” field will be a text field in which readers 
type their email address. The “mailto” field is usually a hidden field where you 
store your own email address. See page 136 to learn how you can create a hidden 
field by editing the HTML. The tag for a hidden “mailto” field should look like 
this:

<input type=hidden name=mailto value="you@youraddr.com">

• If you have the Commercial or Dedicated level of GNN Hosting Service (or your 
own GNNserver), there are a number of built-in programs for searching and adding 
information to database tables. See the GNNserver documentation for more 
information.

• If you have the Commercial or Dedicated level of GNN Hosting Service (or your 
own server), you can write your own form handling programs. These programs can 
use the GNNserver API or the CGI (Common Gateway Interface) For more infor-
mation, see the GNNserver documentation.For resources and examples, see the 
GNN Hosting Service Developers' Corner at 
http://www.gnnhost.com/develop/index.htm .
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Using the Form Palette
Now that the form is created in the document it needs Field Elements: 
Text Fields, Radio Buttons, Check Boxes, Text Areas, Selection Lists, 
Picture Fields, Reset buttons, and Submit buttons.
Each field element needs to have a Form Tag to identify the field when 
the results are sent to the form handler.

Radio Buttons
A Radio Button is a diamond-shaped or circular button that you can click 
either on or off. One or more Radio Buttons can be grouped by giving all 
the buttons in the group the same “Form Tag”. The group then acts like a 
single field in which only one of the buttons can be switched “on” at a time. 
The value of the button that is switched on becomes the Value Tag of the 
Radio Button field when you submit the form.
For example, you might have a group of Radio Buttons that all have a Form Tag of 
“fruit”. The individual Buttons in the group could have Button Labels and Value Tags 
of Banana, Apple, Orange, and Kiwi. When you submit the form, the value of the 
“fruit” field is the selected fruit.

Add a Radio Button::

1 Position the cursor where you want the Radio Button to be.

2 Click the Radio button on the form palette to see this dialog:

3 Specify values for Button Label, Form Tag, and Value Tag.

The Button Label is the text that follows the button, and therefore identifies it, 
in your page. It is not submitted with the form.

  
 

Buttons with
same form tag
are bound
together

If selected, 
radio button is
turned on when
form is selected

Text that 
follows button,
identifying it on 
your page

Internal
variable name,
must be unique
within a group
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All Radio Buttons with the same Form Tag are bound together. Only one of 
them may be selected at a time.
The Value Tag is the internal variable name. Each Value Tag must be unique 
within a group of Radio Buttons with the same Form Tag.

If Default is selected, this Radio Button is on when the Form is reset. There can 
be no more than one default radio button with the same Form Tag.

4 Click OK to insert the Radio Button at the cursor position within the form.

Check Boxes
Check Boxes are similar to Radio Buttons, except that they allow multiple 
Value Tags to be submitted with the same Form Tag. The dialog and 
mechanism for placing Check Boxes in your form are similar to those for 
the Radio Button.

Add a Check Box:

1 Position the cursor where you want the Check Box to be.

2 Click the Check button on the form palette to see this dialog:

For example, creating three Radio Buttons with value like these:

Results in a Radio Field that looks like this:

If selected,
box is turned
on when form
is initialized

Resulting field:



Creating Web Pages
Forms

Do-It-Yourself Authoring and Publishing for the World Wide Web 109

7
3 Specify values for Button Label, Form Tag, and Value Tag and You may also click 

Checked.
The Button Label is the text that follows the check box, and therefore identifies 
it, in your page. It is not submitted with the form to the server.
All Check Boxes with the same Form Tag are in a group.
The Value Tag is the internal variable name. Each Value Tag must be unique 
within a group of Value Tags with the same Form Tag. If the Check Box is 
selected, a string like “Form_Tag=Value_Tag” is submitted when the Form is 
submitted. The Check Box allows multiple Value Tags in the same Form Tag.
If Checked is selected, the Check Box is turned on by default when the Form is 
initialized. More than one check box with the same Form Tag may be Checked.

4 Click OK to insert the Check Box at the cursor position within the form.

TextFields
The Text Field is a one-line box on the Form where the user may type in 
text. It can have an initial setting, or it can be blank.

Add a Text Field:

1 Position the cursor where you want the Text Field to be.

2 Click the Text button on the form palette to see this dialog:

3 Specify values for Form Tag and, optionally, Initial Text.
Initial Text, if specified, is displayed within the text field by default and is 
submitted with the form data if the user has not typed over it.

4 Select the Field Type, either Text or Password.
If Text is selected, the text that the user types appears in the field.
If Password is selected, an asterisk (*) appears instead for each letter.

5 Enter, optionally, Display Size.

Optional,
displayed by
default Length of text

field

Maximum
number of
characters
allowed

Resulting field:
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Display Size controls the length of the text field, as displayed in the form.

6 Enter, optionally, Max Input.
Max Input controls the maximum number of characters that the user is allowed 
to type in. If you do not specify this, you will be limited by whatever the limit 
is for the system, often infinite.

7 Click OK, and the text field appears where the cursor was positioned.

Text Areas
If you want to input more than one line of text you should use a Text Area 
rather than a Text Field.

Add a Text Area:

1 Position the cursor where you want the Text Area to be.

2 Click the TArea button on the form palette to see this dialog, which allows you to 
insert a text area (a scrollable area in which the user can type more than one line of 
text) into a form.

3 Specify values for Form Tag and, optionally, Initial Text.
Initial Text, if specified, is displayed within the text area by default and is 
submitted with the form data if the user has not typed over it.

4 Optionally specify the Area Attributes: Rows (number of rows) and Cols (number of 
columns).

This sets the size of the Text Area in the page. The number of characters a user 
may enter into a text area may be greater than fits into it, but the horizontal and 
vertical scrolling allow the user to read everything in the text area.
When adding text, scrolling occurs automatically when Return is hit.

5 Click OK, and the text area appears where the cursor was positioned.

Size of text
area in page

Resulting field:
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Selection Lists

You can insert a Selection List—either a scrollable list from which the user 
may select one or many items, or a pull-down list from which the user may 
select one item—into a form.

Add a Selection List:

1 Position the cursor where you want the Selection List to be.

2 Click the SList button on the form palette to see this dialog:

3 Specify a value for the Form Tag.

4 In the Selection List Attributes box enter the number of lines to be displayed in the 
Display: # Lines field.

The default is to display one line. When only one selection is allowed (see the 
next step) it is common to display one line, since clicking on the Selection List 
provides a pull-down list from which the one selection can easily be chosen.
When multiple selections are allowed, the selection list is displayed as a scrol-
lable list and it is probably best to set number of lines to display to at least two 
for clarity and ease of use.
If when using a Selection List that allows multiple selection you wish to make 
multiple, non-consecutive selections, depress the CTRL key (Command key on 
Macintosh) when making these selections. Otherwise the subsequent mouse 
clicks deselect the previous selection(s).

Number of lines
displayed in 

Enter new list
items

Click to make 
item a default
selection

Selection list
field

list

Resulting field:
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5 In the Selection List Attributes box choose, by clicking, whether to Allow Multiple 

Selections.
The default is to not allow multiple selections.

6 Insert the items into the Selection List.
Enter a list item in the Selection List field.
Optionally click the Select box to make the item a default selection. Unless the 
Allow Multiple Selections box is checked, there can be only one item selected as 
the default.
Click Add to add the item to the list.

7 To change the text or default status of an item in the list, highlight the item in the 
text area (so that it is displayed in the Selection List field) make the changes, and 
press Change.

8 To delete an item from the selection list, highlight the item in the text area (so that 
it is displayed in the Selection List field) and click the Delete button.

9 To change the order of items in the selection list, highlight the item (so it is 
displayed in the Selection List field) and press Up or Down buttons to move the high-
lighted item through the list.

10 Click OK, and the selection list appears where the cursor was positioned.

Image Fields
You can insert a “clickable” image into a form. Clicking on the image 
immediately submits the form, sending the x and y position of the click.

Add an image field:

1 Position the cursor where you want the image to be.

2 Click the Picture button on the form palette to see this dialog:

3 Specify a value for the Form Tag.

Choose
how image
is aligned
with text

Enter URL
of desired
image

Save image
to page’s
MiniWeb
and create
relative link

Resulting field:
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4 Enter the Location of the image. Either:

Enter a URL or the local file name in the Location field.
Click the Browse button to search the directories and locate and select the file.

5 Choose, by clicking, an Alignment option—Top, Middle, or Bottom—to choose how 
the image is aligned with the adjoining text.

6 Click, optionally, on Import Image.
If imported, the image file is saved to the page’s MiniWeb and has a relative 
link.
Otherwise, the image remains outside the directory with an absolute URL.

7 Click OK, and the image appears where the cursor was positioned.

Reset
A form can have a Reset button. When pressed by the user, it sets the other 
field elements to their initial state.

Add a Reset Button:

1 Position the cursor where you want the Reset button to be.

2 Click the Reset button on the form palette to see this dialog, which allows you to 
insert a Reset button, a box labeled, by default, Reset, into a form.

3 Type, optionally, a Button Label. The default is Reset.

4 Click OK, and the Reset button appears in the form at the cursor position.

Submit
A form can have a Submit button. When clicked, it submits the current 
form to the form handler that was specified when the form was created.

Add a Submit Button:

1 Position the cursor where you want the Submit button to be.
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2 Click the Submit button on the form palette to see this dialog, which allows you to 

insert a Submit button, a box labeled, by default, Submit, into a form.

3 Type, optionally, a Button Label. The default is Submit.

4 Click OK, and the Submit button appears in the form at the cursor position.
Image fields act as submit buttons, and if a form contains only a single text field 
(no other form elements), hitting Return within the text field submits the form to 
the form handler.

Changing Forms
Text, images, links, etc. can be inserted and modified in the form just as in the rest of 
the page. Form elements can be dragged-and-dropped and cut and pasted, but must 
always be placed within a form.
Form elements can be modified by selecting the element in the form and clicking the 
form palette button which corresponds to the type of form element selected. This 
produces the dialog for the selected form element with the current attributes displayed. 
Making changes in the dialog and clicking OK effects the changes in the form element.

Change the form handler location or method:

1 Place the cursor within the form to be changed.

2 Choose Format Form.
This produces the Form Handler dialog with the current Form Handler Location 
and Method displayed. Making changes in the dialog and pressing OK imple-
ments the changes in the form.
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Links
Quick Start

Here is a quick summary of commands you can use with images:

Parts of a Link
Links

A link is a cross-reference to another file or target location in a file. Other files and 
anchors are the targets of links. A link can be either an absolute link or a relative link. 

• Absolute links specify the full location of a file. You can only use absolute links 
to link to a file on a different server or disk.

• Relative links omit part of the file specification and use the current location as the 
default. (For example, http://gnn.com/gnn/netizens/index.html  is an 
absolute reference. A relative reference to this file from the directory above would 
be news/news.htm.  See the "References Between SubWebs" section on page 
159 for more about the syntax of relative references.)

It’s usually best to use relative links within your own Web site. Relative links allow 
you to move the entire directory tree to a new location without breaking your links. 
You should try to use absolute links only to references files outside your own Web.
GNNpress can automatically change references from absolute to relative references 
and back for you. If you see a Relativize button in a dialog for creating links or setting 
image attributes, the link is currently an absolute link and you can click this button to 
make it a relative link. If you see an Absolutize button, you can change the relative link 
to an absolute link. Also, when you choose the File Save As menu item, the Options 
button provides a dialog that allows you to convert all relative references to absolute 
references by checking the Relative Links to Full URL box.

Create Links Select text ... Element Link

Create Anchors Select text ... Element Anchor

Change Links and 
Anchors

Control/Option-select link ... Element Link or Element Get 
Attribute

Create AutoLinks Open page with text... Tools AutoLinks. Type in choice of 
GNNserver.
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Anchors
An anchor is a target location within a page. Links can point to anchors in the same 
page as the link or in another page. Anchors are often used in longer pages so that 
readers can quickly find different parts of the page. The “anchor” is the place on the 
page you want to move to. The links you create can point to these anchors. Anchors 
don’t do anything when you click on them, they are only place holders to be linked to.

Creating Links
Using the Link Dialog

Make a link:

1 Select the text you would like to make a link, either to another web site or another 
page within your MiniWeb.

2 Choose the Element Link menu item to bring up the Link dialog.

3 Type the URL in the Link To Page field, for example, http://gnn.com/

4 If you want to link to some place in the middle of a page, type an anchor name in 
the Append Anchor Name field. You will also need to create an anchor with the same 
name in the page you referenced in the Link To Page field. See page 117 for details. 
If the anchor you want to link to is in the same page as the link (that is, if you just 
want the link to scroll the page), you don’t need to type the name of the page in the 
Link To Page field. 

5 Click OK.
The text you selected in your document is now colored, italic, and underlined. This 
is a link to the URL you specified. Clicking on your newly created link takes you 
to the page you chose, at the part of the document where it is anchored.

Internal name
given to 
selected text.
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Other Buttons in the Link Dialog

The Link dialog also contains these buttons:

Making Anchors Within a Page
Anchors allow you to use plain text in a document and link to that exact part of the 
document. The anchor is not a link and cannot be clicked on. It is used as a target text, 
for example in a long page with an index or a table of contents.

Make an anchor within a page:

1 Type or select some text in your page. 

2 Choose the Element Anchor menu item.

3 Type an anchor name in the text field. For convenience, use an anchor name that is 
related to the text you selected. For example, you could type Top if you are placing 
an anchor at the top of the page so that links within a long page can jump back to 
the top of the page.
If you already created a link to this anchor, use the same anchor name you used in 
the link dialog.

4 Click OK. The text you selected in your document turns magenta (unless you are 
using a customized Style Sheet). This reminds you where the anchors are in your 
page. Other browsers will show anchors as normal text. 

Cancel Close the Link dialog box:
Select Only If the text you selected already contains a link, then that link URL 

is displayed in the Link to Page field and the Select Only button is 
enabled. Because selecting text by dragging and highlighting is 
inaccurate, selecting this button ensures that you select only the 
text that was the previous link.

Browse Allows you to browse your local files or your GNN Hosting 
Service directory for files to choose as links. If you enter a site that 
you cannot browse, you get a message “Cannot Browse Location.” 
(For details on using such file selection dialogs, see page 40.)

Relativize or 
Absolutize

Click the Relativize button to change the link reference to a relative 
URL. If the reference is already a relative reference, click the Abso-
lutize button to change the reference to an absolute reference. See 
page 115 for an explanation of relative and absolute references.

Help Provides an online Link Help Page.
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To check anchor names or remove anchors:

If you forget an anchor name and want to create a link to that anchor, select the 
anchor text and choose Element Anchor. You will see the anchor name in a dialog.
If you erase the anchor name from this dialog and click OK, the anchor will be 
removed from the page.

Copying and Pasting URLs
In addition to selecting text to link to, you can copy-and-paste URLs from almost any 
source, including Hot Lists and web pages. To copy a URL from the Hot List:

Copying a URL:

• If the page you want to link to is stored in your Hot List, open your Hot List with 
the Browse Hot List menu item, select the page you want to link to, and click the 
Copy URL button. This copies the URL of the page so that you can paste it.

• If you’ve already opened the page whose address you want to copy, choose 
the Edit Copy URL of Page menu item (or click the Copy URL button in the 
toolbar). This copies the URL of the current page so that you can paste it.

• If the page you want to link to is listed as a link on another page, highlight that link 
and choose the Edit Copy URL in Selection menu item (or click the Copy URL 
button in the toolbar). You can hold down the Ctrl key on your keyboard while you 
highlight a link to prevent GNNpress from opening that page. This copies the URL 
of the link so that you can paste it.

Pasting a URL to create a link:

• If you want GNNpress to fill in the text for the link, position the cursor 
where you want to create the link, and choose the Edit Paste URL menu 
item (or click the Paste URL button in the toolbar). This creates a link to 
the URL you copied. If you copied the URL of a page, GNNpress adds 
the title of that page as the text for the link. If you copied the URL of a highlighted 
link, GNNpress adds the URL of the page as the text, instead.

• If you want to turn existing text into a link, highlight the text you want to link, and 
choose the Edit Paste URL menu item (or click the Paste button in the toolbar). 
This makes the highlighted text a link to the URL you copied.
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Email Links

If you want people who visit your pages to be able to send you email by clicking on a 
link, you can create an email link.

Creating an email link:

1 Select the text you want to link. For example, you might select your email address 
or text that says “Send me email.”

2 Choose the Element Link menu item to bring up the Link dialog.

3 In the Link To Page field, type mailto:me@myaddress.com

4 Click OK. When people click on this link, most browsers will let them send email 
to the address you typed.

Image Maps—Links to Images
Image maps are images that, when clicked on, act like linked text. The difference is 
that you can map URLs to different parts of the image. For example, you could create 
an image map with symbols for parts of your business (support, sales, products). When 
the reader clicks on a part of the image, the reader is taken to a page on that subject.
Because image maps require readers to download an extra image, you should use them 
only when they present a distinct advantage in navigating your web pages. By using 
the GNN Hosting Servicealong with GNNpress, you can create quick and easy image 
maps.
The browser, in this case GNNpress, requests a page that contains an image map. It 
also requests the image and displays it along with the text. The reader clicks on the map 
image. GNNpress sends the coordinates of the click to the server, which processes the 
coordinates and decides which “hot spot” the mouse was in when it was clicked. It then 
returns the URL for that spot. If the spot is not mapped, the default URL is returned 
instead. GNNpress retrieves the page designated by the URL and opens a new window.
When you delete an image map from a page (by highlighting it and pressing the Delete 
key), the actual image and image map files are not deleted. To delete the files, you can 
use File Delete or by selecting and deleting the file’s icon in the MiniWeb view.
If you are unfamiliar with how to import and use images in documents, see page 86.

Make an image map:

1 Select an image in your document that you would like to place hot spots on. Choose 
the menu Element Image Map to see the GNNpress – Image Map dialog.

You will probably want to re-size the Image Map dialog to be able to see the 
entire image. You can do this as you would for any window.
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The following items are in the Image Map dialog:

Map Name This is the name of your map file, which is different from the 
name of the image. Map names end with .nvm , which replaces 
the ending of your image file (for example, .gif ). You can 
rename it if you wish.

Create Rectangle The image you have just selected is located in this box. This is 
the work area where you draw rectangles that will be hot spots. 

Rectangle List This is a menu list of your map hot spots. The coordinates of 
the rectangle are listed along with the URL of the item.

Location Type the URL you want the rectangle to link to.
Rectangle in 
Pixels

When the Image Map dialog opens, the four pixel boxes have 
zeros. After you select a rectangle in the Create Rectangle box, 
the pixel boxes show the coordinates of the rectangle. You can 
also make rectangle selections by entering the exact pixel 
coordinates.

Selection Type: 
Rectangle or 
Default

Choose Rectangle to select rectangle hot spots. Choose Default 
to select the default link (the URL that appears if no selection 
is clicked on the image map).

OK Closes the Image Map dialog box.
Cancel Closes the Image Map dialog box without making the 

changes.
Add Adds a new selection or hot spot to the image map.

Create 
rectangle:
working area
for creating 
hot spots on
map

Coordinates
of rectangle

Enter new
map file
name
Menu list of
map shots

Enter URL
for the 
highlighted
area on the
image 
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Example: insert a specific image map:

1 Set the default location by clicking the Default button under Selection Type.
If nothing is chosen for default, clicking outside all hot spots has no effect.

2 Enter a URL in the Location field (for example, http://gnn.com/ ) for the default 
selection.

3 Click the Add button. The default location has now been set. If a reader clicks on a 
spot that has not been mapped, this default URL page appears.

4 Click the Rectangle button under Selection Type.

5 Depress your cursor on the parts of the image you wish to select. Hold down the 
cursor and draw a rectangle to select a hot spot.

6 Enter the URL in the Location field (for example, http://www.aol.com/ ) for the 
first map selection.

7 Click the Add button. Don’t be afraid if you make mapping mistakes at first. 
Mappings that have been added can be removed by choosing the Remove button. 
Try the map again.

8 Repeat the above steps for each URL you wish to be mapped. When done, choose 
the OK button.

The image map you have just created has a fine blue line surrounding it, which 
indicates that the image is a link—possibly an image map, but it could also link to a 
normal page. Click on the hot spots you have just created and the hot spot’s page 
appears. Click on the MiniWeb for this page and you can see the icons that designate 
images maps.

Change Allows you to edit any URL selection you have made.
Remove Removes the rectangle or hot spot selected.
Up Moves the rectangle or hot spot selected up one line.
Down Moves the rectangle or hot spot selected down one line.
Browse Allows you to browse your local files or your GNN Hosting 

Service directory for choosing map links.
Help Provides an online Image Map Help Page.
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Links to Other Media
This guide assumes you already have audio or video files if you plan on incorporating 
them into your web document. It does not explain how to create these other media files.
Links to audio or video files are just like links to other pages. However, audio and 
video are not viewed or heard when first displayed. An external viewer (for video) or 
player (for audio) is required to use these types of links. See page 174.

Insert an audio or video link:

1 Select the text or image you would like to be linked to your audio or video file.

2 Choose the menu Element Link.

3 Either type in the URL if you know it or browse your files to locate the file you 
wish you link. Click OK.

The selected text is now blue, italic, and underlined and is linked to the file you chose. 
You can click on this link, and if you have the external player or viewer you will see 
or hear the file.

Changing Links

Modify an existing link:

1 CTRL+select an existing link, or, if the link is one word, CTRL+double-click on 
the link.

2 Choose the menu Element Get Attribute or Element Link.
You can now make any changes to your link just as you would if you were creating a 
new link from plain text.

Remove a link:

1 CTRL+select an existing link, or, if the link is one word, CTRL+double-click on 
the link.

2 Choose the menu Element Unlink.
The selected text now appears in the state it was before it was a link.
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Checking Links
You use this GNNpress function to make your web information as accurate as possible. 
Check Links gives you the ability to select a GNNpress page and check most of the 
links it contains. GNNpress finds links that are not working, for whatever reason. You 
can then edit your document and links as needed. Without Check Links, you would 
have to click on each link in the document to verify it.

To check the links in any Web page:

3 Open any Web page, either in your local directory or on a web server.

4 Choose menu Tools Check Links to see the Check Links dialog.

5 Watch the dialog box.

GNNpress scans all links to the page and verifies that they exist. A status message at 
the bottom of the dialog box keeps you apprised on GNNpress’ activity. If it finds a 
bad link, the status message changes to indicate the problem. If no bad links are found 
you get “no bad links found” message.
If you get a “Could not find ‘http://....’ message, you can edit the URL.

Link to Page

Edit the URL:

1 Edit the URL as necessary in the Link to Page field.

2 Select the Change button.
This corrects the link in the page and moves on to check the next link.
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Appending an Anchor Name

Add an anchor to the URL:

1 Type in an anchor name in the Append Anchor Name field.

2 Select the Change button.
This changes the link, adds the anchor, and moves on to check the next link.

Closing the Check Links Dialog
While the Check Links dialog is open, your page is locked. You cannot browse any 
links until you close the Check Links dialog. If you try you get a “This page is 
temporarily locked...” message at the bottom of your Page window. You can use the 
File Open dialog to load pages though.

Close the Check Links dialog:

Click the Done button.
You can also cancel the link checking while it is in progress by clicking this 
button.

Stopping Link Checking

Abort the link checking:

Click the Stop button.
This gives you an “aborted ‘http://....[name of link currently being checked]’” message 
and allows you to change the link.

Checking the Next Link

Continue link checking:

Click Next.
Use after interruption, or if you wish to leave in a link that is currently unavailable.
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Browsing to Choose Links

If you want to change the URL of a link, you may want to browse your local files or 
your GNN Hosting Service directory.

Browse files or a server:

1 Click Browse.

2 Click on the down-arrow to the right of the Drives / MiniWebs / Sites field to choose 
a drive, server, or MiniWeb to browse.

3 Click on the down-arrow to the right of the Files/Directories field to browse files and 
directories once you have chosen a drive, server, or MiniWeb.

If you enter a site you cannot browse, you see a “Cannot Browse Location” message.

AutoLinks
GNNpress can search the GNNserver that hosts your pages for other pages you might 
want your pages to link to. Then, you can choose whether you want GNNpress to 
create each link. All the pages on the GNN Hosting Service server or a GNNserver you 
choose are searched for possible links.
If the Tools AutoLinks command is not visible in your version of GNNpress, choose 
the Tools Preferences menu item. In the General Preferences dialog, uncheck the 
“Short Menus” item. Then, click OK.
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To AutoLink a page:

1 Open the page in which you want to create links with GNNpress.

2 Select Tools AutoLinks.

3 In the “AutoLinks” window, select the GNNserver you want to search. For 
example, you can type http://members.gnn.com/  (or select it from the pull-
down list). 

4 Click OK. GNNpress sends your page to the server, and the server uses natural 
language processing technology to identify potential links from your page to pages 
on the server.

5 You may be prompted for your username and password. Type these and click OK 
to access the server.

6 When the server has finished examining your page, GNNpress opens a window that 
lets you select which of the suggested links you want to add to your page.

7 In the list of Suggested Anchors, highlight one of the lines of text. GNNpress scrolls 
your page to show you this text in context. It also lists the titles of the suggested 
link pages in the Potential Pages For Selected Anchor list.

8 To see a suggested page, highlight a title in the Potential Pages For Selected Anchor 
list. Then, click Show Page. GNNpress opens that page in a new page window.

9 To create a link to a suggested page, highlight the title of the page in the Potential 
Pages For Selected Anchor list. Then, click Apply. GNNpress links the text in your 
page to the page you selected.
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Style Sheets
Style sheets are a way of customizing the way Web pages are displayed. A style sheet 
allows you to specify how each HTML element is formatted. For example, your style 
sheet can display Strong characters in cyan and italic and level 1 headings (Hdg 1) in 
right-justified 36 point text.
If the Format Style Sheet command is not visible in your version of GNNpress, choose 
the Tools Preferences menu item. In the General Preferences dialog, uncheck the 
“Short Menus” item. Then, click OK.
You can use GNNpress style sheets for two purposes:

• To customize the way other people using GNNpress see your pages. If you apply 
a style sheet to a page in your MiniWeb, other GNNpress users will see the styles 
you created. (Your style sheet will not affect the way the page is displayed by other 
browsers, such as GNNworks.) 

• To customize the way pages anywhere in the Web look when you view them. You 
can apply a style sheet to any page. Your style sheet will affect how the page looks 
in your current session. You can choose a default style sheet so that all pages you 
view use that style.

The Format Style Sheet dialog provides a list of style maps and allows you to apply 
one to the current page. You can also create new style sheets (by selecting a base style 
and pressing the New button), or browse around the net to find existing maps.
You can use Format Body Attributes to change the background and text colors so that 
people using other browsers will also see your changes. See page 94 for details.

Quick Start
Here is a quick summary of commands you can use with Style Sheets:

Edit a Style Sheet Format Style Sheet, click Edit to get the 
Edit Style dialog

Edit the way various paragraph formats 
are displayed

Paragraphs from the Style Types list in the 
Edit Style dialog

Edit the way type styles and 
anchored/linked text are displayed

Type Styles from the Style Types list in the 
Edit Style dialog

Edit the way various lists are displayed Lists from the Style Types list in the Edit 
Style dialog

Edit the way Horizontal Rules are spaced Horizontal Rule from the Style Types list in 
the Edit Style dialog
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Purpose of Style Sheets
HTML allows both logical and physical styles. In GNNpress these styles are listed in 
the Format Type Style menu.
The physical styles (Plain, Bold, Italic, Underlined, Fixed Pitch, Superscript, 
Subscript) describe how the text looks on the page.
The logical styles (Citation, Code, Definition, Emphasis, Keyboard, Sample, Strong, 
and Variable) describe the content of the tagged text and allow the reader (browser) to 
determine how it looks on the page. Content can be divorced from presentation.
Logical tags allow the author to specify that a particular line is a level-one heading but 
does not specify that a level one heading should be, for instance, 24-point Times 
Roman and centered.
This also allows readers to change the presentation of every occurrence of a particular 
style type by simply changing its definition within a style sheet.
Within the Style Sheet dialog the user can decide how the different Paragraph and 
Heading formats, Type Styles, Lists, and the Horizontal Rule appears on the screen.

Editing and Creating Styles
The dialogs for editing a style or creating a new style are similar.

Selecting an Existing Style to Edit
You edit style sheets through the Edit Style dialog. Usage of this dialog is covered in 
the “Edit a Style” section that follows. To get to it, go through the following steps.

Bring up the Edit Style dialog for an existing style:

1 Choose Format Style Sheet to start the Styles Sheet dialog:

Listing where 
all created
style are kept
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This dialog lists the style sheet (if any) associated with your current page and any 
style sheets you created or edited during this GNNpress session. Style sheets can 
be stored on your local drive or on a server.

2 To select a style sheet to edit, either:
Highlight a style sheet in the Style Sheets list.
To find a style sheet that was created in a previous session, click the Browse 
button to search your local directories or remote servers for .stl  files.  (.stl  
is the default file extension for style sheets.)

3 Click the Edit menu item.

4 Continue with the steps in the “Edit a Style” section below.

Creating a New Style Sheet

Bring up the Edit Style dialog for a new style:

1 Choose Format Style Sheet to start the Styles Sheet dialog. Select a base style.

2 Click New and the New Style dialog appears.
This dialog provides a default location that is the path (local directory or URL) and 
file name of the current page with an extension of .stl

You can start with an existing style sheet.

3 Optionally, enter or modify the location and file name of the new style sheet in the 
Name New Style Location field.

4 Click OK, and the Edit Style dialog appears. From here on, the commands are the 
same as if you were editing an existing style, and are covered in the “Edit a Style” 
section next.

Enter URL for
style location
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Editing a Style
Whether you are editing an existing style or creating a new style, you work through the 
Edit Style dialog.

You can select a Style Type by using the scroll arrow to the right of the Style Types box. 
Choices are Paragraphs, Type Styles, Lists, and Horizontal Rule.

Edit styles for Paragraphs:

“Paragraphs” include the various kinds of text that appear between carriage returns. 
These include normal paragraphs and headings.

1 Choose Paragraphs from the Style Types field in the Edit Style dialog. You will see 
several fields that let you control the appearance of the various paragraph formats.

Scroll to 
access style
types

Select 
desired
style
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Select a paragraph type from the Edit Style Items field. Choices are Normal, Hdg 
1 through Hdg 6, BlockQuote, Preformatted, Lineprinter Listing, and Address.

2 Choose an Alignment style for the paragraph.

3 Choose the Color of the text in the paragraph or type in an “rgb” (red-green-blue) 
color, like “128 128 128” for gray.

4 Set the Indentation (in points) of the First line and subsequent lines (Others) of the 
paragraph. 1 inch = 72 points.

5 Enter a value for Leading in the Initial field. Leading (pronounced “ledding”) is the 
amount of blank space above the first line in the paragraph. Values are in points.

6 Click the Font button to select a Font, Style, and Size. For any choice, the selected 
font appears in the Sample Text box. The Fonts and the dialog boxes vary on 
different platforms.

7 If desired, choose another paragraph format to be edited from Edit Style Items or 
choose another Style Type.

8 Click OK to save the changes in the style sheet and return to the Styles Sheet dialog.

Edit Type Style:

“Type Styles” include character and logical formats. They also include special kinds 
of text, like anchors and links.

1 Choose Type Styles from the Style Types field in the Edit Style dialog. You will see 
several fields that let you control the appearance of the various type styles.

Optional
special
effects

Display of
font choice
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2 Select a type style from the Edit Style Items field. Choices are Bold, Italic, Underlined, 

Fixed Pitch, Superscript, Subscript, Citation, Code, Definition, Emphasis, Keyboard, 
Sample, Strong, Variable, Link Anchors, Link Cached Anchors, and Anchors.

3 Choose the appearance you want for the type style you selected from the Emphasize 
To list. Choices are Normal, Bold, Italic, Underline, Underdash, Bold Italic, Bold Under, 
Bold Dash, Italic Under, Italic Dash, Bold Italic Under, Bold Italic Dash, Subscript, or 
Superscript.

4 Choose the color of the text from the Color list.

5 If desired, click the Font... button to open the Font Selection dialog.

6 If desired, choose another paragraph format to be edited from Edit Style Items or 
choose another Style Type.

7 Click OK to save the changes in the style sheet and return to the Styles Sheet dialog.

Edit styles for Lists:

“Lists” include bulleted and numbered lists. Each nested level (1-4) of numbered and 
bulleted lists can be edited separately.

1 Choose Lists from the Style Types field in the Edit Style dialog. You will see several 
fields that let you control the appearance of the various types of lists.
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2 Select a list type from the Edit Style dialog. Choices are Numbered List and Unnum-

bered List (bulleted).

3 Choose the Nested Level you wish to edit. Choices are 1, 2, 3, or 4.

4 If you are editing the appearance of a Numbered List, select the Numeric Style for the 
Nested Level you chose. Choices are Arabic (regular numbers), Lower case Roman, 
Upper case Roman, Lower case Letters, and Upper case Letters.

5 If you are editing the appearance of an Unnumbered List, choose the Bullet Style for 
the Nested Level you chose. 

6 Set the Indentation (in points) of the First list item and the subsequent list items 
(Others). 1 inch = 72 points.

7 Set the Leading values for the Initial List—the vertical space between the first list 
item and the line above it—and for Within List, the vertical space between items in 
the list.

8 If desired, choose another Nested Level, another list type from Edit Style Items, or 
another Style Type.

9 Click OK to save the changes in the style sheet and return to the Styles Sheet dialog.

Edit style for Horizontal Rule:

You insert a horizontal rule with the Element Horizontal Rule menu (see page 73). 
Here we describe how the Style Sheet determines the spacing of horizontal rules.

1 Choose Horizontal Rule from the Style Types field in the Edit Style dialog. You will 
see a fields that lets you set the spacing of horizontal rules.
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2 Set the Leading value (in points) for Initial. This determines the height of the blank 
vertical space between a horizontal rule and the line above it.

3 If desired, choose another Style Type to be edited.

4 Click OK to save the changes in the style sheet and return to the Styles Sheet dialog.

Applying Styles
You apply Style Sheets to a page by clicking Apply in the Styles Sheet dialog after 
closing the Edit Style dialog.

• If you apply a style sheet to a page in your MiniWeb, other GNNpress users will 
see the styles you created. (Your style sheet will not affect the way the page is 
displayed by other browsers, such as GNNworks.) 

• You can apply a style sheet to pages anywhere in the Web. Your style sheet will 
affect how the page looks in your current session. You can choose a default style 
sheet so that all pages you view use that style.

Apply Styles:

1 Select a style sheet from the Styles Sheet dialog, which lists the style sheet (if any) 
associated with your current page and any style sheets you created or edited during 
this GNNpress session. To find a style sheet created in a previous session, click 
Browse to search your local directories or remote servers for .stl  files.

2 Click the Use As Default Style box so that it is filled.

3 Click the Apply button.
The Style Sheets dialog closes and the selected style sheet is applied to the page and 
all other pages you view.
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Viewing and Editing HTML
If you know the source language for Web pages, HTML, or if you want to learn about 
it by example, use the Tools Show HTML menu item. You will see the actual document 
with its HTML tags. 
GNNpress lets you edit the HTML source directly and then test your changes quickly. 
You might want to edit the HTML source to add tags for which GNNpress does not 
provide direct authoring support. For example, you can add the <P CLEAR=ALL>  tag 
after a paragraph that wraps around an image to make sure the next paragraph or image 
starts below the first image. 
You might also want to view the HTML source to find out how a particular page was 
created so that you can create similar pages.

Viewing the HTML

Open a window showing the HTML tags:

1 Open a Web page. The page need not be part of a MiniWeb.

2 Choose the Tools Show HTML menu item to open a window containing the HTML 
for your page. If any text in the Page window was highlighted, the HTML window 
automatically scrolls to show that highlighted text.

3 You can open multiple HTML windows for different Page windows at the same 
time, if you like.
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To close the HTML window, either:

With focus in the HTML window, choose the File Close menu item.
Edit the page in the Page window. The HTML window closes automatically when 
you edit the Page window so that the contents of the Page window and the HTML 
window will not conflict.

Editing the HTML
You can edit the HTML source and load the changes you make into the Page window. 
For example, you might want to add HTML extensions for which GNNpress does not 
provide WYSIWYG authoring support. 

Editing the Source:

1 Open a GNNpress page.

2 Choose the Tools Show HTML menu item.

3 You can edit the HTML by typing text directly or by using any of the commands 
in the Edit menu.

If you cut and paste from an HTML window to a Page window, you will be able 
to see the HTML tags in the Page window. You can use this technique if you 
want to create a Web page that explains how to use HTML tags.
If you cut and paste from a Page window into an HTML window, the tags will 
not be pasted.

4 To save changes you make in an HTML window, choose the File Parse menu 
item. GNNpress checks your HTML code for errors. If any errors are found, you 
will see a message explaining the error. If no errors occur (or if you choose to 
ignore the errors), your changes will be shown in the Page window.

You can also choose File Save As to save your HTML changes to a separate 
file.
Use File Reload if you want to discard changes you made to the HTML and 
start modifying the HTML again using the current code for the Page window.
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Additional HTML 3.0 Tags Supported

In addition to the HTML tags you can add through WYSIWYG editing in GNNpress, 
the following HTML 3.0 tags are supported by the GNNpress browser. See the HTML 
3.0 draft specification for details. Other browsers may not yet support these additional 
tags 
See page 170 for information about how tags differ in HTML 3.0 and Netscape.

Tag Description
<LINK REL=> Adds buttons to the toolbar for links such as “Home”, 

“Next”, and “Index”. For example:
<LINK REL=Previous HREF=”mydoc2.htm”>

<LINK REL=Bookmark TITLE=”Buy” 
HREF=”b.htm”>

<TAB> Sets tab stops and indents text. Attributes supported are 
ID, TO, and INDENT. For example,
Item 1: <TAB ID=T1>description

<P><TAB TO=T1>2nd description paragraph

<AU>, <PERSON> , 
<ACRONYM> , and 
<ABBREV>

Identify the following types of content: authors, people, 
acronyms, and abbreviations.

<INPUT TYPE=RANGE> Creates a sliding range field inside a form.
<INPUT DISABLED> Prevents the reader from setting a value in a field.
<P CLEAR=>

<BR CLEAR=>
Moves text down to clear space after an image. If you use 
LEFT or RIGHT alignment for images near each other, 
you will probably want to use this tag. The CLEAR 
attribute can be set to LEFT, RIGHT, or ALL.

<P NOWRAP> Prevents the text in a paragraph from wrapping.

<TABLE>  attributes: 
WIDTH , UNITS , 
COLSPEC , and NOWRAP

Provide additional control over width and formatting of 
tables.
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MiniWebs help you manage the files that make up your Web site. You can think of a 
MiniWeb as being similar to the Windows File Manager or the Macintosh Finder. 
MiniWebs provide a visual structure for organizing and manipulating your Web pages. 
In addition to letting you visualize and edit your Web structures, one of the real 
strengths of MiniWebs is that they help you manage and maintain your Web 
structures.(A number of MiniWeb features are new in GNNpress v1.1. See page 10 if 
you do not yet have v1.1.)
These are just some of the benefits provided by MiniWebs:

• MiniWebs help you visualize the organization of your pages and other files.
You can view MiniWebs in many ways — as a web, as a tree, and as a list of 
files sorted by name, title, or type. These views make it easy to find broken 
links, pages not linked to other pages, pages you have links to but have not yet 
created, and more.
You can show or hide both links to files and links from files, and you can hide 
groups of files so that you can focus on other files.

• MiniWebs help you edit groups of files.
You can “Webize” an existing set of directories — making MiniWebs and 
SubWebs (nested MiniWebs) automatically.
You can perform a find and replace on all the pages in a MiniWeb at once.
You can create a “stationery” page to be used as a template for all new pages.
You can verify that links in a MiniWeb work and easily fix any broken links.
If you rename a file in a MiniWeb, links to that file in the current MiniWeb are 
automatically corrected.
You can drag-and-drop files from your MiniWeb to your pages to create links.
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• MiniWebs help manage your pages and other files.
You can print all the pages in a MiniWeb, or print any view of a MiniWeb.
You can use a hierarchical directory structure with relative links between files 
in different directories. This makes it easy to move files to a different location.

Things to Know About MiniWebs
Each MiniWeb shows the contents of a directory on your local machine or on your 
GNN Hosting Service directory. When you create files in a MiniWeb, you are also 
creating files in that directory.
You can put one MiniWeb inside another MiniWeb to reflect the directory structure of 
your entire site. (Such nested webs are called “SubWebs”. See page 158 for details.) 
(See page 10 if you do not yet have v1.1.)
MiniWebs are excellent tools for creating Web sites with multiple pages — even if  
you expect your readers will be using browsers other than GNNpress. 
Because MiniWebs are unique to GNNpress, you cannot view MiniWebs with other 
browsers. In addition, you cannot use MiniWebs to view the directory structures of 
other servers.

MiniWeb’s
home page

Unsaved

Animation

web page

Saved web
page

Page of
unknown
type

Video 

Sound
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Ghost page
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Quick Start
Here is a quick summary of commands you can use with MiniWebs:

Viewing MiniWebs
MiniWebs provide a visual structure for organizing and manipulating your Web pages. 
You can view MiniWebs in many ways — as a web, as a tree, and as a list of files 
sorted by name, title, or type. These views make it easy to find broken links, pages not 
linked to other pages, pages you have links to but have not yet created, and more. You 
can also show or hide both links to files and links from files, and you can hide groups 
of files so that you can focus on other files.

Open a MiniWeb File Open or select the open icon in the MiniWeb view.

Open a new MiniWeb File New MiniWeb or select the MiniWeb icon in the 
MiniWeb view.

Open a file File Open or select the Open icon in the MiniWeb view.

Open a new page File New page or select the Page icon in the toolbar.

Templates

Open a template Help Templates. Click on the Templates link and select 
one of the templates. Then, click on the MiniWeb icon.

Save your own copy of 
the template 

File Save As

Directories

Convert a directory into a 
MiniWeb

Tools Webize

Modify MiniWebs

Add Pages File New Page or choose the Page icon in the toolbar.

Set the Home Page Click on the down arrow to the right of the Home Page 
Title field.

Copy URLs Edit Copy URL or choose the Copy URL icon in the 
toolbar.

Delete Pages Highlight an icon, and press the delete or backspace key; 
or highlight an icon and choose the Edit Cut or File De-
lete menu item.

Save File Save or File Save As.
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Creating MiniWebs
If MiniWebs and MiniWeb commands are not visible in your version of GNNpress, 
choose the Tools Preferences menu item. In the General Preferences dialog, uncheck 
the “Short Menus” item. Then, click OK.

To create a new MiniWeb, either:

Choose the File New MiniWeb menu item.
Click on the “New MiniWeb” icon in the MiniWeb toolbar.

If your current window is a MiniWeb view, the new MiniWeb you create using either 
of these methods will be a SubWeb of that MiniWeb. See page 158 for details about 
SubWebs. 

Webizing Existing Directories
You may already have a set of files you want to publish on the Web. GNNpress makes 
it quick and easy to convert directories or folders containing pages and other files into 
a MiniWeb. We call this “Webizing” the directory.
You can Webize a directory on your hard drive or one of your GNN directories (for 
example, http://members.gnn.com/netname ). You cannot Webize someone 
else’s Web site.
You should re-Webize your directories if you add pages or other files to the directory 
with a product other than GNNpress. GNNpress can’t add icons to your MiniWeb 
automatically if you create them outside GNNpress. Also, if your MiniWeb doesn’t 
match the files your directory contains, you can re-Webize the directory anytime.



Working with MiniWebs
Viewing MiniWebs

Do-It-Yourself Authoring and Publishing for the World Wide Web 143

8

To convert existing directories to MiniWebs:

1 From any Page or MiniWeb window, choose the Tools Webize menu item. 

2 If the directory you want to Webize has subdirectories (or folders) that you want to 
turn into SubWebs, click Options. The Webize Options dialog lets you choose 
whether you want to Webize subdirectories that are not already MiniWebs, and 
whether you want to Webize subdirectories that are already MiniWebs. If you 
check both boxes, all subdirectories are Webized. If you uncheck both boxes, no 
subdirectories are Webized. (See page 10 if you do not yet have v1.1.)

3 Browse to find the directory you want to convert to a MiniWeb.
If you want to Webize a directory and its subdirectories, find the highest-level 
directory you want to Webize. 

4 Double-click on the directory name in the list of Files. Or, select the directory in the 
Directory list and click Webize.

5 If a MiniWeb already exists for a directory, you will be asked whether you want to 
regenerate the MiniWeb.Click Regenerate to update the MiniWeb.

Opening Existing MiniWebs
You can store MiniWebs on your local disk drives, on any disks you can connect to 
through your local network, or on your GNN Hosting Service directory 
(http://members.gnn.com/ netname/). There are several ways to open existing 
MiniWebs.
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To open an existing MiniWeb, do one of the following:

Choose the File Open menu item. Select MiniWeb in the List Files of Type field. 
Select the MiniWeb you want to open. Then, click Open.
(If the MiniWeb is not listed as a separate file, select its directory and erase the file 
name of “new.htm” at the end of the Location field.)
Select the Open icon in the MiniWeb view.
Type the MiniWeb URL you want to open in the Location field of a Page window. 
For a MiniWeb stored on your hard drive (on a PC), you might type 
C:\users\me\myweb . For a MiniWeb stored on your GNN Hosting Service 
directory, you might type http://members.gnn.com/ netname/myweb .
Click on the MiniWeb icon to the left of the Title field in a Page window.
You can click this button any time you are viewing a page that is part of a 
MiniWeb. The button is grayed out if the page is not part of a MiniWeb. See page 
142 for information on converting directories into MiniWebs.

Templates
Templates are existing example MiniWebs we have created for your use. You can 
simply view them to get ideas or a better understanding of how MiniWebs work, or 
you can create your own copy of them and adapt them to suit your own purposes.

To adapt a template for your use:

1 Select the Help Templates menu item to open a page that lists MiniWeb templates 
you can use.

2 Click on the Templates link to move down the page to the list of templates.

3 Click on the Resume link to see the resume template.
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4 Click on the MiniWeb icon to the left of the Title field. You will see the MiniWeb 

for the resume template.

5 Choose the File Save As menu item.

6 It's a good idea to save the template MiniWeb to your local hard drive while you're 
working on it. Select the drive from the Drives / MiniWebs / Sites field and find the 
directory you want to contain the MiniWeb. A new subdirectory will be added to 
that directory to contain the MiniWeb when you click OK.

The status bar of the MiniWeb displays the names of all the MiniWeb files. It then 
briefly says “Publishing...” and then “Saved,” indicating a successful copy and save of 
the Template to your local files.
If you are using GNNpress on a Macintosh, it is best to save your copied MiniWeb in 
its own folder on your computer. Saving it directly to your desktop might not copy the 
files successfully.
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Selecting a MiniWeb View
The default way to view a MiniWeb is with the “Web” view. The MiniWeb is shown 
with icons for all the files in as a series of concentric circles. The icons are connected 
by arrows that show the connections between files. You can view MiniWebs in several 
other formats. The “Tree” and “Name” views are shown in the figures that follow.

• Web View of a MiniWeb

• Tree view of MiniWeb: (See page 10 if you do not yet have v1.1.)
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• Name view of a MiniWeb: (See page 10 if you do not yet have v1.1.)

To select a MiniWeb view:

1 Choose the View Name menu item. (See page 10 if you do not yet have v1.1.) The 
window will list files by file name. Links to files are indented below each file.

2 As you work, you can switch the MiniWeb view between Web, Tree, Name, Title, 
and MIME Type (which is similar to the file type).

3 Notice that each type of file has a different icon, and that there are several colors 
for arrows and text. The next sections explain these icons, arrows, and colors.

Icons in MiniWebs
One page is designated the home page (it is displayed with a special icon—a spider in 
its web), any file in the directory that can be reached through a series of links from the 
home page is shown in the web. Some pages may not be “reachable”; they are 
displayed either to the right or below the main graph.
Pages that are referenced but have not yet been created are grayed out. References to 
the external Web have another type of grayed icon, and their names are green. Files 
other than pages (images, sounds, etc.) are shown with different icons. Pages icons are 
webs, image icons are a landscape, sound icons a speaker, video files a projector, style 
files an italic f, and image maps a map of the U.S.
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HTML pages come in three states: new, modified and normal. The normal icon is a full 
web, the modified icon is a broken web (until the file is saved), the new icon is a very 
small web.Pages and images come in several states with similar icons.

Arrows in MiniWebs
When you use the “Web” or “Tree” view, arrows between the icons indicate the 
relationships between them. 
• Black arrow: A normal, one directional link.

• Double-ended cyan arrow: Each page refers to the other. 

• Blue arrow: Link to an in-line image. 

• Green arrow: Link from a page containing a form to the form handler program.

• Gray dotted arrow: A link that does not appear in the page when it is displayed (for 
example, a link to an image map file)

Color Codes in MiniWebs
MiniWebs are color coded to show the status and relationships of the files in the 
MiniWeb:

Focusing the View
GNNpress provides several ways to focus on the files you are working on, even if your 
MiniWeb contains lots of files. (See page 10 if you do not yet have v1.1.)

Home page External 
image

New page

Ghost image 
(file not yet 
created)

Image Unsaved 
page

Icon color/style

Solid The file is physically located in the MiniWeb.

Dithered The file is a relative link, but is not physically located in 
the MiniWeb. See the "Links" section on page 115 for an 
explanation of relative and absolute references

Green text The file is an absolute link and is not physically located in 
the MiniWeb.

Broken The file is physically located in the MiniWeb but has 
unsaved changes.
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To hide various file types:

1 Choose the View Display 
Control menu item.

2 In the Display Control window, 
select the types of files you 
want to hide. You can hold 
down the Shift key to select 
several types in a row, or the 
Ctrl key (the Command key on 
a Macintosh) to select any set of 
file types. 

3 Click Apply to hide the file 
types you selected.

4 You can check the External files 
box to hide files outside your 
MiniWeb or the Ghost files box to hide files that are linked to but do not exist.

5 If you want to add kinds of files to the list, type a MIME type in the field and click 
Add. The new type will be added above the “Anything else” type. (To see a list of 
MIME types, choose the Tools Preferences Extensions/MIME menu item.)

To hide or display links in the Name, Title, or MIME type view:

If the Name, Title, or MIME Type view does not show links to other files, you can 
display them by choosing the View List Links To menu item.
If the same view does not show links from other files, you can display them by 
choosing the View List Links From menu item.
If a type of link is shown, you can hide those links by reselecting the menu item.

To find a file:

1 If you want to find a particular file in a large MiniWeb, choose the Edit Find Page 
menu item.

2 In the Find Page dialog, type the full name of the file you want to find. The file can 
be a page or any other file in the MiniWeb.

3 Click OK. The file you named will be highlighted in the MiniWeb.

To zoom in or out in the Web or Tree view:

You can view part of the MiniWeb at a larger size by choosing View Zoom In.
You can view more of a MiniWeb by choosing the View Zoom Out menu item.
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Using the MiniWeb View
Pointing the mouse at an icon displays the page’s title (or URL if it has no title) in the 
status bar. Clicking on an icon selects it. In the Web or Tree view, you can drag the 
selected icon around to reposition it. 

Opening Pages and Files
Dragging-and-dropping an icon from a MiniWeb view into a Page Window opens the 
file in that Page Window.
Double-clicking on an icon generally opens the file in a new Page Window. GNNpress 
performs the action that makes sense for each type of file:

Editing MiniWebs
You can use MiniWebs to help you create, save, and delete pages and other files. 
MiniWebs also help you create a variety of links between files.

Page If the page exists in the MiniWeb or there is an absolute link to the 
page, it is opened in a new Page Window. If the page has not been 
created (light dithered icon), GNNpress asks you if you want to 
create it. If there is a relative link to the page, you should first find 
the SubWeb that contains the page and open the page from that 
SubWeb.

Graphic GNNpress attempts to launch an external viewer. If no viewer is 
available, and the image is either a GIF, JPEG, or XBM, then it 
opens a Page window containing just the image. Otherwise you are 
asked if you want to save the file.

Video or 
Sound

GNNpress attempts to launch an external viewer. If no viewer is 
available, you are asked if you want to save the file.

Image Map The Image Map window is opened for the image.

Style Sheet The Style Sheet dialog is opened.

Form No useful result if double-clicked—produces a “Not Found” 
message, or something similar.
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Creating New Pages in MiniWebs

To create a new page or file in a MiniWeb, either:

Choose the File New Page menu item.
Click the New Page icon in the MiniWeb toolbar.
Double-click on any “ghosted” icon in your MiniWeb. (These icons show you 
which files are linked to but do not exist.) You will see a prompt that asks if you 
want to create the file. 

To define a page template (or “stationery”):

1 Highlight the page you want to use as a template in the MiniWeb window.

2 Choose the Edit Set Stationery menu item. When you create a new page, the page 
you selected will be used as the starting point for your new page.

Copying Pages and Files to MiniWebs
MiniWebs help you manage the files that make up your Web site. You can think of a 
MiniWeb as being similar to the Windows File Manager or the Macintosh Finder.
GNNpress gives you several ways to copy files to your MiniWebs.

To copy a file from one location to another:

1 Choose the File Copy File menu item. You will see this dialog: (See page 10 if you 
do not yet have v1.1.)
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2 Choose the file you want to copy. The file can be any file on your local or 

networked disks. Or, it can be a file on your GNN Hosting Service directory.

3 Click Copy when you have selected the file. You will see this dialog:

4 Select the directory where you want to save the file and add a file name. You can 
copy the file to a local disk, or to your GNN Hosting Service directory.

This method copies a single file. It doesn’t copy images within pages or other linked 
files to the new location. If you want to copy the images too, use the File Save As 
menu item and click the Options button to choose how to deal with images.

Other ways to copy files to your MiniWeb:

Edit a page and choose the File Save As menu item to save the page to your 
MiniWeb with a new file name or location.
Drag-and-drop a file icon from one MiniWeb to another. This copies the file to the 
second MiniWeb.
Import an existing file into the MiniWeb by choosing the File Import menu item. 
Importing a page into a MiniWeb puts a separate copy of the file in your MiniWeb.
Paste a page into a MiniWeb by pasting its URL: (You can use this method to copy 
a file anywhere on the World Wide Web to your MiniWeb.)

1 Move to a Page Window, highlight a link inside a Page Window, or highlight 
an icon in a MiniWeb.

2 Click the Copy URL button in the toolbar or choose the Edit Copy URL menu 
item. (Double-clicking on a MiniWeb icon while holding down the Control key 
also copies the URL so you can paste it.)

3 Move to a MiniWeb window and choose the Edit Paste URL menu item.
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Options for Copying Links and Images

If you use any of the previous methods (except File Copy File) to copy a page to a 
MiniWeb, you will either automatically see the following Options dialog or you can 
open the Options dialog by clicking the Options button in the file selection dialog.

This dialog allows you to set the following options:
File Format: Normally, pages are imported or copied as HTML pages. If you 
chose the File Save As menu item, you can change the format of the file that is 
saved to “Text without line breaks” or “Text”.
Save Images: When you copy a page, you can choose what you want to do with 
any images inside the page:

Control Links: If you want to convert relative links in the page to absolute links, 
check the Relative Links to Full URL box. For example, check this box if you copy a 
page from some other server and want the links in that page to continue working.
The Use Base when possible box is ignored when you are copying a file into a 
MiniWeb.

None Choose None if you do not want to copy any of the images. If the images 
are not already part of your MiniWeb, also check the Relative Links to 
Full URL box so that the links to the images will still work.

Relative Choose Relative if you want to copy images with relative links to your 
MiniWeb. You should also uncheck the Relative Links to Full URL box.

All Choose All if you want to copy all the images in the page to your 
MiniWeb. You should also uncheck the Relative Links to Full URL box.
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Saving MiniWebs
When you save a MiniWeb, GNNpress also saves all files in the MiniWeb that are 
open and have unsaved changes.

To save a MiniWeb, either:

From the MiniWeb window choose the File Save menu item. This saves the 
MiniWeb in its current location along with any unsaved pages.
From the MiniWeb window choose the File Save As menu item. You can use this 
dialog to move the MiniWeb to a different location on your local disk or on the 
Web. The files in your MiniWeb are copied to the new location you choose.
The Options button opens a dialog that lets you choose whether or not to save all 
the SubWebs under this MiniWeb, and whether or not to convert any relative refer-
ences to other files to absolute references. By default, relative links to files in the 
same MiniWeb are still relative in the new location and SubWebs under the 
MiniWeb are also copied to the new location. (See page 10 if you do not yet have 
v1.1.)

Deleting Files in MiniWebs
When you delete a file from a MiniWeb, you are also deleting the file from your disk 
or from the server’s disk. If other files in your MiniWeb link to the file you delete, you 
will still see a “ghost” image of the file icon.
Deleting an image or image map from a page does not delete the actual file. Likewise, 
deleting a page file does not delete files associated with it—such as images and image 
maps. If you want to delete files associated with another file, you must delete them 
separately using one of the following techniques.

To delete a file, either:

In a MiniWeb view, highlight an icon and press the Delete or Backspace key. You 
will not be prompted, and there is no way to undo this action.
In a MiniWeb view, highlight an icon and choose the Edit Cut menu item. You 
can choose the Edit Paste menu item to restore the file.
In a MiniWeb view, choose the File Delete menu item to open the Delete dialog. 
Select the file you want to delete and click Delete. A prompt window will ask if you 
are sure you want to delete the file.
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Creating Links Using MiniWebs
MiniWebs give you many ways to control links between pages and files.
If you rename a file within a MiniWeb, the links to that file within the current MiniWeb 
(but not the SubWebs) are automatically fixed. From a MiniWeb window you can also 
use the “Check Links” feature (see page 123) to check the links in all the pages in your 
MiniWeb and in all of its SubWebs at once. (See page 10 if you do not yet have v1.1.)

To create links:
Use the right mouse button to drag a page icon from a MiniWeb to a page. 
Use the right mouse button to drag an icon for an image from a MiniWeb to a page. 
The image is added to the page. (If you use the left mouse button to drag the image, 
instead, your page is replaced by a blank page containing the image.) (See page 10 
if you do not yet have v1.1.)
Paste a link into a page by pasting the URL:
1 Move to a Page Window, highlight a link inside a Page Window, or highlight 

an icon in a MiniWeb.
2 Click the Copy URL button in the toolbar or choose the Edit Copy URL menu 

item. (Double-clicking on a MiniWeb icon while holding down the Control key 
also copies the URL so you can paste it.)

3 Move to a Page window and position the cursor wherever you want to place the 
link. If the text or image you want to act as a link is already in the page, high-
light it. If you don’t highlight any text, the title of the page you are linking to is 
automatically added to your page as a link.

4 Choose the Edit Paste URL menu item.

Managing MiniWebs
In addition to letting you visualize and edit your Web structures, one of the real 
strengths of MiniWebs is that they help you manage and maintain your Web structures.

Setting the Home Page
The “home page” is the page where readers start in your directory. If a reader uses a 
URL with no file name (such as, http://www.mycompany.com/mydir/ ), the 
GNNserver automatically sends the home page in that MiniWeb to be displayed.
If you use a URL without a file name in GNNpress, you normally see the MiniWeb 
view for that directory if there is one. However, if you are using the short menus (see 
page 169), you will automatically see the home page.
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To set a home page for a MiniWeb: 

1 Click the arrow to the right of the Home Page field below the MiniWeb toolbar. You 
will see a list of the titles of pages in your MiniWeb.

2 From this list, select the title of the page you want to be the home page of your 
MiniWeb. The icon for that page in your MiniWeb will change to have a spider in 
the web.

Finding and Replacing MiniWeb-Wide
When you are in a MiniWeb window, you can find text anywhere in your MiniWeb 
and make global changes to the MiniWeb. (See page 10 if you do not yet have v1.1.)

To find and replace text:

1 Choose the Edit Find/Replace menu item.

2 Type the text you want to search for in the Find What field.

3 If you want to change that text, type the new text in the Replace With field.
You can also check one or more of the following Search Options:

Whole Words Finds only whole words that match the characters you type. 
The default is to match any characters, even parts of words.

Match Case Makes the match case-sensitive. The default is to ignore case.
Search Backward You can search backward through a single page. When you 

are searching through a MiniWeb, this field is dimmed, and all 
searches go forward.
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4 Use the buttons on the right to control the search.

You can search for text in a paragraph even if there are hidden HTML tags within the 
text. For example, you can find text even if a link starts within the text or if some words 
in the text are bold. However, you cannot search for HTML tags themselves in all the 
pages of the MiniWeb. When you view the HTML (see page 136), you can perform a 
Find/Replace on a single page of HTML, including the tags.

Printing Pages and MiniWebs
To manage a MiniWeb, you may need to create printed documentation about the 
MiniWeb. (See page 10 if you do not yet have v1.1.)

To print all the MiniWeb pages:

Move to the MiniWeb window and choose the File Print menu item. This will 
send all the pages in your MiniWeb to your current printer.

To print the current MiniWeb view:

1 Move to the MiniWeb window and display the MiniWeb in the format you want to 
print.

2 Choose the File Print Graphs menu item. This sends the view of your MiniWeb to 
your current printer.

Find Finds and selects the next match.
Close Closes the dialog.
Replace Replaces the selection with the text in the Replace With field.

Replace All Finds and replaces all the occurrences in the entire MiniWeb.
Wrap & Find Repeats the current Find operation, but starts at the beginning 

of the first page in the MiniWeb.
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Using SubWebs
Larger Web sites use several related directories instead of a single directory. This 
makes maintaining the Web site easier in some ways, because you can make the 
directory structure match the structure of your site. For example, you might store 
customer support pages in a “custsupp ” directory, sales pages in a “sales ” 
directory, and images in an “images ” directory.
You manage multi-directory Webs in GNNpress with “SubWebs”. Each subdirectory 
is its own SubWeb. A folder icon for each SubWeb is shown in the MiniWeb for the 
directory containing the SubWeb. (See page 10 if you do not yet have v1.1.)
In general, you use SubWebs the same as any other MiniWeb. For example, you can 
drag-and-drop files from one SubWeb to another SubWeb. The differences are the 
additional ways files in a SubWeb can interact with files in other SubWebs.

To create a SubWeb, either:

Use the Tools Webize menu item to create a main MiniWeb and SubWebs for all 
of your existing directories. See page 142 for details.
Display the MiniWeb that will contain the SubWeb, and choose the File New 
MiniWeb menu item or click the “New MiniWeb” icon in the MiniWeb toolbar. The 
new MiniWeb will be a SubWeb of the MiniWeb you were viewing.
Drag-and-drop a SubWeb icon into another MiniWeb window.
Create an empty MiniWeb. Then, choose the File Save As menu item to save the 
MiniWeb inside another MiniWeb. 
Import one MiniWeb into another MiniWeb.

To open a SubWeb, either:

Double-click on the SubWeb’s folder icon in the MiniWeb above the SubWeb in 
the directory tree.
Choose the File Open menu item.
Select the Open icon in the MiniWeb view.
Type the SubWeb’s URL in the Location field of a Page window.
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References Between SubWebs

It’s usually best to use relative links (see page 115) within your own Web site. Relative 
links allow you to move the entire directory tree to a new location (for example from 
your hard disk to the Web) without breaking your links. You should try to use absolute 
links only to references files outside your own Web.
A relative reference to a file in the same directory is simple—just use the filename and 
omit any information about the Web location and the directory. For example, use 
other.htm  instead of http://members.gnn.com/ netname/other.htm

You can also use relative links to reference files in different SubWebs within your site, 
but they are a little more complicated. Suppose you have a directory tree like this:

Relative references between files in these directories would have the following syntax:

Reference Between... Relative Link Format

“main” to “products” products/file.htm

“main” to “prod_a” products/prod_a/file.htm

“products” to “prod_a” prod_a/file.htm

“products” to “main” ../file.htm

“products” to “images” ../images/fig.gif

“prod_a” to “main” ../../file.html

“prod_a” to “images” ../../images/fig.gif

main

products images

prod_a prod_b
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99 Publishing Pages
on a Server

In This Chapter . . .
Publishing to the GNN Hosting Service 161
Publishing to Another GNNserver 163
Publishing to non-GNNservers 163
File Names and URLs 165

One of the most popular features of the GNN Hosting Service is the integrated ability 
to browse, edit, and publish pages. You can update pages and publish them at any time.
If you have questions about publishing with GNNpress, see the Frequently Asked 
Questions (FAQ) list at http://www.gnnhost.com/publish/faq/faq.htm .

Publishing to the GNN Hosting Service
Once you create a Web page, you can publish it to the GNN Hosting Service. Until you 
publish it, your page exists only on your disk. You can see your page; no one else can.

Publish your Web page to GNN Hosting Service:

1 Choose the File Save As menu item. This dialog appears. (For specific details on 
using such dialogs on PCs and Macintoshes, see page 40.)
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2 In the Page Location field, type the location of your GNN Hosting Service 

directory.
If you have Personal service, type http://members.gnn.com/ netname , 
where netname  is your own username for the GNN Hosting Service.
If you have Domain, Commercial, or Dedicated service, type the URL for the 
domain you use through the GNN Hosting Service.

3 If you want to add a directory, click the Create Dir button and use the dialog that 
opens to create a subdirectory under the directory for your username.

4 Move the cursor to the Page Location field and add a file name for the Web page to 
the end of the page location. A common convention is a name followed by .htm 
(for example, you might type joespage.htm).

5 Click the OK button to save the page. Saving the file across the network may take 
a few seconds.

You may be asked for your username and password. If so, type your GNN 
Hosting Service “netname” and password.
If an older version of the page is already stored on the server, you will be asked 
to confirm that you want to replace the file. You will also be asked whether you 
want to replace any image files that are already stored on your Web site.

Now your page is on the Web!
If you have questions about publishing with GNNpress, see the Frequently Asked 
Questions (FAQ) list at http://www.gnnhost.com/publish/faq/faq.htm .

Enter new
directory
name
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Publishing to Another GNNserver
If you do not have a GNN Hosting Service membership, you can sign up by following 
the instructions on http://gnn.com/gnn/join/index.html  or 
http://www.gnnhost.com/ .
If you want to set up your own Web server, you can download the GNNserver software 
for free from http://www.tools.gnn.com/index.html . The GNNserver is 
extendable with C and Tcl APIs that can access various types of databases. Full CGI 
support is also provided. Then, you can use GNNpress to publish to that server.

Publish your Web page to another GNNserver:

1 Choose the File Save As menu item.

2 In the Page Location field, choose the GNNserver where you want to publish your 
page (you must have write permission for the location where you want to publish).

If you have ever visited the GNNserver you are interested in, it shows up in the 
list you can see by clicking on arrow next to the Drives / MiniWebs / Sites field.
If this is a GNNserver you have not visited yet, then you can type its URL in 
the Page Location field at the top of the dialog. This GNNserver may be any 
server on the Internet where you have write permission. 

3 Click the OK button to save the page. Saving the file across the network may take 
a few seconds.

You may be asked for your username and password. If so, type your username 
and password for this GNNserver.
If an older version of the page is already stored on the server, you will be asked 
to confirm that you want to replace the file. You will also be asked whether you 
want to replace any image files that are already stored on your Web site.

Publishing to non-GNNservers
If you want to publish to a Web server other than the GNN Hosting Service or a 
GNNserver, you can save them directly if the Web server supports the HTTP 
(HyperText Transfer Protocol) PUT protocol. (For example, Cern’s httpd server 
supports the PUT protocol but disables it by default.)
Another way to save files to other types of servers is through FTP (File Transfer 
Protocol). If you can use FTP to move files directly to the page directories on your Web 
server, you can use FTP from within GNNpress to save your pages. 
If you do not have access through an FTP server to your Web page directories, you will 
need to transfer the files with software other than GNNpress. For example, you can use 
terminal emulation software to log into the Web server and transfer the files.
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To save pages with FTP:

1 Choose the File Save As menu item.

2 In the Page Location field, type:

ftp://username@your.ftp.site/path/filename.htm

“username” should be the name you use to log into the FTP server.
“your.ftp.site” should be the name of your ftp server (such as 
ftp.mydomain.com ).
“path” should be the directory path to your file. Use the full directory path from 
the perspective of the FTP server. If you do not know the full directory path, 
use FTP software to move to the directory where you want to save pages. Then, 
use the “pwd” command to see your current working directory.
“filename.htm” should be the name of your Web page.

For example, suppose you want to save a page called mypage.htm  to the 
/users/myname/public_html  directory on ftp.domain.com . You would 
type the following in the Page Location field:

ftp://myname@ftp.domain.com/users/myname/public_html/mypage.htm

3 Click the OK button to save the page. Saving the file across the network may take 
a few seconds.

You may be asked for your username and password. If so, type your GNN 
Hosting Service “netname” and password.
If an older version of the page is already stored on the server, you will be asked 
to confirm that you want to replace the file. You will also be asked whether you 
want to replace any image files that are already stored on your Web site.

4 To make this process easier, you can add your FTP location to the list of sites you 
commonly save to, by following these steps: 

Choose the Tools Preferences Sites menu item. 
In the Site Location field, type the ftp location you used above (without the file-
name for your page). For the example in step 2 above, you would type:

ftp://myname@ftp.domain.com/users/myname/public_html/

Click the Add button, then click the Done button. Your FTP site will now be 
listed in the Drives/MiniWebs/Sites list in the Save As dialog.
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File Names and URLs
File names have different restrictions depending on the type of computer you are using. 
It is important to understand these distinctions before creating and publishing your 
Web information, because you want your documents to be as portable between 
platforms as possible. If you are working with more than one platform, naming your 
files is very important. The customs and restrictions are as follows:

MS Windows
File names in DOS and Microsoft Windows can be no longer than eight characters, and 
must be at least one character. They may end with an extension of up to three 
characters (for example, .htm instead of .html). File names are not case-sensitive. 
URLs are case-sensitive; only letters, numbers, and underscores are allowed.
Note that GNNpress requires you to use these “8.3” filenames even if you are using 
Windows 95, which allows longer filenames.

Macintosh
File names can have up to 31 characters, although you should not make your file names 
this long since that makes your document difficult to use between platforms. File 
names are not case-sensitive, but case is retained. Extensions are not required, but you 
should use .htm or .html to make it easy to move the files to the server.
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The Preferences windows let you control various aspects of the behavior of GNNpress. 
To see a list of the Preferences windows, choose the Tools Preferences menu item.
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General Preferences
Choose the Tools Preferences General menu item to bring up the General 
Preferences dialog. You use this dialog to control general browsing and editing 
behaviors of GNNpress.

Load Remote Images
If you turn off Load Remote Images, images that are not stored on your local file system 
are not loaded unless you click on them. This speeds up page loading, especially if you 
are browsing pages with lots of large images or if you are using a fairly slow modem.

Unix Style Delete
Under Microsoft Windows, the Delete key normally deletes the next character and the 
Backspace key deletes the previous character. On most Unix and Macintosh systems, 
both keys delete the previous character.
Setting Unix Style Delete causes both the Delete and Backspace keys to delete the 
previous character. Not setting this field causes the Delete key to delete the next 
character. Pressing CTRL+D always deletes the next character.

Edit Complex Lists
The Edit Complex Lists check box controls whether pasting text with multiple 
paragraphs into a list will add multiple paragraphs to a single list item (check this box) 
or will add multiple list items (uncheck this box). (See page 10 if you do not have v1.1.)
This check box also controls what happens if you format a set of list items as a nested 
list. If this box is checked, a new list item is added to the outer list for the nested list. 
If this box is unchecked, the nested list is added within the current list item.
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Prefetch Pages

If you turn on Prefetch Pages, GNNpress preloads pages to which the current page has 
links (so that when you click on one of these links it will already be loaded into your 
computer’s memory cache).

Short Menus
Checking Short Menus makes the menus simpler and shorter. The short menus omit 
menu items for creating and administering MiniWebs, creating forms, creating style 
sheets, and setting preferences other than those in the General Preferences dialog.
By default, previous versions of GNNpress used “Short Menus” mode, which hides 
access to a number of advanced features. These features include MiniWebs, Style 
Sheets, and various dialogs for setting preferences. If these features are not visible in 
your version of GNNpress, uncheck the “Short Menus” item and click OK. When you 
use the longer menus, you will see some menus items for administering your Web site 
that are supported only if you have the Commercial or Dedicated level of GNN 
Hosting Service.

MiniWeb File Type
Use this option to restrict the file names you can use when you create pages and 
MiniWebs on a GNNserver. It is best to choose “DOS” if you need your files to be 
portable to a PC (even if you are using Windows 95 or Windows NT).

• If you choose DOS, you are restricted to the eight-dot-three file name format.

• If you choose Macintosh, you can use file names with up to 31 characters.

• If you choose Posix, most Unix systems allow you to use 256-character file names.

Text Edit Spacing
By default, HTML displays multiple white-space characters (spaces, tabs, etc.) as a 
single space (except in “Preformatted” paragraphs). If One is selected in the Text Edit 
Spacing field, you can only type one space in a row.
GNNpress provides a way for you to type multiple spaces by using special “non-
breaking space characters.” When you type multiple spaces, spaces other than the first 
one are actually non-breaking spaces. Non-breaking spaces keep browsers from 
condensing spaces into one space. You can turn on this capability by selecting the 
“Non-breaking” option in the Text Edit Spacing field. However, some browsers will 
show “&nbsp;” instead of spaces if you do this.
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Conform To
This field lets you choose whether you want GNNpress to create and display HTML 
code using the Netscape conventions or HTML 3.0. If most of your readers will be using 
Netscape to browse your pages, you should conform to Netscape conventions. 
Otherwise, HTML 3.0 may be a better choice. (See page 10 if you do not yet have 
v1.1.) The GNNworks browser supports both Netscape and HTML 3.0.
Changing the Conform To field doesn’t affect how other browsers display your page. 
You may want to explicitly set features where the default varies to make all browsers 
use the same setting. Changing this setting affects the following areas:

Startup View
This field controls which page is displayed first when you start GNNpress (with no 
command-line arguments). (See page 10 if you do not yet have v1.1.) You can choose 
any of the following:

• Home Page: Start with the page specified in the Home Page field. Use an absolute 
(complete) reference to the page you want. If you specify only a file name, 
GNNpress looks for the file in its help directory on your local disk first and then it 
looks in the http://www.gnnhost.com/GNNpress11/press.htm  directory.

• Blank Page: Start with no page open.

• MiniWeb: Start with a new MiniWeb and a blank page.

Feature Netscape HTML 3.0

Tag to create link anchors <A NAME> <A ID>

Tags for font size changes <FONT SIZE=#> <BIG>, <SMALL>

Table width default unit Pixels “En”s

Default alignment of tables Left Center

Default vertical alignment of table cells Middle Top

Does “>” terminate attributes in tags? Yes No

Can pages have multiple <TITLE> s and <BODY> s? Yes No
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Network
Click the menu Tools Preferences Network to bring up the Network Preferences 
dialog. You use this dialog to control how GNNpress interacts with your network. 
If you use the same modem connection for both GNNpress and GNNworks, you do not 
need to set any of the fields in the Network Preferences dialog. You may want to set 
your mail address so that people can reply to email you send from within GNNpress.
If GNNpress does not allow you to browse the Web, you may need to ask your system 
administrator how to set some of these fields.

Mail Address
Type your email address in the Mail Address field. The email address you provide is 
used as a return address for mail you send from GNNpress, as a password when you 
download files with anonymous ftp, and as an identification line on all HTTP requests.

SMTP Mail Host
Type the name of the SMTP (Simple Mail Transfer Protocol) mail host machine. This 
is a machine that takes care of putting email from your internal mail system into an 
accepted Internet format. 
Most systems do not require you to specify the SMTP Mail Host. If you do not know 
whether your system uses SMTP or the name of the SMTP mail host, ask your system 
administrator.

Name Server
A name server interprets Web page addresses, and finds the addresses that correspond 
to the addresses.
Most systems do not require you to specify the Name Server. If you do not know 
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whether you need to specify a name server, ask your system administrator. If you do 
need to specify a name server, type the IP address of the name server in these fields.

Proxy
GNNpress does not handle news, gopher, or WAIS requests directly. If you are 
browsing these kinds of links you have to specify a Proxy server. When GNNpress 
finds an access method it does not understand it sends it to the specified proxy server, 
which handles the request. For example, you may use a CERN httpd server, with a 
name in the form hostname:port  (for example, www.mycompany.com:81 ). Do not 
type the leading http:// .
If your site is behind a firewall, then you even need to proxy http (Web page) requests 
through that machine, so click the Always Proxy check box. However, you will not want 
to proxy domains inside your firewall, so list them in the “except these domains” field. 
If you use another server to proxy all http requests, you may not be able to browse 
directories on a GNNserver or publish your pages to a GNNserver, depending on the 
configuration of the proxy server you use.
If you are not behind a firewall, do not check the Always Proxy box. You only want to 
proxy non-http requests.

SOCKS Host
If your system uses the SOCKS protocol for firewall security, you should type the 
name of the SOCKS host in this field. You can allow pages stored on trusted domains 
(such as the domains on your side of the firewall) to skip the SOCKS checking by 
typing those domain names in the field provided. 

File Extensions and MIME
When GNNpress loads a local file it attempts to handle it by looking at the extension 
on the file name, from which it can generate a MIME type. Then, it uses the MIME 
type and the external viewer you specify in the MIME Viewers preferences dialog to 
find out how to display the file. (See page 10 if you do not yet have v1.1.)
(MIME stands for “Multipurpose Internet Mail Extensions.” This standard identifies 
files sent across the Internet so the program that receives it can deal with it correctly.)
GNNworks comes with a number of MIME extensions and external viewers. You can 
use GNNworks to view files that need external viewers.
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To modify the list of file extensions:

1 Choose the Tools Preferences Extensions/MIME menu item. You will see the 
Extensions/MIME Preferences dialog.

2 Select a file extension from the scrolling list.
To add an extension: Type a new file extension and a new MIME type. Then 
click Add. The new entry will be added before the selected entry. For example, 
you can add a file extension of .doc  with a MIME type of applica-
tion/msword  to indicate that the files are Microsoft Word files. (You will also 
need to select winword.exe  as the external viewer for this MIME type in order 
to have GNNpress open Microsoft Word automatically. See page 174 for 
details.)
Or, you may want to add an entry with an additional file extension for a MIME 
type that is already listed.
To change an extension: Change the file extension or the MIME type and click 
Change.
To delete an extension: Select an entry and click Delete.

Currently 

file extension
selected

MIME type
for this
file extension
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MIME Viewers
When you follow a link to a file that GNNpress does not know how to display (for 
example, a video), GNNpress looks through the list of MIME viewers for a program 
to run to display the file. If there is no entry for the MIME type, GNNpress asks if you 
want to save the file on your local system.
GNNworks comes with a number of MIME extensions and external viewers. You can 
use GNNworks to view files that need external viewers.

To add a MIME viewer:

1 Choose the Tools Preferences MIME/Viewer menu item. You will see the 
MIME/Viewer Preferences dialog.

2 Type a MIME type. For example, you might type application/msword , which 
is the MIME type for Microsoft Word documents.

3 Type the file location of the viewer for these files in the External Viewer field. Or, 
you can click Browse to search for the file. For example, the location of the viewer 
for Microsoft Word files might be C:\MSOFFICE\WINWORD\WINWORD.EXE .

4 Click Add to save your new entry. (If the Add button is gray, type an extra space in 
the External Viewer field.)

5 To change a viewer, select the MIME Type, modify the viewer name, and click 
Change.

For a list of common MIME types, choose the Tools Preferences Extensions/MIME 
menu item. (The file extensions are used only when you load local files. For remote 
files, the MIME type of the file is used directly.)

Currently 

MIME type
selected

Location of
external viewer
for this
MIME type
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These are some additional MIME types you might want to view:

application/commonground
application/macwriteii
application/msword
application/zip
application/x-framemaker
application/x-tcl
application/x-wais-source
text/tab-separated-values

MiniWeb Icons
If you have files with additional MIME types in your MiniWebs, you may add special 
icons for these file types. These icons will be shown when you display the MiniWeb 
in the Web or Tree view.

To select an icon for a MIME type:

1 Choose the Tools Preferences MiniWeb Icons menu item. You will see the 
MiniWeb Icon Preferences dialog.

2 Type a MIME type. For example, you might type application/msword , which 
is the MIME type for Microsoft Word documents.

3 Type icon file’ location in the Icon Location field. Or, click Browse to search for the 
file. You can use gif, jpeg, or xbm file containing a 32x32 pixel image.

4 Click Add to save your new entry. (If the Add button is gray, type an extra space in 
the Icon Location field.)

5 To change an icon, select a MIME Type, change its icon location, and click Change.

Currently 

MIME type
selected

Location of
icon for this
MIME type
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Sites
This dialog lets you store a list of directories on your local drives and server sites on 
which you can save pages. GNNpress uses this list in various places. For example, the 
list in this dialog appears in the Drives/MiniWebs/Sites field in the File Open dialog.
The list can contain more than GNNserver locations. You can add any directory on you 
local drives, any directory on a server on which you publish pages, or any MiniWeb to 
this list.

To add a new server or directory location:

1 Choose the Tools Preferences Sites menu item. You will see the following pref-
erences dialog.

2 Type the URL or location you want to add in the Site Location field.
You can add your GNN Hosting Service directory, other GNNserver directories, 
local drives and directories, MiniWeb locations, and FTP paths to this list. You can 
also add directory URLs on any server that supports and enables the HTTP (Hyper-
text Transfer Protocol) PUT protocol, as GNNserver does.

3 Click Add. The location you added will now be listed when you are prompted for a 
drive, MiniWeb, or site location.

Animation
You can change the animation in the upper-right corner of a window when a page is 
being loaded. In the future, the GNNpress Web site — 
http://www.tools.gnn.com/ — may contain additional animation files for you to 
download. GNNpress will prompt you to save the file and then ask if you want to use 
the file as the default animation. 



Setting Preferences
Configure Toolbar

Do-It-Yourself Authoring and Publishing for the World Wide Web 177

10

Configure Toolbar
You can add or remove icons from the GNNpress toolbar so that the commands you 
use most often are easy to select. (See page 10 if you do not yet have v1.1.)

To change the set of toolbar icons:

1 Choose Tools Preferences Configure Toolbar. You will see this dialog.

2 Hold down the Ctrl key, which lets you select multiple items that are not sequential.
3 While you hold down the Ctrl key, click on unselected items you want to add to the 

toolbar. Also, click on selected items you want to remove from the toolbar. Select 
the “-----” items in places where you want a wider space between buttons.

4 Click OK when you have selected the toolbar buttons you want.
Another way to configure the toolbar is to add <LINK REL=>  tags to your pages. This 
tag adds buttons to your toolbar when the page is viewed and is part of the HTML 3.0 
specification. However, this tag is still not supported by many browsers. GNNpress 
supports toolbar modification by the <LINK REL=>  tag. See page 137 for details.
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By default, previous versions of GNNpress used “Short Menus” mode, which hides 
access to a number of advanced features. These features include MiniWebs, Style 
Sheets, and various dialogs for setting preferences. 
If these features are not visible in your version of GNNpress, choose the 
Tools Preferences menu item. In the General Preferences dialog, uncheck the “Short 
Menus” item. Then, click OK. 
When you use the longer menus, you will see a few menus items for administering your 
Web site that are supported only if you have the Commercial or Dedicated level of 
GNN Hosting Service.
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Page Window Menus
The sections that follow give you a quick list and description of all the menu items you 
see when you are using a Page window.

File Menu
You use the File menu to operate on pages either locally or remotely over the network.

(Short menus)

New MiniWeb Creates a new MiniWeb.
New Page Creates a new, empty page window.
Open Lets you browse (locally or remotely) for files or specify the 

URL directly. You may also choose how to use the file (for 
example, you can open an HTML page as a Text page and see 
the tags).

Close Closes the current page. Prompts if you have unsaved changes.
Save Saves the current page.
Save As Lets you save the page locally or on the network. You can 

choose formats and other options.
Import Lets you import a text file or image into the current page.

Copy File Lets you copy a file from anywhere locally or on the network 
to anywhere else.
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Edit Menu
You use the Edit menu to modify your pages.

Delete Lets you browse for files and delete them.
Print Setup Lets you choose a printer and its settings.
Print Lets you send the current page to a printer.

Upgrade GNNpress Opens a page of information about downloading the latest 
version of GNNpress.

Exit Exits GNNpress. Prompts if you have unsaved changes.

Undo Undoes the last edit (some operations, like Insert File may not 
be undone). There is no limit to the number of Undos.

Redo Reverses the last Undo.
Cut Saves selection to the clipboard and deletes it from the page.
Copy Saves the selection to the clipboard.
Paste Transfers the contents of the clipboard to the current page, 

either at the current insertion point or in place of the selection. 
If the clipboard contains a URL from a Copy URL command, 
acts like the Paste URL command.

Clear Deletes the selection without saving it.
Select All Selects the entire page.
Copy URL of Page Saves the URL of the current page (or if the selection contains 

a link then the URL in the link) into the clipboard in such a way 
that pasting it yields a link.
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Element Menu
You use the Element menu to add special features to your page.

Paste URL Equivalent to Paste, except the URL is pasted and the selection 
(if there is one) becomes the anchor to a hyperlink. If there is 
no selection, then the URL is added as text for the new anchor.

Find/Replace Invokes the Find/Replace dialog. This provides several options 
for finding and replacing text.

Find Next Repeats the last Find without presenting a dialog.

Get Attribute Allows you to set various attributes for the selection (for 
example, if you select a link, you see the Link dialog).

Horizontal Rule Adds a horizontal line at the insertion point.
Forced Line Break Forces a line break at the insertion point.
Link Lets you attach a link to the current selection. If the selection 

already contains a link, lets you alter or remove the link.
Anchor Lets you attach a name to a point in the page. You can use this 

name in links that move to this point in a page.
Image Lets you insert an image into the page and align text with it.
Image Map Lets you make the selected image into a clickable image with 

multiple links.
Unlink Removes the currently selected link.
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Format Menu
The Format menu adds structure and modifies the appearance of your page.

(Short menus)

Exit Format Creates a new paragraph outside the current format item (for 
example, list, form, heading, preformatted paragraph, etc.) and 
puts the cursor there.

Remove Format Removes the current formatting. If the cursor is in a list, 
heading, ... it undoes the formatting of the entire list, heading, 
etc.

Type Style > A submenu lets you emphasize text in various ways.
Heading > A submenu lets you use one of six levels of headings.
Paragraph > A submenu lets you create one of several types of paragraphs. 

It also lets you align text horizontally.
List > A submenu lets you create one of three types of lists—

Numbered, Unnumbered, Definition. It also lets you reverse 
terms and definitions in a Definition list.

Form Inserts a form and prompts you for the URL of a script on your 
server that runs when the form is submitted.

Show Borders Draws a border around forms and lists so you can see where 
they end. When the borders are shown, this command changes 
to Hide Borders.

Body Attributes Lets you change the background and text colors of your page.
Style Sheet Lets you change the way HTML elements are displayed.
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Table Menu
The Table menu lets you create and format tables in your pages.

Tools Menu
The Tools menu lets you show information about your page and customize the 
behavior of GNNpress

Create Table Lets you create a table and specify the number of rows and 
columns and set the spacing and border width.

Alter Table Lets you modify the number of rows and columns and the 
spacing and border width.

Split Cell Lets you split a cell that has been merged.
Merge Cell Lets you merge several cells into a single cell.
Normal Cell Turns a header cell into a normal cell.
Header Cell Turns a normal cell into a header cell.
V Align Row Aligns contents of an entire row to the top, middle, or bottom.
V Align Cell Aligns the contents of one cell to the top, middle, or bottom.

(Short menus)
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Browse Menu
The Browse menu lets you find and display new or old pages.

Show HTML Lets you view and edit the HTML tags for the current page.
Check Links Checks to make sure all URLs referenced by the page exist.
Preferences > Lets you set preferences for a variety of GNNpress behaviors. 
AutoLinks Searches the server you choose and finds other pages that are 

related to the current page and suggests links to them.
Search Server Opens a page listing all the tables on the server with links for 

searching each table. (Not supported unless you have the 
Commercial or Dedicated level of GNN Hosting Service or 
your own GNNserver. See the GNNserver documentation.)

Administer Server Opens a page with links to the server administration functions. 
(Not supported unless you have the Commercial or Dedicated 
level of GNN Hosting Service or your own GNNserver. See the 
GNNserver documentation.)

Administer Page > Lets you set various options for a page on the server. (Not 
supported unless you have the Commercial or Dedicated level 
of GNN Hosting Service or your own GNNserver. See the 
GNNserver documentation.)

Backward As you follow hyperlinks in the Web, a history of pages is 
stored. This item lets you backtrack through the history.

Forward Moves forward through the page history after you backtrack.
Stop Aborts any outstanding requests from this window to read files.
Reload Page Reloads the current page (and all images in it) from the Web.
Global History Lists all pages you have viewed in this session in any window. 

You can view one by double-clicking on it.
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Window Menu
The Window menu appears under Microsoft Windows only. It lets you arrange the 
Page and MiniWeb windows in your workspace.

Help Menu
The Help menu provides a variety of ways to get more information on GNNpress.

Hot List Shows the list of pages you have added to this list. You can 
view one by double-clicking on it or pressing Fetch.

Add to Hot List Adds the current page’s URL to the Hot List.

Tile Arranges your windows side-by-side or bottom-to-top.
Cascade Arranges your windows so they overlap and titles are visible.
Arrange Icons Arranges icons of minimized Page and MiniWeb windows.

Contents Shows the table of contents for the GNNpress documentation 
with links to each section.

Search for Help Lets you search for keywords in the documentation.

Templates Provides templates for pages and MiniWebs.
FAQ Answers Frequently Asked Questions
Tech Support Shows email addresses and telephone numbers for technical 

support. The mail link lets you send us an email message. 
About GNNpress Shows the version number of your copy of GNNpress.
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MiniWeb Window Menus
The sections that follow give you a quick list and description of all the menu items you 
see when you are using a MiniWeb window.

File Menu
The File pull-down menu lets you operate on MiniWebs and pages locally or remotely 
over the network. It is identical to the File menu in the Page window, except it also 
contains a Print Graph item. 

Close Closes the MiniWeb window. Prompts you to save any 
unsaved pages.

Save Saves the MiniWeb.
Save As Lets you save the MiniWeb either locally or on the network. 

Lets you choose formats and various options.
Import Lets you import a file into the current MiniWeb. You can also 

import the images in the page along with the page.
Print Prints all the pages in the current MiniWeb.

Print Graph Prints the current MiniWeb view to the selected printer.
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Edit Menu
The Edit menu lets you modify your MiniWeb. It is similar to the Edit menu in the Page 
window, except it does not have the Undo, Redo, and Select All items. It contains 
additional items to Find Page and Set Stationery.

Cut Saves the selected page or other file to the clipboard and deletes 
it from the MiniWeb.

Copy Saves the selected page or file to the clipboard.
Paste Transfers the contents of the clipboard to the current MiniWeb. 

You can paste from a MiniWeb to a Page window, but you 
can’t paste from a Page window to a MiniWeb.

Clear Removes the selected page from the MiniWeb. If there are still 
links to that page it is shown in faint gray. The icon cannot be 
removed until all links have been broken.

Copy URL of 
MiniWeb/Page

If nothing is selected, copies the URL of the MiniWeb into the 
clipboard. Otherwise it copies the URL of the selected page.

Paste URL Equivalent to Paste.

Find/Replace Lets you find text in any page in the MiniWeb.
Find Next Finds the next occurrence of the text in any MiniWeb page.

Find Page Lets you select a page in the MiniWeb by typing its file name.
Set Stationery Sets the currently selected Page as a “stationery” file for this 

MiniWeb. When a new page is created, the stationery page is 
used to initialize it.
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View Menu
The View menu helps you manage the appearance of the MiniWeb.

Clean Up Realigns all items in the MiniWeb view.
Display Control Lets you hide various types of files in the MiniWeb view.
Web Displays the MiniWeb as a graphical web.
Tree Displays the MiniWeb as a graphical tree.
Name Displays the MiniWeb as list sorted by file name.
Title Displays the MiniWeb as list sorted by page title.
MIME Type Displays the MiniWeb as list sorted by type of file.
Zoom In Makes the MiniWeb icons larger and shows a smaller area.
Zoom Out Makes the icons smaller and shows a larger area.
Normal Goes back to the default icon size.
List Links To Shows links to each file if checked.
List Links From Shows links from each file to other files if checked.
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Tools Menu
The Tools menu in the MiniWeb window does not contain the Show HTML, AutoLinks, 
and Administer Page items from the Page window. Additional items in the MiniWeb 
version of this menu are: Webize and Administer MiniWeb. 

Browse Menu
The Browse menu in the MiniWeb window is a subset of the Browse menu in the Page 
window. It has only the Global History, and Hot List menu items.

Window Menu
The Window menu in the MiniWeb window is identical to the Window menu in the 
Page window.

Help Menu
The Help menu in the MiniWeb window is identical to the Help menu in the Page 
window.

Webize Lets you turn existing directories into MiniWebs.
Check Links Runs through the links in all the pages in the MiniWeb and 

checks to make sure the URLs they reference exist.
Administer MiniWeb Lets you set the Pricing, Permissions, and Describe options for 

a MiniWeb stored on a server.(Not supported unless you have 
the Commercial or Dedicated level of GNN Hosting Service or 
your own GNNserver. See the GNNserver documentation.)
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Using the Mouse
Select text with the mouse:

To set the insertion point, click the mouse.
To set the insertion point in a link, use CTRL+click to avoid following the link 
(hold the CTRL button down and click the mouse).
To select a block of text, hold the mouse button down and sweep over the letters or 
words that you want to select.
To extend any selection to the current mouse position, SHIFT+click (hold the 
SHIFT button down and click the mouse). Or, click with the right mouse button.
To select a single word, double-click anywhere on the word.
To select a word that is a hyperlink, hold down the CTRL key. CTRL+double-click 
selects a single word. CTRL+triple-click selects the whole hyperlink. Clicking on 
the hyperlink without pressing CTRL accesses the URL that the link refers to.
To select a whole paragraph, triple-click anywhere in the paragraph.
To select the whole page, quadruple-click anywhere in the page.
Click in the margin to select parts of a page:

single-click selects a line
double-click selects a paragraph
triple-click selects a page

Use the mouse for other miscellaneous tasks:
As you move the mouse, the status bar shows the link destinations you move over.
If you click on a link, the link is loaded into the current window. If you double-click 
on a link, it is loaded into a new window.
If you hold down the mouse button on a link and drag the pointer into another 
GNNpress page window and then release, then that window follows the link.
If you depress the mouse on a link and drag the pointer into a MiniWeb window, 
that page being linked to is inserted into the MiniWeb.
If you depress the mouse on a link and drag the pointer out of any GNNpress 
window, then a new window is created to follow the link.
If you hold down the right mouse button (on the Macintosh, hold the command key 
down and press the button) on a link and drag the cursor to another window, a link 
is made to the URL of the original link. The link is inserted where you release the 
mouse. If you release the mouse on top of a selection, the selection is bound to the 
link, otherwise the title of the page is inserted and used as the link.
If you click on the icon of an image that has not been loaded (either because you 
clicked the Stop icon, or because image loading is turned off) then it is loaded.
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BBWhat’s New in V1.1?

In This Chapter . . .
Use Tables and Other New Formats 193
Edit HTML Directly 194
MiniWeb Enhancements 194
Customize the Toolbar 195
Use GNNpress from Inside a Firewall 195

Use Tables and Other New Formats
You can create and display pages that use the latest extensions to the tag language for 
creating Web pages (HyperText Markup Language — HTML) in a What-You-See-Is-
What-You-Get (WYSIWYG) authoring environment. These are some of the 
extensions and HTML 3.0 features supported in GNNpress v1.1:

• Table Support: GNNpress v1.1 lets you create tables interactively. The new 
“Table” menu lets you create and modify tables and table cells. Though you edit 
tables as you would in a word processor, GNNpress automatically creates the 
complex HTML 3.0 tags for the tables. In addition, several enhancements to tables 
are supported. GNNpress v1.1 supports table, row, cell, and caption alignment; 
border sizing, cell spacing, cell padding, and more. (See "Tables" on page 98 for 
details.)

• Image and Text Alignment: You can wrap text around images to the left or right. 
(See "As an Element" on page 88 for details.) Also, you can justify text to the left, 
right, center, or both left and right. (See "Changing Paragraph Alignment" on page 
78 for details.)

• New Text Formats: You can mark text as inserted text (shown with change bars 
by GNNpress) or deleted text (shown as strike-out text). You can also change the 
font size of any text on a page. (See "Character Styles" on page 75 for details.)

• Page Body Attributes: You can set the colors of the page background, text, links, 
and visited links in a dialog that allows you to pick color using a standard color 
picker. And, you can select an image file to be the background image for a page. 
(See "Setting Colors and Background Images" on page 94 for details.)
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Edit HTML Directly
Despite the WYSIWYG authoring capabilities of GNNpress, some people like to edit 
HTML code directly. GNNpress v1.1 provides support for direct editing of HTML. For 
example, you can use the HTML editing window to add any tags or extensions for 
which GNNpress does not provide authoring support directly. (See "Editing the 
HTML" on page 136 for details.)
When you save the HTML code, GNNpress automatically parses code and displays 
your changes in the browser window. Any errors, such as missing tags, are reported to 
you. In addition, the standard editing capabilities (Cut, Copy, Paste, Find/Replace, and 
Save As) are provided for HTML editing.

MiniWeb Enhancements
A number of enhancements in GNNpress v1.1 make MiniWebs even more useful:

• In addition to viewing a MiniWeb as a graphical “web” with color-coded links, you 
can customize the MiniWeb view in the following ways (See "Selecting a 
MiniWeb View" on page 146 for details.):
• View as a graphical tree structure with the home page for the MiniWeb on the 

left and layers of linked files cascading to the right.
• Sort by file name, title, or file type. Links to and from each file are listed after 

each file. You can choose to see links to files, links from files, both types of 
links, or neither type.

• You can choose which types of files you want to display in any type of MiniWeb 
view. For example, you can limit the view to HTML files, sub-web files, and 
audio files -- hiding image files and other file types. (See "Focusing the View" 
on page 148 for details.)

• You can create hierarchical MiniWeb structures. That is, a MiniWeb can contain 
nested SubWebs with relative links to other MiniWebs. You can double-click on a 
SubWeb to open it. You can copy and paste or drag and drop SubWebs from one 
location to another. When you save a MiniWeb, you can automatically save the 
contents of all its SubWebs. (See "Using SubWebs" on page 158 for details.)
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• You can control whether links between files are saved as relative links (for 
example, <A HREF=“../../Images/logo.gif”> ) or as absolute references 
(for example, <A HREF=“http://www.mycom.com/Images/logo.gif”> ). 
When you add links or images to Web pages, the dialog contains a button that auto-
matically toggles between a relative link and an absolute link to the file you select. 
(See "Links" on page 115 for details.)

• The “Webize” command examines the files in subdirectories and automatically 
creates SubWebs. (See "Webizing Existing Directories" on page 142 for details.)

• You can use the “Check Links” command on an entire MiniWeb. Also, if you 
rename a file in a MiniWeb, all the links to that file in that MiniWeb are automat-
ically changed. (See "Creating Links Using MiniWebs" on page 155 for details.)

• You can perform a global find/replace on the files in a MiniWeb. (See "Finding and 
Replacing MiniWeb-Wide" on page 156 for details.)

• You can print the graphical MiniWeb view or print all the pages in a MiniWeb. 
(See "Printing Pages and MiniWebs" on page 157 for details.)

Customize the Toolbar
You can choose which menu commands you want to include in the GNNpress toolbar. 
For example, if you create lots of numbered lists, add the numbered list button to the 
toolbar so that you can quickly format your pages. (See "Configure Toolbar" on page 
177 for details.)
GNNpress v1.1 also allows pages to add toolbar buttons on the fly using  the HTML 
3.0 <LINK REL....> tag. For example, your page can add toolbar buttons that link to a 
home page, table of contents, index, glossary, copyright page, next page, previous 
page, help page, higher level page, or a bookmark in the document. (See "Additional 
HTML 3.0 Tags Supported" on page 137 for details.)

Use GNNpress from Inside a Firewall
GNNpress v1.1 supports the SOCKS protocol. This protocol allows you to use 
GNNpress from behind a firewall without compromising the security provided by the 
firewall. (See "SOCKS Host" on page 172 for details.)
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ABBREV tag 137
Absolutize button 89, 95, 117
ACRONYM tag 137
Address

email 171
in page 79

Align
image 89
paragraph 78
style sheet 131
table cells 101

alter table 100
Anchor 56, 116

add to an URL 124
append name 124
check anchor names or remove 118
creating 117
using in link 116
view locations within a page 56

Append
anchor name 116, 124

Apply 77–79
Arrows in MiniWebs 148
Art

clip art 90
Assumptions about users 7

GNNserver 8
Attributes, body 94
AU tag 137
Authoring

and browsing 31, 65
creating page 22
example 22
local vs. remote 32
publishing example 28

AutoLinks 125

B
Background color 94
Background image 95
Background on

browsing 17
home pages 18
HTML 18
MiniWebs 18
publishing 18
URLs 18
web client 18
web pages 17
web server 17
Web site 18

Backspace vs. Delete 168
Backward button 55
Bigger font 75
Block quotes 79
Body attributes 94
Border

lists 86
show/hide 86, 99
table 99

Browse 49, 51
add to hot list 58
backward and forward 55
files or a server 125
global history 57
hot list 57–58
reload page 56
stop 53, 56

Browse menu
MiniWeb window 190
Page window 185

Browser
comparison with others 31
non-graphic 62
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Browsing 49

Backward and Forward 55
Directory Services 51
double-click = additional window 55
enter a URL 52
external viewers 59
Follow Hyperlinks 53
global history 57
history 57
Hot list 58

add or open a page 58
delete entire list 58
dialog box buttons 59

load images 60
Location field 52
MiniWeb 150
Navigate 50
open a URL 50
preferences 60
pre-fetch pages 60
Reload Page 56
Sequential 55
speed 60
Stop 56
stop download 53, 56
Surf the Web 19, 51
The Web 49
Unsuccessful Openings 54
window history 57

Bulleted lists 64
Button

backward 55
forward 55
in Link dialog 117
radio 107
reset 113
stop 53, 56
submit 113

C
Caption, for table 99
Cell 98

header 100
merging 102
normal 100
padding 100
spacing 100
splitting 102

Center
table 101
text 78

CGI
forms 106

Change bars 76
Character styles 75

apply and remove 77
formatted 75
logical 76

Check Box 108
Check links 123

abort 124
close dialog 124
continue 124

Choose
text, see select text 191

Client-server features 32, 40
Clip art 90
Clone a page 54
Close

check links dialog 124
modal dialog box 38
the Hot List Window 59
the HTML window 136

Color
changing 94
default 95
MiniWeb meanings 37
RGB values 95
style sheet 131–132
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Color coding, in MiniWebs 148
Columns, table 99
Contents

online help 39
Conventions

file names 42
hyperlink 51, 53, 55, 73, 116–118, 122
menu items 9
MiniWeb files 42
typographical 9
URLs 42

Convert
files to MiniWeb 142

Copy 72
and paste 118
and paste a URL 72, 118
file 65, 151
images from another page 90
text 72
text from another page 72
URL 72–73, 118

toolbar 72–73, 118
URL from Web page 118

Copy-and-paste 32, 152, 155
Copy-and-paste URL

page into MiniWeb 152, 155
Couldn’t find page message 54
Couldn’t find server message 54
Counting visits to page 92
Cursor

positioning with mouse 191
Customer support 3, 40, 141, 145
Customizable Toolbar 195

D
Database

forms 106
Delete vs. Backspace 168
Deleted text 76

deleting file
miniweb 154

Design guidelines 62
headings 62
HTML limitations 63
images 62
navigation 63
non-graphic browsers 62

Dialog
modal 38

Directories
converting to MiniWeb 143
references between 159
selecting 40

Directory services 51
Browsing 51
Global Network Navigator 20–21, 51–52
Infoseek 51
Lycos 51
WebCrawler 51
Yahoo 51

DNS, see Domain name server 171
Document structure 63
Domain name server 171
Double-click on icons, in MiniWebs 150
Download

animation 52
icons 52
speed 60
stop 53, 56

Drag-and-drop 31–32, 69, 74, 86, 88
in MiniWebs 152, 155

Drives
customizing list 176

Drives / MiniWebs / Sites field 40
customizing 176

E
Edit
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and format Hot list 59
Complex Lists 168
copy 72
copy/paste URLs 72
cut 69
example page 22
find/replace text 71, 156
Miniweb

find page 149
set stationery 151

page 22
paste 69
redo 42
text 69
undo 77, 85

Edit menu 188
MiniWeb window 188
Page window 181

Editable HTML 194
Element

anchor 56, 116
forced line breaks 74
get attribute 91
horizontal rules 74
image 62, 89
image map 119
links 115
unlink 122

Element menu 182
Email address 171
Email links 119
Empty page 64
Entering 69
Error opening page 54
Example

authoring 22
image map 121
insert an image into page 96
merge and split table cells 102
publishing 28
Web page 39

Existing files
convert to MiniWeb 142

Extensions, file 42
MIME types 172
pages and MiniWebs 41

External viewer 59, 174

F
FAQ 11, 161–162
Figures

clip art 90
Figures, see Images 62
File

converting to MiniWeb 143
copy file 151
copying 65, 151
delete 154
edit 69
import image

as an Element 88
import text/graphics 66
MiniWeb

delete file 154
new miniweb 141–142, 151
new page 64–65, 68
open 52
open miniweb 143
open page 52, 65
print 59, 157
print setup 59
save as 154
save miniweb 154
save page 68
selecting 40
upgrade software 14

File extensions 42
preferences 172

File names
restricting 169
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File types

see also MIME types 172
Finding Web sites 51
Find/Replace text 71

current page 71
Fire wall

setting proxy 14
SOCKS host 14, 172

Fixed-width text 79
Folders

see also directories 41
Follow Hyperlinks 53
Font

size
bigger 75
smaller 75
style sheet 131

style sheet 131
Forced line breaks 74
Format

body attributes 94
change heading into normal paragraph 85
forms 103
headings 62, 78
list

definition 80
numbered 80
unnumbered 80

paragraph
address signatures 79
block quotes 79
preformatted text 79

paragraph align 78
remove all character styles from a selection 

85
remove block quotes, preformatted text, or 

address signatures 85
remove list structure 85
removing 85
show/remove border 86
style sheet 127–128

type style 75–76, 131
Format menu 183
Formatted type styles 75
Forms 103

ad hoc and CGIs 106
changing handler location or method 114
create form to drive CGI script 105
creating 105
database 106
layout and design 104
Palette 104, 107

check boxes 108
image fields 112
radio button 107
reset 113
selection list 111
submit 113
text area 110
text fields 109

range slider 137
Forward button 55
Frequently Asked Questions 11, 161–162
Frequently Asked Questions (FAQ) 40, 186

G
General preferences 168
GIF files

interlaced 87
transparent 87

Global history 57
Global Network Navigator 20, 51–52
Global search and replace 156
GNN Hosting Service 1

contacting 3
GNN service

publishing to 28, 162–163
GNNpress

features 31
starting 19, 35
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Gopher

proxy server 172
Graphics

clip art 90
Graphics, see Images 62
Guidelines. See Design guidelines 62

H
Header cell 100
Headings 44, 62, 78

design guidelines 62
Help

templates 144
Help menu

contents 39
Frequently Asked Questions(FAQ) 40
MiniWeb window 190
Page window 186
search for help 9, 39
technical support 40
templates 39, 144

Help, online 9, 38
table of contents 39

Hiding menu items 169
History

global 57
window 57

Hit counter 92
Home page

field 34
miniwebs 155

Horizontal rule 74
duplicate 74
re-position 74

Hot list 21, 57–58
add page 21, 58
adding or opening a page 58
copy and paste URL from 118

delete entire list 58
edit and format 59

Hour glass 53
htm file extension 42
HTML 43, 102, 135

anchor 56
basics 61
bullets 64
design guidelines 62
design limitations 63
detailed information 43
editable 194
editing 101
errors 136
formatting 45
hyperlink 45, 53
images 64
limitations 63
lists 45, 64
markup tags 44
more information 62, 64
multiple spaces 63
page design rules 63
paragraphs 44, 64
save change 136
structure of documents 63
style sheet 64
titles 44, 64
viewing 135

HTML 3.0
additional tags supported 137
tables 102
tags supported 137

HTML 3.0 and Netscape Extensions
image and text alignment 193
new text formats 193
page body attributes 193
table support 193

Hyperlink 45, 53, 55, 115
create 116
see also Links 45
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HyperText Markup Language. See HTML 64
HyperText Transfer Protocol (HTTP) 176

I
Icon

animation 52
hour glass 53
lightning bolt 53
question mark 53
stop button 53

Icons
customizing MiniWeb 175
customizing toolbar 177
MiniWeb window 38
Page window 36

Image Fields 112
Image map 93, 119

create 119
example 121

Images 86
background 95
bad link, “broken” 53
broken link 53
changing alignment 91
changing text alignment 91
clip art 90
copy 92
copy from another page 90
delete 92
design guidelines 62
example 96
file formats 87
formats 64
indent 92
insert in-line 88

as element 86, 88
as imported file 89

interlaced 87
move an image down a single line 91

not loading 168
relative vs. absolute reference 89, 95
replace and modify 86, 91
reposition 91
transparent 87
wrap text around 89

Images and graphics
bad link, “broken” 53

Import
images 66
text 66

Import text from another Web page 66
Indent 131
Infoseek 51
Initial page, setting 65
Insert a Horizontal Rule 74
Inserted text 76
Installation

Macintosh 14
MS Windows 13
set preferences 14
system requirements 11

Integration of GNNpress and GNNserver 32
Interlaced images 87
Internet connection 11

J
Justify

paragraph 78
style sheet 131
table cell 101

K
Keyboard

Commands 70
control the cursor 70
edit text 70
navigation 70
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L
Larger font 75
Left justify

image 89
table cell 101
text 78

Lightning bolt 53
Line break 74

forced 74
normal 74

LINK REL tag
add toolbar button 137

Links 115
abort check links 124
anchor 56, 116

creating 117
append anchor name 116, 124
arrows in MiniWeb 148
AutoLinks 125
broken 53
checking 123
close check link dialog 124
color 94
color codes in MiniWebs 148
continue checking links 124
creating 115–116
hiding 149
image maps 119
insert audio or video 122
list from or to 149
modify 122
other media 122
parts of links 115
relative syntax 159
relative vs. absolute reference 117
remove 122
suggesting 125
to a page 116, 119, 123
unlink 122
with the mouse 191

Lists 80
add normal paragraph within a list 81
adding,deleting,rearranging items 81
apply definition structure 82
apply structure 80
borders 86
bullets in 64
change relative positions of term and 

definition lines 83
definition 82
delete or move items within a list 81
editing complex 168
end current list structure 81
nest a new list with typed or pasted items 

85
nest an existing list 84
nested 84
numbered 80
remove structure 81, 85
style sheet 132
unnumbered 80

Load
remote images 168

Load Images 60
Load remote images 168
Location

URL 45
Location field 20, 34, 41

browsing 52
Logical type styles 76
Lycos 51

M
Macintosh

file names 169
installation 14
selecting files 41
system requirements 12

Mail address 171
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Mail host 171
Mailto links 119
Memory requirements 12
Menu bar 34

MiniWeb window 38
Page window 36

Menus 34
MiniWeb window 38, 188

View 189–190
Window 190

Page window 36
short 42, 169

Merge table cells 102
MIME

MiniWeb icons 175
viewers 174

MiniWeb 139
accessing pages 150
add existing pages

import 152
Webize 143

arrows 148
colors 37, 148
converting files to MiniWeb 143
copy-and-paste URL 72, 118, 152, 155
creating subwebs 142
customizing list of 176
delete file 154
deleting pages 154
drag-and-drop 152
enhancements 194
example 37
file type 169
find/replace text 156
Home page 148, 155

setting 141
icons 150, 175
importing a page 152
menus 38
moving 154
naming URLs 42

nested 158
opening 143

multiple pages 54
new page 151
pages 150

print pages 157
quick start 141
saving 154
set stationery 151
SubWeb 158
templates 39, 144–145
Webize 142–143

MiniWeb menu 38
Status bar 36, 38
Toolbar 38

MiniWeb window 32, 37
Browse menu 190
Edit menu 188
example 39
Help menu 190
menu bar 34, 38
parts of 33
scrolling 35, 53
status bar 36, 38
title bar 33
toolbar 34, 38
View menu 189
Window menu 190

Mistakes, Undo - Redo 42
Modal dialog 38
Mouse 191

making links 191
other behavior 191
selecting text 191

Move file 65
MiniWeb 154

MS Windows
file name 169
installation 13
selecting files 40
system requirements 12
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Multiple spaces 63, 169
Multiple windows and pages 54
mw file extension 42

N
Name server 171
Naming 42

directories 42
MiniWeb files 42
page URLs 42
platform differences 42, 165

Naming conventions
Differences among platforms 165

Navigate
Browsing 50

Navigation 49
design 63

Nested lists 168
Netscape

tables 102
Network operations 40
Network preferences 171
New page 64–65, 68

empty page 64–65
import text and graphics 66
open existing page 65

New paragraph 81
New releases of software 14
News

proxy server 172
Non-breaking space 63, 169
Non-graphic browsers 62
Not found message 54

O
Odometer, page visits 92
Online help 38

dialogs 39

example pages and MiniWebs 39
FAQ 40, 186
searching 39
see also Help, online 9
table of contents 39

Open
clone current page 54
example pages 39
multiple windows 54
page 52, 65
reload page 56
unsuccessful 54
with mouse 191

P
Padding, cell 100
Page

backward 55
clone 54
create and save 68
design limitations 63
follow hyperlink 55
forward 55
icons 52
icons in MiniWebs 147
initial 64
location 45
multiple windows 54
naming 42
navigation links 63
new 65
opening 65
print 59
reload 56
saving 68, 161, 163–164
stop downloading 53
title 64, 68

Page menu 36
Page window 32–33, 35
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Browse menu 185
Edit menu 181
Element menu 182
example 39
Format menu 183
Help menu 186
Location field 34
menu bar 34, 36
menus 36
parts 33
scrolling 53
startup 19, 49
status bar 36, 38
Table menu 184
title bar 33
Title field 34
toolbar 34, 36
Tools menu 184
Window menu 186

Palette
forms 107

Paragraph 77
align or center 78
formatting 64
new 81
normal 77
removing structure 85
selecting 64
structures 77
style sheet 130

Parse HTML 136
Paste

into list 168
text 69

Paste URL 73, 118
toolbar 73, 118

Performance
pre-fetching pages 169

PERSON tag 137
Pictures, see Images 62
Platform dependencies

Naming conventions 165
Platforms, variation among 9, 165

DOS/Windows 165
Macintosh 165
naming conventions 42
restricting file names 169

Posix
file names 169

PPP connection 11
Preferences

browsing 60
File Extensions 172
General 168
load images 60
MIME viewers 174
MiniWeb icons 175
Network 171
pre-fetch pages 60
set at installation 15
short menus 42
Sites 176
startup view 65
Toolbar 177
Unix style delete 168

Pre-fetch pages 60, 169
Preformatted text 79
Print 59
Print page 59
Print setup 59
Printing pages

miniwebs 157
Procedure

browsing 55
how to use this book 8
open new page 65

Proxy server 14, 172
Publish pages to WWW 28
Publishing

client-server 32
creating a directory 162
example 28
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GNN Hosting Service 161, 163
GNN service 28, 162–163
other servers 176
URLs can change 42

PUT method 176

Q
Question mark 53

R
Radio Button 107
Range field 137
Redo command 42
Reference 8

relative syntax 159
relative vs. absolute 117

Relative references
syntax 159

Relativize button 89, 95, 117
Reload

HTML 136
page 56

Remote operations 40
Remove

Block Quotes, Preformatted text, and 
Address signatures 80

character style 77
formats 85
heading 79

Removed text, type style 76
Replace

MiniWeb 156
Reset Button 113
Retrieve failed message 54
RGB colors 95
Right justify

image 89
table cell 101

text 78
Rows, table 99

S
Save

HTML 136
MiniWeb 154
page 68, 161, 163–164
page to local disk 27
see also Publishing 27–28
URLs can change 42

Scroll bar 53
Search and replace

current page 71
MiniWeb 156

Security
SOCKS host 172

Select text 69
with mouse 191

Selection Lists 111
Sequential Browsing 55
Servers

customizing list 176
proxy 172

Short menus 42, 169
Signature, in page 79
Sites

customizing list of 176
Size of font 75
SLIP connection 11
Smaller font 75
SMTP mail host 171
SOCKS host 172
SOCKS Support 195
Source

viewing 135
Spaces 73

HTML rules 63
multiple 63, 169
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preformatted text 79

Spacing, cell 100
Span table cells 102
Split table cells 102
Standalone installation 13
Starting

a new page 64
animation you see 52
default page 19, 35, 49, 65
GNNpress 19, 52
points 64
your tour of the Web 20

Startup
page 35
Page window 19, 49
page, setting 65
View 170

Status bar 35–36, 38
MiniWeb window 36, 38
Page window 36, 38

Stop 56
Stop button 53, 56
Strikeout text 76
Structure

document 63
Style sheet 64, 127

apply style 134
create 128
create new style 129
edit 127–129
edit style for horizontal rule 133
edit styles for lists 132
edit styles for paragraphs 130
edit type style 131
purpose 128
select existing style 128
vs. HTML 64

Styles
apply and remove 77
characters 75

Subdirectories

converting to MiniWeb 143
Submit Button 113
SubWeb 140, 158

check links 155
creating 142–143, 158
opening 158
saving 154
Webize 143

Support, technical 3
supported HTML 3.0 tags 137
Surf the Web 51
System requirements

Macintosh 12
MS Windows 12

T
Tab

preformatted text 79
setting 137

Table 98
align cells 101
align or center 101
alter table 100
border 99
creating 99
header cell 100
HTML 3.0 vs. Netscape 102
merging cells 102
normal cell 100
splitting cells 102
V align cell 101
V align row 101

Table menu 184
Tags

HTML 3.0 137
viewing 135

TCP/IP
Windows 12–13

Technical support 3
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Templates 39, 144

example miniwebs 144
Personal Home Page 22

Testing links 123
Text

color 94
copying 72
edit spacing 169
editing 69
entering and revising 67
for non-graphical browsers 62
import 66
move horizontally 73
selecting 69
typing 69
wrap around image 89

Text Areas 110
Text Fields 109
Tiled background 95
Title 64

bar 33
field 34
page 64, 68

Toolbar 34
adding buttons 137
copy 72
copy URL 72–73, 118
customize 177, 195
icons

Page window 36
MiniWeb window 38
Page window 36
paste 72
paste URL 73, 118

Tools
AutoLinks 125
check links 123
general preferences 168
preferences

configure toolbar 177
extensions/MIME 172

general 65
MIME/Viewer 174
MiniWeb Icons 175
network 171
sites 176

show HTML 103, 135
Tools menu 184
Transparent images 87
Tutorial 8
Type styles

apply and remove 77
formatted 75
logical 76
removing 85
style sheet 131

Type text 69
Types of files

see also MIME types 172
Typographical conventions 9

U
Undo 42
Uniform Resource Locator (URL) 42, 45
Unix

delete vs. backspace 168
file names 169

unlink 122
Unsuccessful openings 54
Upgrades 14
URL 45

anatomy 45
cross platform 42
naming conventions 42
relative 151

Usenet newsgroups
proxy server 172
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V
Vertical alignment

image 89
table cells 101

View
display control 149
hide/display links to/from 149
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